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g Greetings!

Welcome to the amazing world of FoxPro. In your
hands is the best database management system
we've ever created for the personal computer!
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Welcome to the amazing world of FoxPro. In your hands is the best
database management system we've ever created for the personal
computer!

Your first step is to install FoxPro. Simple installation instructions are
located in the FoxPro Installation Guide.

The Quick Tour chapter in this manual showcases FoxPro’s outstanding
features.

A tutorial, Groundwork through Now What?, is available for new FoxPro
users as well as old hands who want an introduction to the amazing new
features of FoxPro 2.0.

The tutorial is divided into several short sessions. Each session focuses
on one major topic and leads you through step-by-step.

By the time you've completed the tutorial, youll have learned to create
your own database, change it, retrieve information from it, combine that
information in new ways, report on your data and design custom input
screens for your data — all with incredible ease. And that’s not all.
You'll also learn to generate your own applications.

The tutorial is designed to be easy-to-follow and, as you gain expertise, it
can stay by your side for reference.

As you use FoxPro, remember:

* The context-sensitive on-line help system is at your fingertips — just
press F1. On-line help contains the most current information about
FoxPro.

¢ If you have any problems, refer to the Customer Support appendix in
the FoxPro Developer’s Guide.

Introduction
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Taking a Quick Tour

Take a quick tour of the features that make
FoxPro one of the most exciting software
packages in the world.

Quick Tour

 Imterface. . . ............. page 2
® Browse Window . . . . ........ page 4
e RQBEWindow ............ page 6
® Report Writer . . . .. ... ..... page 8
® ScreenBuilder ... ........ page 10
® MenuBuilder . . .. ........ page 11
® TextEditor ............. page 12
® Trace & Debug Windows . . . . . . page 13
¢ Project Manager .......... page 14
e WrappingIltUp........... page 15
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Neu...
Open...
Close

Save

File Edit Database Record Program Uindouw )

Save as... Open:
Revert

Printer Setup... [FOXAPP]
Print... [PICS]
[QTPICS]

— Quit [SANPLES] Directory | PRO288
e | roe |

[T3PICS]
[T4PICS]

[ 1 A1l Files < Neu >

N\

Welcome to a quick tour of FoxPro! During this tour you will see
many of FoxPro’s tools for managing your data. The tools help
you easily create and manipulate your data, and quickly extract
useful information.

Explanations of the features shown in the Quick Tour are
provided throughout the FoxPro documentation.

You can communicate with FoxPro using a mouse or the key-
board, whichever you prefer. You tell FoxPro what to do by select-
ing items from the menu system. More specific information is
communicated to FoxPro via dialogs that may contain check boxes,
lists, popups, push buttons, and radio buttons.

Quick Tour



System File Edit Database Record Program UWindou

« Toplcs » “ Open File J <

< Next > | When you choose Open... from the File menu popup, the
Open File dialog appears so you can open existing files.
< Previous > | Variations of this dialog appear at other times in the

product when you need to open a file. For example, uhen
< Look Up > | you need to open a report, an Open Report File dialog

appears. The Open File dialog displays all files of a
l ticular type. File types are categorized by their

Command ensions.
Label Layout
I Menu Design
ProJject
Report Layout
ROBE [ 1 A1l Files < New >
Screen Design

Text Editing T

_ 1

Have you ever had a question and no one was around to answer
it? With FoxPro, help is always close at hand. FoxPro provides
help based on what you are doing. If you ask for help while look-
ing at a dialog, FoxPro tells you all about that particular dialog.

FoxPro even provides a handy list of related help topics.

Most actions in FoxPro take place in windows. A window can be
opened, closed, moved, resized and scrolled.

Quick Tour S2-3



158
175
188
248
271
281
294
322
328

I Janet A. McCarthy

Robert Watters
Doris Dupuy

T Staziola Tounsend
John Hodge

Houard Schneider
Jay Kennedy

Tom Caravello

E. Faulkner

Keith Sutherland
Jim Surbrook
Ned Hicks
Robert Angelo

(21327 2 |[East Rarttora |

24762.85|Ualtham
202083.99|Fall River
7798. 34| Burlington
182797.63|Hermnitage
42181.43]Allentoun
58521.98|Neu York
69118. 59| Mahuah
16004. 78] Columbia
340888. 44| Concord
27282.52|Gainesville
49292. 86| Savanah
26737.83|Boca Raton

MA

MA 4
MA |617/273-2]
PA ]1412/981-
PA |215/432-3
NY | 2127246~
NJ |281/529-
SC |883/776-8
NC | 784/788-
FL |984/392-
GA |812/232-

FL 8

The Browse window is an incredible tool for viewing and editing

your data.

The Browse window usually displays your data in tabular form.
Each row is called a record and each column is called a field.
Don’t worry if you can’t see every field or every record — it’s easy
to scroll around until you can see the data you desire.

The fields in a Browse window can be resized and rearranged to
suit your needs. After you get everything where you want it, don’t
be afraid to close the Browse window. FoxPro remembers where
everything was so that when you open the Browse window again,

everything is just as you left it.

S2-4
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SALESHMAN

Robert Watters
Doris Dupuy

69118. 59[264/529-2831

SALESMAN. NOTES
Janet has been salesperson of the month for one consecutive month!

Janet A. McCarthy Hero |

Robert Watters
Doris Dupuy

T Staziola Tounsend
John Hodge

Houard Schneider
Jay Kennedy
Tom Caravello

FoxPro has a very special type of field called a memo field. Memo
fields can hold data of any size and type. This makes memo fields
especially well-suited for storing information that varies in size,
such as descriptions, comments, letters, programs, and even bi-
nary data like pictures and digitized sounds.

If your memo field contains text, you can view it in a separate
window while you browse through your data. You can also see the
ASCII representation of pictures and sounds.

In addition to the tabular form of the Browse window, you can
view your data in Change mode.

The Browse window can be divided into two partitions. One parti-
tion can show one portion of your data while the other parti-
tion displays another part of your data. The partitions can even
be in different display modes.
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SAMPLE
Databases Output Fields Output To

1t NAME [X1 Select Fields...
24 ITOTAL e

$

$

$ COMPANY [X1 Order By...

3 CONTACT [ 1 Options...
$

t

CUSTOMER
INVOICES
»SALESMAN

PHONE [ 1 Group By...
< Add > [ 1 Having... < See SQL >
< Clear > « Do Query »

Field Name NOT Example Options Select
Criteria

Like CUSTOMER. CNO

INUOICES. CNO [1]
SALESMAN. ONO [ 1 Like CUSTOMER. ONO <Insert>
[1

$ INVOICES. ITOTAL Hore Than 2500

<Removed

< Or >

RQBE stands for Relational Query By Example. RQBE allows you
to look at your data from many different angles. It’s ease of use
and quickness of response make FoxPro’s RQBE facility an excel-
lent tool for “what if” analysis.

Using the same simple interface that you've seen so far, FoxPro
allows you to choose databases to retrieve information from. You
can then select fields to display, specify their order and organize
them in groups. You can even create conditions that records must
meet to be displayed.

S52-6 Quick Tour



SELECT SALESHAN. NAME,
CUSTOMER. CONTACT, CUSTOMER. PHONE:
FROM CUSTOMER, INUOICES, SALESMAN:
WHERE INUOICES.CNO = CUSTOMER.CNO:
AND SALESMAN.ONO = CUSTOMER.ONO:
AND INUOICES. ITOTAL > 2508:
ORDER BY SALESMAN.NAME, INUOICES.ITOTA
INTO CURSOR SAMPLE
REPORT FORM SAMPLE.FRX PREVIEW

INVOICES.

ITOTAL,

CUSTOMER. COMPANY, 5

SAMPLE
Conpany

Bill Diaddigo || 3321.66)

Bill Diaddigo
Bob Hubben

Bob Hubben

Bob Wubben

Bob Wubben
Carolyn Macioce
Carolyn Macioce
Daniel Small
Daniel Small
Daniel Small
Daniel Small

E. Faulkner
Fuji Retell
Fuji Retell
Jan Buoniconti
Jan Buoniconti
Jan Buoniconti
Jan Buoniconti
Jin Surbrook

Nixing Systems & Company
Univ Diego Corp

0il & Gallery

Hammerman Systens

Atec Data Service

The Automated Associates
Herring Inc.

Univ Diego Corp

0il & Gallery

Hammernan Systems

Atec Data Service

Consof State DSSD

The Automated Assocliates
Herring Inc.

Univ Diego Corp

0il & Gallery

Hammernan Systems

Atec Data Service

Consof State DSSD

Paul Schuartz
Paul Dixon
Randy KeJji
Hike Murray
Ann Casey
Bruce Snith
Dave Mccarthy
Paul Schuartz
Paul Dixon
Randy KeJji

Mike Murray

84/25/91 Top Sales by Salesman Page 1
I Salesnan’s Nane Total Conpany Contact Phone l
Bill Diaddigo 3321.66 Vaultec Studies Ken Bott 614/382-9499
2615.58 HMixing Systems & Larry Locey 21978656010
5937.24
Bob Uubben 3168.93 Univ Diego Corp Dave Mccarthy 415/573-5167
30824.57 0il & Gallery Paul Schuartz 415/426-8117
2827.62 Hammerman Systems Paul Dixon 213/532-2286
2721.13 Atec Data Service Randy Keji 488/246-5353
11734.31
Carolyn Macioce 2538.18 The Automated Ann Casey 214/631-8458
2525.89 Herring Inc. Bruce Smith 585/842-3778
5063.27
Daniel Small 3168.93 Univ Diego Corp Dave Nccarthy 415/573-5167
3824.57 O0il & Gallery Paul Schuartz 415/426-8117
Hamnernan Systems Paul Dixon 213/532-2286
Ej © Randy Keji 488/246-5353
Uaultec Studies |[Ren Bott |l mike rurray 385/444-7534
Larry Locey |219/865-6818
Dave Mccarthy|415/573-5167
Paul Schuartz}|415/426-8117 Ann Casey 214/631-8458
Paul Dixom 213/532-2286 Bruce Smith 585/842-9778
Randy Keji 408/246-5353
Ann Casey 214/631-8458
Bruce Smith |585/842-9778 Dave Mccarthy  415/573-5167
Dave Mccarthy]415/573-5167 Paul Schuartz 415/426-8117

415/426-8117
213/532-2286

305/444-7594|

You can choose to send data from RQBE to a Browse window. This
allows you to use all of the powerful features available with
Browse windows.

You can also choose to send your data to a report. The report can
be modified using FoxPro’s Report Writer, which you will see on
the next stop of this tour.

Behind the scenes, RQBE actually creates a SQL SELECT command
containing all of the items you specified. This command can be
copied and used in your programs if you desire.

Quick Tour
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SAMPLE. FRX
Page Footer

Top Sales by Salesman

[ Salesman’s Name Total Company Contact

Report Total

FoxPro’s Report Writer allows you to design professional reports
quickly and easily. You can place text, fields, lines and boxes
anywhere in your report. This allows you to produce an infinite
variety of reports.

You can use both database fields and calculated fields in a report.

Data in a report can be grouped so that totals, counts, averages,
standard deviations, variances and other calculations can be com-
puted.

A page preview option allows you to view your report on the
screen before you actually print it, saving you both time and
paper.

Naturally, the reports that you design can be saved, modified and
used again.

S2-8 Quick Tour



84/25/91 Custorer Phone List Page 1
Company Phone Contact City St
Ist Computers 617/232-5853 Jeff W. Culbertson Brookline MA
st Data Reductions 584/524-3966 Dennis Johnson Neu Orleans LA
Ist Softuare Systems Ltd. 713/723-1288 Rance Siuren Houston ™=
st Survey 214/243-7247 Robert Hepuorth Dallas TX
R Beck Pertanina 617/643-6928 Jim Ansarti Arlington MA
h. Arts Computers 617/662-8157 Darryl Roudebush Nelrose HA
h. Bloomington Biz 9084/222-9457 Phil Putnam Tallahassee FL
Inc 617/823-5188 Ton Totah Taunton MA
bymark Uelonex 214/922-4927 Isador Sueet Dallas TX
hcres Tree Solutions 281/786-8785 Russell Knickle Sparta NJ
hdd Associates 415/897-28108 Len Silverman Novato cA
hdd Inc 363/499-2086 Bert Crauford Boulder co
hdder Incorporated 313/573-5873 Brenda Carturight Warren HI
hdv. Softuare 617/646-7974 Barbara H. Martin Arlington HA
hdvantage Computer School 488/946-1317 Duane Marshall San Jose cA
herial Inc. 281/696-7378 Lynn Williaws Hayne NJ
Rlex County Community 3081/459-4484 Rance Hayden Lanhan MD
herial Inc. 281/696-7378 Lynn Willians Hayne NJ
Rlex County Community 381/459-4484 Rance Hayden Lanhan HD
hlex Systems 814/838-3116 Nancy Uright Erie PA
huerican Computer Company 886/793-7786 Dick W Guyton Lubbock X
herican Forum 885/682-5588 Gui Dupuy Santa Barbara ca
puerican Innovations 201/245-7517 Garret Hill Roselle NJ
fnsari Data Softl g4.,/25/
eari Produce 84/25/91 Top Sales by Salesman Page 1
;:::’l‘e;ll::'lszon Salesman’s Name Total Company Contact Phone J
hspen Technolo
Rssoc nnericinga Bill Diaddigo 3321.66 Vaultec Studies Ken Bott 614/382-9433
pssoc_Strong 2615.58 Mixing Systems & Larry Locey 219/865-6019
ec Data Servid -
hutomated Mayo M
huard Ammonia G 5937.24
Rzimuth Bavis &
hzinuth Corp Bob UWubben 3168.93 Univ Diego Corp Dauve Mccarthy 415/573-5167
B-J Astra 3824.57 0il & Gallery Paul Schuartz 415/426-8117
ham Cu:"Puﬂ" 2827.62 Hammernan Systems Paul Dixon 213/532-2286
; If '91. ;“"‘ : 2721.19 Atec Data Service Randy Keji 488/246-5353
11734.31
Carolyn Macioce 2538.18 The Automated Ann Casey 214/631-8458
2525.89 Herring Inc. Bruce Smith 585/842-9778
5863. 27
Daniel Small 3168.93 Univ Diego Corp Dave Mccarthy 415/573-5167
3824.57 0il & Gallery Paul Schuartz 415/426-8117
2827.62 Hammerman Systems Paul Dixon 213/532-2286
2721.19 Atec Data Service Randy Keji 4088/246-5353
11734.31
E. Faulkner 27?26.63 Comsof State DSSD Mike Murray 3857444-7594
2726.63
Fuji Retell 2538.18 The Automated Ann Casey 214/631-8458
2525.89 Herring Inc. Bruce Smith 585/842-9770
5863. 27
Jan Buoniconti 3168.93 Univ Diego Corp Dave Mccarthy 415/573-5167
3624.57 0il & Gallery Paul Schuartz 415/426-8117
2827.62 Hammerman Systems Paul Dixon 213/532-2286
2721.19 fAtec Data Service Randy Keji 488/246-5353

Quick Tour
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Title 1988 - A Filu By Bernardo Be Deleted: No Recordit 393

S2-10

Catalog#t LU8S8B4-3
Price 49.95
Acquired 18/11/98
U.Quality 8
Critics 7?7

NC-17 " Rating
Paramount ﬂ Studio
Title ﬂ Order

Sides
Duration 255

Year

< Top > <« Prior >

LN N N N N ]

d nd bd bd d bd d

5

13977

Digital tra
Digital aud
Stereo
Surround so
CX encoded
Closed capt
Letterboxed

< Next >

Comments
Thisis a g

nsfer ]

io

[

L

[
und C
[
ioned [
[

Cd bd bd hd e bd

< Bottom >

ood Mmovie.

CAV format
Black and white H
Subtitled
Dubbed
Silent
ComMentary
Supplements

< Quit >

]

FoxPro’s Screen Builder allows you to design screens for entering
and editing your data.

Your screens can contain the same controls used in FoxPro’s inter-
face. These controls include push buttons, radio buttons, invisible

and boxes.

buttons, check boxes, popups, lists, text edit regions, text, lines

FoxPro takes the information supplied by the Screen Builder and

generates a program.

Quick Tour



LASERM. MNX
Prompt Result Options
$ \<Systen Submenu [X1 Menu Bar ﬂ
$ \(Edit SubMenu [X]
$ \<(batabase Submenu [X]
$ Ex<nvironment SubMenu [X] < Try it >

Iten
< Insert >

< Delete >

Designing custom menu systems is a snap with FoxPro’s Menu
Builder. You can create menus that include your own options as
well as some or all of the options from FoxPro’s menus.

FoxPro uses information you specify in the Menu Builder to
generate a program.

You can coordinate screens and menus in applications that you
write.

Quick Tour S2-11
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PICTURE. PRG

close all

use pictlou

endif

set library to imagelib

define windou picture fro
title "Press F2 to Disp
float grouw close zoom s}
color scheme 8

on key label f2 do disppi

brouse nouwait windou pict

[]

ROBE. TXT

In the command window type CLOSE ALL

2. Fron the File menu popup select New...

3. From the Neu dialog select Query

4. Select the Cust database from the Open file
dialog

5. In the ROBE windou select the Select
Fields... check box.

6. In the Select Fields dialog Remouve All the

fields and add the fields cust.cno,

0UT4. TXT

84/87/91 Invoice Report Pa

I Company Phone Contact Date

Atec Data Service 408/246-5353 Randy Keji 85717738

?714/54 085/88/90 M

Automated Mayo Miley

8-6862 Bill Hopkins

FoxPro’s built-in text editor does more than just allow you to type
and modify text. You can also cut, copy, and paste both within a
file and between files. FoxPro’s text editor includes search and
replace, word wrap, auto indentation, justification, undo/redo and
a handy status line.

Quick Tour



u Trace

Program Resume Out Over Step
53 dimension £1ds(256), query(58), tags(256>, dbfs(25)
54
55 dbc = @
56 for 1 =1 to 25
5?7 if len(dbf(id> # @
58 dbc = dbc + 1
59 dbfs(dbc) = alias(i)
68 endif

61 TITN
62

63 if dbc = 8
64 x = getfile("DBF","Pick database to BROWSE")
+BROWSER. SPR

FoxPro’s Trace window allows you to watch program code as it
executes. You can let your program execute normally, step
through the code one line at a time, or set breakpoints to stop
execution on certain lines.

The Debug window allows you to monitor the values of variables
and expressions while your program is executing. You can set
breakpoints based on specific variable values.

Editing, Trace and Debug windows are an unbeatable team for
program development.
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APP1.PJX
Name Type

< Eait >
LASER # Database
LASER Report < Info >
LASER « Screen Set
LASERM Menu < Add >
LREPORT Screen Set

< Remove >

< Build >

Select Build Option
*) Rebuild Project
) Build Application
) Build Executable « OK »
(+> Compact
C > Stand-alone
¢ ) Stand-alone Extended < Cancel >

[
C
¢

[ 1 Display Errors
[ 1 Rebuild All

To help you keep track of your databases, queries, reports,
screens, menus and programs, FoxPro provides the Project
Manager. The project manager unifies and coordinates the ele-
ments of a FoxPro application.

The Project Manager remembers the location and current version
of every file it contains. It also allows easy access to prewritten
programs and interface components.

Distribution of both application files and executable (.EXE) files is
highly streamlined when you use the Project Manager.

Quick Tour



As you can see, FoxPro is a database system of remarkable
breadth and depth.

Beginners can simply and swiftly tap FoxPro’s amazingly powerful
facilities to interactively create ad-hoc queries, reports, data input
screens and even entire applications.

Yet FoxPro has the depth to satisfy the most demanding developer
or corporate power-user. FoxPro has the speed to outrun
mainframe databases and handle millions of records (one of our
sites actually has databases of nearly 100 million records).

PC Magazine styled FoxPro a “developer’s dream” and we agree
wholeheartedly.

With FoxPro, you'll never lack room to grow.

Quick Tour
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Groundwork :
Starting FoxPro and using the interface is a snap.
In this chapter, you'll learn the basics. Q
® Welcome ................ page 2
® Starting FoxPro . ........... page 3 E
® Mouse Techniques . . . .. ... ... page 4
® MenuSystem. ............. page 5 o
® Windows . ... ............ page 6
® Dialogs . .. .............. page 8 *
® On-LineHelp. ............ page 10 x
® TextEditing ............. page 12
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Welcome

Welcome

S3-2

Welcome to the FoxPro tutorial. Please, sit down and relax. Take your
shoes off if you want to. Get ready to make your life easier.

The first few pages of this tutorial familiarize you with the FoxPro inter-
face. If you need more information about the interface, refer to the In-
terface Basics chapter in the FoxPro Interface Guide. The sessions that
follow show you how to use FoxPro’s tools to enter, manipulate and
report your data.

By the time you are finished with this tutorial, FoxPro will not be just
another software package. You will wonder how you survived without it.

Groundwork



Starting FoxPro

Starting FoxPro

Starting FoxPro
1. Turn on your computer.

. If you have not installed FoxPro, do so now.

2
3. Go to the directory in which you installed FoxPro.
4

. Type FOX and press Enter. The FoxPro sign-on screen
appears with the Command window open.

File Edit Database Record Program Windou

Exiting FoxPro

When you are ready to exit FoxPro, choose Quit from
the File menu popup. You are back to the system
prompt.

Groundwork S3-3



Starting FoxPro

Mouse Techniques

Here are some common mouse techniques. For additional information
about mouse use, refer to the Interface Basics chapter in the FoxPro
Interface Guide.

Point — DPosition the pointer at a
specific location on the screen. When
you move the mouse, the pointer
moves in a similar manner.

‘I"lll
3
il

/oD~

Q Click — Point to an object then press and
release the mouse button once.
Double-click — Point to an object then press and
Q release the mouse button twice in rapid
succession.

Q Drag — Hold the mouse button down,
\ roll the mouse until the pointer is in
Q the desired location and release the

— mouse button.

S3-4 Groundwork



Menu System

Menu System

The menu system makes it easy for you to communicate with FoxPro
without programming. The parts of the menu system are shown below,
along with steps for choosing menu options.

Menu Pad

I——» [ System RFWCW Edit Database Record Program UWindou

Menu Bar New

[——'IEI_
Close

Menu

Option Save
Save as...
Revert

Printer Setup...
Print...

Quit

D

— Menu Popup

Choosing Menu Options
With the keyboard:

pads on the menu bar.

With the mouse:

Groundwork

1. Press the Alt key to select the first menu pad, then press
the Right or Left Arrow keys to select other menu

2. Press Enter to display the menu popup.

3. Press the Up or Down Arrow keys to select an option,
then press Enter to choose the option.

1. Point to the menu pad and press the left mouse button to
display the menu popup.

2. Point to the desired option and press the left mouse
button.

S3-5



Windows

Windows

FoxPro windows display text files, programs, data, help information and
many other kinds of information. You can manipulate windows in a
variety of ways.

Close Box Title Zoom Control

S3-6

| |

Command

Down Arrow

Size Control

Scroll Bar

Moving a Window
With the keyboard:

1. Choose Move from the Window menu popup. The
window border flashes.

2. Press the arrow keys, PgUp, PgDn, Home and End
keys to move the window, then press Enter.

With the mouse:

Point to the window title, drag the window to the
desired location and release the mouse button.

Groundwork



Windows

Sizing a Window
With the keyboard:

* Choose Size from the Window menu popup. Press the
Left, Right, Up and Down Arrow keys to move the
border of the window. When the window is the size you
want, press Enter.

« To enlarge the window to full size, choose Zoom T from the
Window menu popup. Choose Zoom T again to return
the window to its previous size.

With the mouse:

« Point to the size control and drag until the window is the
desired size.

* To enlarge the window to full size, click on the window’s
zoom control. Click again to return the window to its
previous size.

Scrolling a Window
With the keyboard:

* Press the Down Arrow key to scroll down or press the Up
Arrow key to scroll toward the top of the window.

» To scroll rapidly, press the PgUp key to display the pre-
vious window full and the PgDn key to display the next
window full of text.

With the mouse:

¢ Click on the up or down arrow on the scroll bar to move
through the text a line at a time. Click on the Page
Up or Page Down region to move through the text a
screen at a time. Click and hold the mouse button
down on the arrow to scroll continuously.

* To scroll rapidly, point to the thumb and drag it up or
down.

Closing a Window

Choose Close from the File menu popup or click on the
window’s close box.

Groundwork S3-7



Dialogs

Dialogs

Dialogs are special boxes that allow you to make
action about to take place.

Open:

[..1
CUSTOHER. DBF
CUS_COM. DBF
INUOICE. DBF
ITEMS. DBF
LINEITHMS. DBF
PAYMENTS. DBF
SALES. DBF

List

Check Box —— [ 1Al Files < New >

Database Type < Cancel >

z
1]
£

Database
Program
File
Index « OK »
Report
Label < Cancel >
Screen
Menu
Query
Pro ject

Radio
Buttons

la N aNaNaRaNaNalalalal
-
W W W W W W W W

choices concerning an

Popup Control

Default
Push Button

Push Button

Scrolling a List
With the keyboard:

list.
With the mouse:

S3-8

Tab to the list, then keep pressing the Down Arrow key.
Use the Up Arrow key to scroll toward the top of the

Click on the up or down arrow on the scroll bar. If you
hold the mouse button down, scrolling will continue
until you release the mouse button.

Groundwork
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Choosing an Option on a Popup
With the keyboard:

1. Tab to the popup control, then press Enter to display the
popup.

2. Press the Up or Down Arrow keys to select the option
then press Enter.

With the mouse:

1. Point to the popup control and press the mouse button to
display the popup.

2. Drag to the desired option, then release the mouse button.

Choosing a Check Box, Radio Button, Push Button
With the keyboard:

Tab to the check box, radio button or push button, then
press Enter.

With the mouse:

Point to the check box, radio button or push button and
click.

Moving a Dialog
With the keyboard:

1. Press Ctrl+F7 then use the arrow keys, PgUp, PgDn,
Home or End keys to move the dialog in any direction.

2. When the dialog is where you want it, press Enter.
With the mouse:

Point to the top border of the dialog, drag the dialog to
the desired location and release the mouse button.
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On-Line Help

With FoxPro, help information is at your fingertips. FoxPro provides
context-sensitive help so that you can get help information about any
system window, dialog or menu option while you are using that feature.

Accessing Context-Sensitive Help
With the keyboard:

When the window or dialog is frontmost or the menu
option is selected, press the F1 key.

With the mouse:

Hold down the Alt key, point to the window, dialog or
menu option and click the left mouse button.

If you prefer, you can scroll through the topics list in the Help window
and get help on a topic.

Getting Help Details for a Topic
1. Choose Help... from the System menu popup or press F1.

2. Select the topic from the Help window that you want help
information about.

3. Choose the Help push button at the bottom of the Help
window.
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On-Line Help

Cc)> Fox Holdings, Inc.
Hou to use Help
What’s Neu...
Interface
Programming
Compatibility...
FoxBASE+
DB3 & DB4
Configuring FoxPro

VVVYVVYVYYYY

« Help »

Topics Level of the Help Window

« Topics » m Expression Builder “

{ Next > | The Expression Builder is a dialog
that appears in FoxPro whenever you
< Previous > | need an expression to complete a
command.

< Look Up >

An expression is an item C(or items)
that, uwhen evaluated, generates a
See Also “ neu value of Character, Numeric,
Logical or Date type. An expression
can be as simple as a single

Details Level of the Help Window
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Text Editing

Text Editing

Editing text in FoxPro is done with a mouse or eight basic cursor move-
ment keys, two modifier keys and two delete keys.

You can use these techniques whenever you type information with your

S3-12

keyboard.

Cursor Movements

Right Arrow Move one character to the right
Left Arrow Move one character to the left
Up Arrow Move up one line
Down Arrow Move down one line
Home Move to the start of the line
End Move to the end of the line
PgUp Move up one window-full of text
PgDn Move down one window-full of text
Ctrl+Right Arrow Move one word right
Ctrl+Left Arrow Move one word left
Ctrl+Home Move to the beginning of text
Ctrl+End Move to the end of text

Select Text with Keyboard
Shift Arrow Keys Select a range of characters
Shift+Ctrl Arrow Keys Select a range of words
Shift+Ctrl+Home Select from cursor to beginning of text
Shift+Ctrl+End Select from cursor to end of text
Ctrl+A (a menu shortcut) Select entire document

Groundwork
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Select Text with Mouse

Drag Select a range of characters
Double-click Select a word

Double-click and drag Select a range of words
Triple-click Select a line

Triple-click and drag Select a range of lines

Delete and Replace

Place cursor to the right of
the character, press
Backspace, or place cursor | Delete a character
at the character, press
Delete

Place cursor anywhere in
word, press Ctrl+Backspace

Delete a word

Select and press Backspace | Delete a selection

Select text to be replaced,
type new text (or Paste)

Replace existing text

Cut, Copy and Paste

Select the text, press Ctrl+X
or use Cut in the Edit menu

Select the text, press Ctrl+C
or use Copy in the Edit | Copy Text
menu

Press Ctrl+V or use Paste
in the Edit menu

Cut Text

Paste at cursor

Select text, press Ctrl+V or

use Paste in the Edit menu Replace text with clipboard content

Groundwork S3-13






Looking at Your Data

In this session you'll see how easy it is to open a
database and look at its information using
FoxPro’s multi-faceted Browse window.

® Opening a database . . . .. .. ... page 2
® Browsing a database . ... ... .. page 2
® Modifying the Browse window . . . . page 6
® Opening a memo field. . ... ... page 20

Session 1
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Looking at Your Data

Looking at Your Data

Now that you can navigate around the FoxPro interface, let’s use those
skills.

We have provided several databases for your use when learning FoxPro.
A database is a file that contains a collection of information. These files
are sometimes referred to as .DBF files or tables.

One of the databases provided, CUSTOMER.DBF, contains information
regarding a set of rather eccentrically named, fictitious customers. This
is one of six sample databases provided that relate to the operations of a
simple (eccentrically managed) imaginary business.

FoxPro contains a very powerful tool for viewing and editing database
information called a Browse window. Let’s open CUSTOMER.DBF and look
at the customer information in a Browse window.

Opening and Browsing a Database

1. Choose Open... from the File menu popup. The Open File
dialog appears. Make sure that C shows on the Drive
popup control and TUTORIAL shows on the Directory
popup control. (Figure 1)

2. Select CUSTOMER.DBF.
3. Choose the Open push button.

4. Choose Browse from the Database menu popup. The
Browse window appears as in Figure 2.

As you can see, the Browse window displays information in rows and
columns. The rows are called records and the columns are called fields.

¢ TFields contain a certain type of information. For instance,
CUSTOMER.DBF has a field called CNO that contains the customer
number for each customer.

* A record is a set of fields that define a specific person, place or thing.
In CUSTOMER.DBF, each record contains information for one customer.

A database file is simply a collection of records.

Session 1



Database Files

L.

Cno

Looking at Your Data

Open:

[..1

DETAIL. DBF
INUOICES. DBF
OFFICES. DBF
PARTS. DBF
SALESMAN. DBF

[ 1 All Files

Database ﬂ Type

Drive

Directory

[ c ]
TUTORIAL “

<« Oth »

< Neu

v

< Cancel >

Figure 1: Open File Dialog

CUSTOMER
Company

Contact

14821llst Computers

ist Data Reductions

1st Softuare Systems Ltd.
1st Survey

A Beck Pertamina

A. Arts Computers

18232
12082
12840
A8872
ng8818
AB453
A6188
A5181
A3964
A3882
A1846
A7249
A3835

Session 1

A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuare

Jeff WU. Culbert
Dennis Johnson
Rance Sivren
Robert Hepuorth
Jim Ansarti
Darryl Roudebu
Phil Putnam

Tom Totah
Isador Sueet
Russell Kmickle
Len Silverman
Bert Crauford

Barbara H. Martl

Figure 2: Browse Window for CUSTOMER.DBF
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A Browse window isn’t normally big enough to enable you to see all the
fields and records in a database at once. Think of the Browse window as
a viewport to the entire database file, as demonstrated in Figure 3.

You can scroll the Browse window horizontally and vertically to see
different portions of the database. Figure 3 illustrates this concept.

The Browse window has the standard window controls described in
Groundwork. Note that the title of the Browse window is the name of
the database file that you are browsing. Try moving, sizing and scroll-
ing the Browse window. Go ahead, take it for a test drive.

Moving, Sizing and Scrolling the Browse Window
1. Move the Browse window down a few lines on the screen.

2. Size the Browse window so that it covers the entire
screen.

3. Scroll right to see the remaining fields in CUSTOMER.DBF.

Session 1
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3

}

Company l Address I City
— | | errrr— e | YT
18232|1st Data Reductions Dennis Johnson 368 Riverview Farm Street Neu Orleans
12882] 1st Softuware Systems Ltd. Rance Sivren 23433 Chapel 121 Houston
12840 1st Survey Robert Hepuorth 733 Peeler 8bth Dallas
AB872|A Beck Pertamina Jin Ansarti 48081 Ste Arlington
A8818|A. Arts Computers Darryl Roudebus] 3385 Plantation Avenue Melrose
AG453|A. Bloomington Biz Phil Putnan 6388 East Drive Talahase
ABG18B|AZ Inc Ton Totah 2641 Wilshire Blud Avenue Taunton
AS5181|Abbymark Uelonex Isador Sweet 2139 Bridge Sciller Dallas
A3964|Acres Tree Solutions Russell Knmickle] 621 Ferndale Ste Park Sparta
A388Z2|Add Associates Len Silverman 318 N Sante Fe Ave Officell Novato
Add Inc Bert Crauford 253 Mitchell St Boulder
fAdder Incorporated Brenda Carturig 1237 Bering Bellevieu Warren
Adv. Softuare Barbara H. Mar 688 114th Ave Se Ste Ala Arlington
3784 Van Dyke Suite Street San Jose
ferial Inc. Lynn Uilliams 983 Highland Drive Uayne
R d AB982| Alex County Community Corp Rance Hayden 75 Briar Ave Langhan
€COrdS | az4a18|Alex Systems Nancy Uright 2416 Idaho Place S. Erie
AB887| American Computer Company Dick W Guyton 199 E Main Ala Lubbock
ABB39| American Forum Gui Dupuy Second Motor Seuard Santa Barbara
A9489| Anerican Innovations Garret Hill Uoodland Houe Ave Zussman Roselle
A4268|Ansari Data Softuare Uallace Campanelli |Black Touer Drive Ste Court Pittsburg
ABI3Z| Ansari Produce Oliver Mossangan 648481 Hunting Ridge Ave Spring Valley
AB516|Applied Telephone Realtors Michael Cumming 2232 Carlton Hills Place Neuton Square
A4862] Aspen Planning & Inc. Gary Erickson 148 Charleston Avenue Tulsa
ABB48| Aspen Technology Hel Colby 301 Broaduay Suite Place DeMitt
ABB48| Assoc American Chiminey Survey Elizebeth Pitts 121 Lady Ellen 1267 Excelsior
A7319| Assoc Strong Dick Nay 11438 St Belleville
AZ2695|Atec Data Service Randy Keji 4286 S Hardy Drive Ave Santa Clara
A9541|Automated Mayo Miley Bill Hopkins 521 Uhitney 415 Orange
A6294| Auard Ammonia Greenhouses Tony Lee Box South Court Boston
b | AB223| Azimuth Bavis & Systens Chuck Heitmeier 17618 Conesus Lake Auenue San Francisco
Figure 3: Browse Window Displaying a Portion of the Database
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You can also adjust the way data is displayed in the Browse window.
For instance, individual fields in a Browse window may be resized. Let’s
try making the COMPANY field smaller so that you can see more of the
other fields.

Sizing a Field
With the keyboard:

1. If the COMPANY field isn’t selected, Tab to it. Choose
Size Field from the Browse menu popup.

2. Use the Left Arrow key to shorten the field, then press
Enter.

With the mouse:

Point to the line between the CONTACT field and the
COMPANY field, press the mouse button and drag.
Release the mouse when the field is the width you
want.

Figure 4 shows the resized COMPANY field.

It is important to note that you are just changing the way the data
appears. You are in no way affecting the way data is stored in the
database file.
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CUSTOMER
Contact

[TA02 1[It Computers o |Peit o Culbertson |

18232
12882
128480
A8872
A8818
AG4539
A6188
A5181
A3964
A3882
A1646
A7249

Cno

ist Data Reductions
ist Softuare Systems Ltd.
ist Survey

A Beck Pertamina

A. Arts Computers

A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuare

Resized Field

Company

Dennis Johnson
Rance Siuren
Robert Hepuorth
Jim Ansarti
Darryl Roudebush
Phil Putnam

Tom Totah

5111 Parkuay
368 Rivervieu
23433 Chapel 1
733 Peeler 86
40081 Ste

3385 Plantatio
6388 East Dri
2841 Uilshire

Contact

Isador Sueet
Russell Kmickle
Len Silverman
Bert Crauford
Brenda Carturight

Barbara H. Martin

2139 Bridge Sd
621 Ferndale S
318 N Sante Fe
253 Mitchell S
1237 Bering Be
668 114th Ave

14821llst Computers Jeff W. Culbertson |5111 Parkuay

18232
12882
12848
A8872
A8818
AB459
A6188
AS5181
A3964
A3882
A1846
A7249
A3835

Session 1

1st Data Reductions
ist Softuare Systems Ltd.
ist Survey

A Beck Pertamina

A. Arts Computers

A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuare

Dennis Johnson
Rance Siuren
Robert Hepuorth
Jin Ansarti
Darryl Roudebush
Phil Putnan

Ton Totah

Isador Sueet
Russell Kmickle
Len Silverman
Bert Crauford
Brenda Carturight
Barbara H. Martin

368 Rivervieuw Farm Stree
23433 Chapel 121

733 Peeler 86th

4881 Roued Rd

3385 Plantation Avenue
6388 East Drive

2841 Uilshire Blud

2139 Bridge Sciller

621 Ferndale Ste Park
318 N Sante Fe Ave O0ffic]
253 Mitchell St

1237 Bering Bellevieu
608 114th Ave Se Ala

Figure 4: Browse Window with Field Resized
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Another way to change the way your data is displayed is to rearrange
the order of the fields. Why don’t you move some of the fields around so
you can see some important information?

Moving Fields
With the keyboard:

1. If the CNO field isn’t selected, Tab to it. Choose Move
Field from the Browse menu popup.

2. Press the Right Arrow key until CNO appears between
COMPANY and CONTACT, then press Enter.

With the mouse:

Point to CNO, press the mouse button and drag CNO until
it is located between COMPANY and CONTACT.

Figure 5 shows the relocated CNO field.
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Company

CUSTOMER
Contact
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14021llst Computers IJeff U. Culbertson |5111 Parkuay

18232
12882
12840
8872
A8818
A6459
A6188
A5181
A3964
A3882
A1846
A7249
A3835

ist Survey

A Beck Pertamina
A. Arts Computers
A. Bloomington Biz
AZ Inc

Abbymark Uelonex

Add Associates
Add Inc

Adder Incorporated
Adv. Softuare

Moved Field

Company

ist Data Reductions
ist Softuware Systems Ltd.

Acres Tree Solutions

Dennis Johnson
Rance Sivren
Robert Hepuorth
Jin Ansarti
Darryl Roudebush
Phil Putnan

Ton Totah

Isador Sueet
Russell Kmickle
Len Silverman
Bert Crauford
Brenda Carturight
Barbara H. Martin

Cno |Contact

368 Rivervieu Farm Streg]
23433 Chapel 121

733 Peeler 86th

4881 Rowed Rd

3305 Plantation Avenue
6388 East Drive

2841 Uilshire Blud

2139 Bridge Sciller

621 Ferndale Ste Park
318 N Sante Fe Ave Offid
253 Mitchell St

1237 Bering Bellevieu
688 114th Ave Se Ala

TSt Computers o J|L262][Pett U- Culbertson—|

ist Data Reductions
ist Softuare Systems Ltd.
ist Survey

A Beck Pertamina

A. Arts Computers

A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuare

18232| Dennis Johnson
12882| Rance Siuren
12840’Robert Hepuorth
A8872|Jim Ansarti

A8818| Darryl Roudebush
A6459| Phil Putnan
A6188| Ton Totah

A5181| Isador Sueet
A3964| Russell Kmickle
A3882|Len Silverman
A1046]| Bert Crauford
A?249| Brenda Carturight
A3835|Barbara H. Martin

Figure 5:

Session 1

5111 Parkuay

368 Rivervieu Farm Stree
23433 Chapel 121

733 Peeler 86th

40081 Rouwed Rd

3385 Plantation Avenue
6308 East Drive

2841 UWilshire Blud

2139 Bridge Sciller

621 Ferndale Ste Park
318 N Sante Fe Ave Offic
253 Mitchell St

1237 Bering Bellevieu
6008 114th Ave Se Ala

Browse Window with Field Moved

S4-9



Looking at Your Data

S4-10

“What if I want to see all of my fields at the same time?” you may ask.
With FoxPro, it’s no problem! Just switch the Browse window to Change
mode.

Viewing Data in Change Mode

1. Choose Change from the Browse menu popup. The
Browse window appears in Change mode. (Figure 6)

2. Scroll through some records.

In Change mode, you can see all of the fields in CUSTOMER.DBF at once.
You can toggle back and forth between Browse and Change modes at
will. Exercise your will and return to Browse mode.

Returning to Browse Mode

Choose Browse from the Browse menu popup.
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CUSTOMER
[T LUl lst Computers
Cno
[T T3 Jeff W. Culbertson
Address SRRRENETYNICT]
City Brookline
State
Zip
Phone
Ono
Ytdpurch
Lat
Long

Company 1st Data Reductions
Cno 18232
Contact Dennis Johnson

Figure 6: Browse Window in Change Mode

Session 1 S4-11



Looking at Your Data

S4-12

Another useful way to look at data is to split the Browse window into
two partitions. Now you can use the little control in the lower left
corner of the Browse window that you've been wondering about since the
beginning of this session. This control is called the window splitter.

Splitting the Browse Window
With the keyboard:

1. Choose Resize Partitions from the Browse menu popup,
then press the Right Arrow key until you see two
COMPANY fields then a second CNO field. (Figure 7)

2. In the right partition, scroll to the right to see more
fields. (Figure 8)

With the mouse:

1. Point to the window splitter and drag it to the right until
you see two COMPANY fields then a second CNO field.
Release the mouse button. (Figure 7)

2. In the right partition, scroll to the right to see more
fields. (Figure 8)
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CUSTOMER
Company Company

ist Computers 1st Computers I14821IJeff u.

1st Data Reductions ist Data Reductions 18232| Dennis
ist Softuare Systems Ltd. ist Softuare Systems Ltd. |12882
ist Survey 1st Survey 12840
A Beck Pertamina A Beck Pertamina A8872
A. Arts Computers A. Arts Computers A8818

A. Bloomington Biz A. Bloomington Biz AB459
AZ Inc AZ Inc A6188
Abbymark Uelonex Abbymark Uelonex A5181
Acres Tree Solutions Acres Tree Solutions A3964
Add Associates Add Associates A3882
Add Inc Add Inc A1846
Adder Incorporated Adder Incorporated A7249
Adv. Softuare Adv. Softuare A3835

Window Splitter I
Figure 7: Browse Window Spilit into Two Partitions

CUSTOMER
Company Cno City

EaETT— | e Crrrm— | o sz
LA

1st Data Reductions 1823Z2| @ New Orleans 70113]|5084/524-3966
1st Softuare Systems Ltd. |12682 Houston X 77835|713/723-1288
1st Survey 12848 Dallas X 75234|214/243-724
A Beck Pertamina A8872 Arlington HA 82174|617/643-6920
A. Arts Computers A8818| Melrose MA 82176|617/662-015
A. Bloomington Biz AB459 Tallahassee FL 32381|984/222-945
AZ Inc A6188| @ Taunton HA 82780|617/823-5180
Abbymark Uelonex A5181 Dallas TX 75201|214/922-492
Acres Tree Solutions A3964| B Sparta NJ 87871|281/786-0878
Add Associates A3882 Novato cAa 94947| 415-897-2818
Add Inc A1046|§l Boulder co 80303| 383/499-2086
Adder Incorporated A?249 Uarren HI 48893} 313/573-5873
Adv. Softuare A3835| Arlington MA 82174]| 617/646-7974)M

t— Left Partition I [ Right Partition ——I

Figure 8: Browse Window with Right Partition Scrolled
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Perhaps you're wondering why you would want to split the Browse win-
dow. Wonder no longer! You can:

* Scroll through the fields in one partition without moving the fields in
the other partition.

* Change the mode of one partition to Change mode while leaving the
other partition in Browse mode.

Selecting a Partition and Changing its Mode
With the keyboard:

1. If the right partition is not selected, choose Change
Partition from the Browse menu popup.

2. Choose Change from the Browse menu popup, then
scroll through records with the Up and Down Arrow
keys. (Figure 9)

With the mouse:
1. Point to the right partition and click.

2. Choose Change from the Browse menu popup, then
scroll through records with the Up and Down Arrow
keys. (Figure 9)

Notice that the same record is selected in both partitions as you scroll
because the partitions are linked.

S4-14
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Left Partition in Browse Mode  Right Partition in Change Mode

! b !

CUSTOMER
Company Cno Company

Cno

ot Computers o (12020 | Rl Jeff U, Culbertson
ist Data Reductions 18232| @ Address EISSEREISUET

ist Softuare Systems Ltd.|12882|§ City Brookline

1st Survey 128406| @ State

A Beck Pertamina AB8B72| N Zip

A. Arts Computers AB8818| Phone

A. Bloomington Biz AG459| N Ono

AZ Inc A6188| R Ytdpurch

Abbymark Uelonex AS181|H Lat

Acres Tree Solutions A3964|Q Long

Add Associates A3882
Add Inc A1646|@ Company 1st Data Reductions
Adder Incorporated A7243| Cno 18232

Adv. Softuare A3835|M Contact Dennis Johnson

Figure 9: Browse Window with Partitions in Different Modes

Session 1 S4-15



Looking at Your Data

S4-16

Now you’ll see how versatile the Browse window is. Unlink the parti-
tions and scroll through the records in one partition, leaving records in
the other partition unchanged.

Unlinking Partitions

Choose Unlink Partitions from the Browse menu popup,
then scroll through some records.

Remember that everything you have done to this Browse window is for
display purposes only. You have not changed the way the information is
actually stored.
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L Right Partition in Change
Left Partition in Browse Mode Mode viewing different records

CUSTOMER
Company 122.5647

T | [ coweany Add nc

ist Data Reductions Cno A1846

ist Softuare Systems Ltd. Contact Bert Crauford
ist Survey Address 253 Mitchell St
A Beck Pertamina City Boulder

A. Arts Computers State co

A. Bloomington Biz Zip 80383

AZ Inc Phone 3837499-2886
Abbymark Uelonex Ono 5

Acres Tree Solutions Ytdpurch 161.78

Add Associates Lat 40.8233

Add Inc Long 185.2741

Adder Incorporated
Adv. Softuare Adder Incorporated

Figure 10: Browse Window with Partitions Unlinked

Session 1 S4-17



Looking at Your Data

S4-18

Closing the Browse Window

Click on the close box or chose Close from the File menu
popup.

Notice that the Command window is slightly different than when you
first opened the Browse window. When you choose options from the in-
terface, FoxPro generates commands in the Command window. Fig-
ure 11 shows two commands that FoxPro has generated. You will learn
more about the Command window as you proceed.

The CUSTOMER database is only one of the .DBF files provided. Another
file included is SALESMAN.DBF. This database contains data about the
salesmen at our sample business.

Let’s look at SALESMAN.DBF in a Browse window.

Browsing SALESMAN.DBF

1. Choose Open... from the File menu popup. Make sure
TUTORIAL appears on the Directory popup.

2. Select SALESMAN.DBF, then choose the Open push
button.

3. Choose Browse from the Database menu popup. The
Browse window appears as in Figure 12.

The Browse window displays salesman information in a familiar fashion.
Each record represents a salesman, with each field containing informa-
tion about that salesman.
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USE C:\FOXPRO\TUTORIAL\CUSTOMER. DBF
BROWSE LAST

Looking at Your Data

Figure 11: Commands Executed For You

SALESMAN
Ytdsales

Phone

Address

Session 1

Janet A. McCarthy
Robert Watters
Doris Dupuy

T Staziola Tounsend
John Hodge

Houward Schneider
Jay Kennedy

Tom Caravello

E. Faulkner

21427.27
24762.85
[ 26263.99

7798.34
182797.63
42181.43
58521.98
69118.59
166804. 70

283/569-1163
617/894-4332

61?/6?8—48?1

617/273-2904
412/981-7562
215/432~-3822
212/246-5348
281/5293-2831
883/776-8662

1417 S Dearborn Ci
1225 Church St.
336 N.E. 23rd St

7089 South Broad A
748 Summer Ave
4821 U. Lunt Ave.
938 Sherman Uay

Figure 12: Browse Window for SALESMAN.DBF
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In SALESMAN.DBF, you'll notice a rather unusual NOTES field between

the ONO and NAME fields. This field contains the word “Memo” or

“memo.” A memo is a type of field that can hold any amount or type of

information. Because this information may be several pages long, it

would be difficult to display it in the standard Browse format. Instead,

%rioixdcan open a memo window to view the information contained in this
eld.

Because a memo window is like other windows, you can move it and
resize it to make it easier to see both the memo field information and
the Browse window at the same time. Give it a try.

Opening, Resizing and Moving a Memo Window
With the keyboard:

1. Select the word Memo next to Janet A. McCarthy and
press Ctrl+PgDn.

2. Resize the memo window, then move it so that it appears
below the Browse window on your screen. (Figure 13)

3. Select the Browse window and scroll with the Up and
Down Arrow keys.

With the mouse:

1. Point to the word Memo next to Janet A. McCarthy and
double-click.

2. Resize the memo window, then move it so that it appears
below the Browse window on your screen. (Figure 13)

3. Select the Browse window and scroll with the Up and
Down Arrow keys.

“Why,” you may ask, “is there a Memo and a memo?”

The difference in capitalization tells you at a glance whether a particular
memo field contains information. A capital “M” says that there is indeed
information in this memo field and a lower-case “m” says, “don’t bother
looking in this here memo field, ’cause it’s as empty as a gas tank the
day before payday.”

As you scrolled through the records with the arrow keys, you probably
noticed that the information in the memo window changed to match the
current record in the Browse window. You probably also jumped up and
said, “That’s fantastic!” If you didn’t, you should have.

S4-20 Session 1



Inactive Browse Window

L.

Ytdsales
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Phone

Address

anet A. McCarthy
+

Doris Dup!

T Staziola Toun:
John Hodge
Houard Schneider
Jay Kennedy

Tom Caravello

E. Faulkner

21427.27
24762.85
208203. 99
7798.34

Tagz%
421817

50521.98
69118.59
160084. 70

SALESMAN. NOTES .
Janet has been salesperson of the month for one consecutive month!

Active Memo Window with Controls Showing

Figure 13

283/569-1163
617/894-4332
617/679-4071
617/273-29084

2081/523-289

1417 S Dearborn Ci
1225 Church St.

336 N.E.
1812 C Renault St

23rd St

4821 UW. Lunt Ave.

883/776-8662] 938~Shey

Active Browse Window with Controls Showing and Record Selected

Inactive Memo Window

SALESMAN
Ytdsales

Phone

Address

Janet A. McCarthy
Robert Watters

azdala Tounsend
John Hodge

Howard Schneider
Jay Kennedy

Tom Caravello

E. Faulkner

SAL

Doris is lazy.
biggest clients.

Session 1

21427.27
24762. 85

7798. 34
182797.63
\421§%;22

58521758
69118.59
16884. 78

[Z0263. 99

283/569-1163
617/894-4332

b17/679-4871]|

617/273-29084
412/981-7562
2157432-3822
2/246-5348
20173232831
803/776-866.

ESMAN. NOTES

Figure 14

1417 S Dearborn Ci
1225 Church St.
336 N.E. 23rd St
1812 C Renault Str
621 Industrial Way
789 South Broad Av
748 Summer Ave

U. Lunt Ave.

She needs to be terminated but her father is one of our
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You can see why we said at the start of this session that the Browse
window is a very powerful tool for viewing and editing your information.

“Wait,” you say, “you haven’t said a thing about editing my information.”

Let’s talk a minute about editing your information. Whenever you are in
a standard Browse window, you can scroll to a particular record and
change the content of that record. It's as simple as that.

You will work with changing information later on. You can also add and
delete records while you are in a Browse window, but you will learn
about that later, too.

Let’s clean up now and take a short break.

Closing the Browse Window and Exiting FoxPro
With the keyboard:

Press Escape, then choose Quit from the File menu popup.
With the mouse:

Click on the close box of the Browse window, then choose
Quit from the File menu popup.
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Retrieving Your Data

In this session you'll learn to open FoxPro’s
powerful RQBE window, quickly mastering
techmques for gathenng specific information

from your database file.

® Opening the RQBE window . . . . . . page 2
® Browsingaquery ........... page 4
® Modifyingaquery. ... ....... page 6
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Retrieving Your Data

In the last session you learned about viewing data. This is an important
subject, but the primary reason to store data on a computer is so you can
quickly extract certain pieces of that data.

The process of extracting information is called querying. FoxPro has an
incredibly powerful, yet stunningly simple, querying facility called RQBE.
RQBE stands for Relational Query By Example.

* Relational refers to FoxPro’s ability to relate the database files
needed to perform the query.

* Query means to question or inquire.

* By Example is the way that you naturally ask questions such as,
“Can you tell me how many companies are located in CA?”

RQBE allows you to look at your data this way and that, or the other way
if you prefer, with speed and simplicity. If you can imagine it, FoxPro’s
RQBE can show it to you.

Let’s explore FoxPro’s RQBE facility.

Opening the RQBE Window
1. Start FoxPro.
2. Choose New... from the File menu popup.

3. In the New File dialog, choose the Query radio button
(Figure 1), then choose OK.

4. In the Open File dialog, make sure TUTORIAL is showing
on the Directory popup, select CUSTOMER.DBF
(Figure 2), then choose Open.

The RQBE window appears as in Figure 3.
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Database
Progran
File

Index « OK »
Report
Label < Cancel >
Screen
Henu

Query

Pro ject

AAAAAAAAANAN
WV

Figure 1: New File Dialog

Retrieving Your Data

Select database:

[ 1 All Files

[..] Drive C
|
DETAIL. DBF
INUOICES. DBF
OFFICES. DBF Directory | TUTORIAL “
PARTS. DBF
SALESMAN. DBF
« Open »
< Cancel >

Figure 2: Open File Dialog

ROBE - UNTITLED
Databases Output Fields

»CUSTOMER CNO [X] Select Fields...
COMPANY

CONTACT L 1 Order By...
ADDRESS

CITY C 1 Group By...

< Add > STATE L 1 Having...

< Clear >

Output To

[ 1 Options...

< See SQL >
« Do Query »

Field Namne NOT Example

U=L Select

Criteria
<Insert>
<Remove>

< Or >

Figure 3: RQBE Window

Session 2

Do Query
Push Button
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When you perform a query, FoxPro keeps you posted about its progress,
reading records and such. You will see status messages as the query
progresses. When the query is complete, FoxPro shows you the number
of records selected and the amount of time it took to answer your query.
Not long!

Youlll output the results of your query to a Browse window. You can
manipulate the Browse window just as you did in Session 1.

Doing a Query

1. Choose the Do Query push button in the RQBE window.
Figure 4 shows the status message.

2. The Browse window appears as in Figure 5. Scroll
through some records in the Browse window.

Note that what you are looking at is just a copy of the actual data — you
cannot use this Browse window to modify the data in any way. But it
does provide you with an excellent way to view the requested data.

The Browse window takes its fields from the Output Fields list in the

RQBE window. The default for a newly opened database is to display all
fields.

Session 2
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Company

Selected 588 records in 1.54 seconds

Retrieving Your Data

I 1st Computers
18232
12882
12840
AB8872
A8818
AB459
A6188
AS181
A3964
A3882
A1846
A7249

i1st Data Reductions
1st Softuare Systems Ltd.
1st Survey

A Beck Pertamina

A. Arts Computers

A. Bloomington Biz
AZ Inc

Abbymark Velonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated

Adv. Softuare

|[Jeff U. Culbert

Dennis Johnson
Rance Siuren
Robert Hepuort|
Jim Ansarti
Darryl Roudebus
Phil Putnam
Tom Totah
Isador Sueet
Russell Kmickle]
Len Silverman
Bert Crauford
Brenda Carturig
Barbara H. Mar

Figure 4: Query Output with Status Message
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Cno

Company

1st Computers
18232]1st Data Reductions
12882] 1st Softuare Systems Ltd.
12848] 1st Survey

A8872]|A Beck Pertamina
A8818]A. Arts Computers
AB459]A. Bloomington Biz
A6188|AZ Inc

A5181] Abbymark Uelonex
A3964)Acres Tree Solutions
A3882|Add Associates
A1846]Add Inc

A?7248]|Adder Incorporated
A3835|Adv. Softuare

IJeff W. Culbert
Dennis Johnson
Rance Sivuren
Robert Hepuort
Jim Ansarti
Darryl Roudebus]
Phil Putnam
Tom Totah
Isador Sueet
Russell Kmickle
Len Siluerman
Bert Crauford

Figure 5: Query Results in a Browse Window
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You can also tell RQBE that you want to include only certain fields.

Let’s say that you don’t need to see the CNO, ADDRESS, ZIP and ONO
fields. You can return to the RQBE window and specify the fields that
you do want to include in your output.

Specifying Fields in a Query
1. Close the Browse window.

2. In the RQBE window, choose the Select Fields... check box
to display the RQBE Select Fields dialog. (Figure 6)

3. Choose the Remove All push button to clear the Selected
Output list.

4. Select the COMPANY field in the Database Fields list and
choose the Move — push button.

If you have a mouse, try double-clicking on the COMPANY
field. It has the same effect as selecting the field and
choosing Move —.

5. Repeat step four for the following fields: CONTACT,
PHONE, CITY, STATE and YTDPURCH.

6. When the RQBE Select Fields dialog appears as in Figure
7, choose OK. The selected fields appear in the
Output Fields list in the RQBE window.

You may have wondered why we told you to select the fields in the order
we did. The order that you select the fields will be the order that they’ll
appear in the Browse window after you do the query.
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ROBE - UNTITLED

Output Fields

»CUSTOMER

< Ada >
< Clear >

LXK X X1

CNO
COMPANY
CONTACT
ADDRESS
CITY
STATE

Retrieving Your Data

Output To

[£;VSelect Fields...

L 1 Order By...

[ 1 Group By...
[ 1 Having...

Brouse

L 1 Options...

< See SQL >
« Do Query »

Field Name

NOT

Example

U=L Select

Criteria
<Insert>
<Renove>

< Or >

Figure 6: RQBE Window

Database

Fields

CUSTOMER. CITY
CUSTOMER. STAT
CUSTOMER. ZIP
CUSTOMER. PHON
CUSTOMER. ONO
CUSTOMER. YTDP!
CUSTOMER. LAT
CUSTOMER. LONG

E

E

URCH

ZZTZTOOOOO

— Functions/Expressions

Functions

Selected Output

< HMove =+ >

< All + >

< Remove >

L R R AR R Y

<{Remove All>

CUSTOMER. COMPANY
CUSTOMER. CONTACT
CUSTOMER. PHONE
CUSTOMER.CITY
CUSTOMER. STATE
CUSTOMER. YTDPURCH

[ 1 No Duplicates
« OK »

< Cancel >

Session 2

Figure 7: RQBE Select Fields Dialog
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Doing the Query

Choose the Do Query push button in the RQBE window.
The Browse window appears as in Figure 8.

The Browse window now includes only those fields that you selected.
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Company

Contact
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1st Computers

1st Data Reductions

1st Softuare Systens Ltd.
1st Survey

A Beck Pertamina

A. Arts Computers

A. Bloomington Biz
AZ Inc

Abbymark Velonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Advu. Softuare

IJeff U. Culbertson
Dennis Johnson
Rance Sivren
Robert Hepuorth
Jin Ansarti
Darryl Roudebush
Phil Putnam

Ton Totah

Isador Sueet
Russell Kmickle
Len Silverman
Bert Crauford
Brenda Carturight
Barbara H. Martin

l617/232~5853

?713/723-1288
214/243-7247
617/643-6928
617/662-8157
984/222-9457
617/823-5188
214/922-4927
201/786-8785
415/897-2810
3037499-2886
313/573-5873
617/646-7974

Brookline

584/524-3966|Neu Orlea

Houston
Dallas
Arlington
Melrose
Talahase
Taunton
Dallas
Sparta
Novato
Boulder
Warren
Arlington

Figure 8: Browse Window Showing Specific Fields
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After studying the Browse, you may decide that you do not need to see
the CONTACT field. Try removing CONTACT and see how the query
output looks.

Removing Fields from a Query
1. Close the Browse window.
2. Choose the Select Fields... check box.

3. Select the CONTACT field in the Selected Output list,
then choose Remove.

4. Choose OK. Notice that CONTACT no longer appears in
the Output Fields list. (Figure 9)

5. Choose Do Query. The Browse window appears as in
Figure 10.

6. Size the Browse window then scroll through some
records.
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RQBE
Output Fields

- UNTITLED

»CUSTOMER

COMPANY
PHONE
CITY
STATE
¥TDPURCH

< Add >
< Clear >

[X] Select Fields...

[ 1 Order By...

Retrieving Your Data

Output To

QUERY
[ 1 Options...

[ 31 Group By...
[ 1 Having...

< See SQL >
<« Do Query »

Field Nane

Exanple

U=L Select

Output Fields List
Figure 9: RQBE Window

Company

Phone

City

Criteria
<Insert>
<Remoued>

< Or >

Ytdpurch

st Computers [P177232-5653 [Brookline |

1st Data Reductions

1st Softuare Systems Ltd.

1st Survey

A Beck Pertamina
A. Arts Computers
A. Bloomington Biz
AZ Inc

Abbymark Uelonex
Acres Tree Solutions
Add Associates

Add Inc

Adder Incorporated
Adv. Softuare

584/524-3966
713/723-1288
214/243-7247
617/643-6920
617/662-8157
984/222-9457
617/823-5180
214/922-4927
281/786-8785
415/897-28160
3083/499-2886
313/573-5873
617/646-7974

Neu Orleans
Houston
Dallas
Arlington
Melrose
Talahase
Taunton
Dallas
Sparta
Novato
Boulder
Warren
Arlington

|

1688. 35
2272.86
754.81
3991.66
3922.84
684.47
378.73
1398.17
272.48
5487. 46
161.70
?22.25
48208.51

Figure 10: Query Results without CONTACT Field
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Now that you have selected the fields, you can specify the order you
want the data presented. For instance, try displaying your data al-
phabetically by city.

Ordering Fields in a Query
1. Close the Browse window.

2. Choose the Order By... check box in the RQBE window.
(Figure 11)

3. In the RQBE Order By dialog, select CUSTOMER.CITY then
choose Move —. (Figure 12)

4. Choose OK. Notice that a 1 and T appear next to CITY
in the Output Fields list. The 1 indicates that CITY is
the first priority when ordering the data and the T in-
dicates that the data will be displayed in ascending
order.

5. Choose Do Query. The Browse window appears.
(Figure 13)

6. Sroll through some records in the Browse window.
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ROBE - UNTITLED

Output Fields

»CUSTOMER

< fdd >
< Clear >

COMPANY
PHONE
CITY
STATE
¥TDPURCH

L XX X

[X] Select Fields...

Retrieving Your Data

Output To

Brouse

[ 1 Order By...

[ 1 Group By...
L 1 Having...

QUERY

[ ] Options...

< See SQL >
<« Do Query »

Field Nanme

Example

U=L Select

< Or

Criteria

<Insert>

<Remove>

>

Figure 11: RQBE Window
Selected Output Ordering Criteria
CUSTOMER. COMPANY < Move -+ > $ t CUSTOMER.CITY
CUSTOMER. PHONE :
CUSTOMER. CITY < Remove > :
CUSTOMNER. STATE kS
CUSTOMER. YTDPURCH Order Options 3
(+) Ascending 3
C ) Descending 3
[ 1 Ignore Case 3
3
3
« OK » 3
:
< Cancel >

Figure 12: RQBE Order By Dialog

Company

Thinfilm Computer Inc | | T ——

The Circle Distributing Shop

Herring Inc.

Business State Computers
Crescent Computer Source
Posna Associates

Data
Baptist Im-pak

Soltis & Inc.

Sueet County

Min/Max Resource Systems
Control Communication & Compu
A Beck Pertamnina

Adv.

Session 2

White Truck Steel

Softuare

518/869-8738
5085/842-9778
2157481-8653
806/372-7291
617/475-9321
313/668-2612
313/769-3038
313/769-9768
415/439-3581
414/733-1643
818/796-5338
617/643-6928
617/646-7974

Albany
Albuquerque
Allentoun
Amarillo
Andover
Ann Arbor
Ann Arbor
Ann Arbor
Antioch
Appleton
Arcadia
Arlington
Arlington

NM
PA
TX
MA
MI
MI
HI
ca
WI
CA
MA
MA

Figure 13: Query Results in Order by CITY

(|
NY 1858. 88

50819.53
595.46
3764.21
2361.61
8876.77
3276. 16
848.80
1757.96
1807.280
6176.839
3991.66
4828.51
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You can order your data any way you want. For instance, suppose you
want your data ordered by state, and by city within each state. Now
change the order of the information to match.

1.
2.
3.

Ordering by Multiple Fields in a Query

Close the Browse window.
Choose the Order By... check box.

In the RQBE Order By dialog, select CUSTOMER.STATE then
choose Move —.

Adjust the order of the fields in the Ordering Criteria list.

With the keyboard, Tab to the Ordering Criteria list and
use the Down Arrow key to select STATE then press
Ctrl+PageUp so that STATE appears above CITY in the
list.

With the mouse, point to the double-headed arrow preced-
ing STATE in the Ordering Criteria list and drag it
until STATE appears above CITY in the list.

When the Order By dialog appears as in Figure 14, choose
OK.

Observe how the Output Fields list reflects your changes. The 1 preced-
ing STATE indicates the data is ordered first by STATE. The 2 in front of
CITY indicates that the data is ordered second by city within each state.
The arrows indicate that the data will be displayed in ascending order.

Doing the Query

Choose the Do Query push button in the RQBE window.
Figure 15 displays the results of the query.

The data in the Browse window is ordered just as you desired.

S5-14
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Selected Output

CUSTOMER. COMPANY
CUSTOMER. PHONE
CUSTOMER. CITY
CUSTOMER. STATE
CUSTOMER. YTDPURCH

< Move + >
< Remove >
Order Options

(+) Ascending
C ) Descending

[ 1 Ignore Case

Ordering Criteria

t CUSTOMER. STATE
t CUSTOMER.CITY

« 0K »

< Cancel >

3
3
3
3
3
3
3
3
3
3
3
$

Figure 14: RQBE Order By Dialog

Company

ergen Endeavors - |[207/543-3704 [bethel

Steven Computers
Walker Business Gallery
Harpoon Store

Great Form

Goods For The Masses

Harpoon PCA

Pro and Pouer

Raybank Services & Computin
Quik Assistance

SC Co.

Thralls Senski

Weichert Compuserve
Thinfiln Computer Inc

2685/881-2245
285/749-9881
561/663-37086
682/892-8572
682/276-5827
682/943-5882
6082/276-6239
6082/943-4609
6827953-8869
6827/991-1558
682/834-9367
684/381-2591
818/889-2717

Huntsville F
Opelika
Little Rock
Mesa
Phoenix
Phoenix
Phoenix
Phoenix
Scottsdale
Scottsdale
TEMPE
Uictoria
Agoura

Figure 15: Query Results in Order by STATE and CITY
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2244.
18297.
1688.
2523.
2684.
1727277.
348.
655.
5331.
543.
1419.
2208.
6892.
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Until now, you have been looking at all of the records in the CUSTOMER
database.

Now you can start asking questions — of your database, that is.

Suppose you ask, “What companies are located in Ohio?” Using the
RQBE window, this question is answered almost immediately.

Specifying Selection Conditions
1. Close the Browse window.

2. Choose CUSTOMER.STATE from the Field Name popup
located in the bottom portion of the RQBE window.
(Figure 16)

Like appears by default on the comparison popup
control. (Figure 16)

3. Type OH in the text box below Example. (Figure 16)
Be sure both letters are capitalized.

4. Choose Do Query. The Browse window appears.
(Figure 17)

. Scroll through some records in the Browse window.

The Browse window now displays the data for only those companies
located in Ohio. Like specifies that CUSTOMER.STATE must match OH to
be included in the output.
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Databases OQutput Fields Output To
»CUSTOMER 3 COMPANY [X] Select Fields... Brouse “
3 PHONE
$ 2t CITY [X]1 Order By...
$ 1t STATE [ ] Options...
$ YTDPURCH [ 1 Group By...
< Add > 3 [ ] Having... < See SQL >
< Clear > « Do Query »

NOT Example U=L Select
CUSTOMER. CNO Criteria
t | custoMER.company | [ 1 UEEE L1

CUSTOMER. CONTACT
CUSTOMER. ADDRESS
CUSTOMER.CITY
CUSTOMER. STATE
CUSTOMER. ZIP
CUSTOMER. PHONE
CUSTOMER. ONO
CUSTOMER. YTDPURCH

<Insert>
{Remoue>

< Or >

Comparison
Popup Control
Field Name
Popup Figure 16: RQBE Window

Phone

Company City

System County Medical Health
Legal Corp.

Micro Time Corp

Polytron Business Machines
Sacred City Steel Inc.
Steven Softuare Solutions
System Business Machines Ltd
Wright L. Tither & Sons.
Financial Stamps Of Builders
Raymond Computing

Patrick Inc

Maximal Computing Prosthesis
DPCS Produce

Toun Computer Systems

513/731-8835
513/381-5929
513/231-4793
216/292-4892
614/445-11087
614/224-7828
614/895-8647
5137434-5836
513/229-2046
216/851-3379
614/261-4356
6086/329-6350
513/677-7788

Cincinnati
Cincinnati
Cincinnati
Cleveland
Columbus
Columbus
Columbus
Dayton
Dayton

E Cleveland
Hilliard
Ironton
Mainville

Figure 17: Browse Window with Companies in Ohio
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Use the same simple procedure to display those companies located in
both Ohio and Michigan.

Specifying More Selection Conditions
1. Close the Browse window.

2. Select In from the comparison popup (between the Field
Name popup and the text box below Example.)
(Figure 18)

3. In the text box below Example, after OH type , MI.
(Figure 18)

4. Choose Do Query. The Browse window appears as in
Figure 19.

FoxPro displays only companies located in Ohio or Michigan because In
specifies that, to be included in the output, CUSTOMER.STATE must be
one of the items in the Example text box.
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Databases Output Fields Output To
»CUSTOMER 3 COMPANY [X] Select Fields...
3 PHONE
$ 2t CITY [X] Order By... QUERY
$ 1t STATE [ 1 Options...
3 YTDPURCH [ 1 Group By...
< fAdd > k2 [ 1 Having... < See SQL >
< Clear > « Do Query »
Field Name NOT Example U~L Select
Criteria
$ CUSTOMER. STATE Like OH, MI L1
Exactly Like <Insert>
More Than
Less Than <Renove>
Betueen
< Or >

Figure 18: RQBE Window

Comparison Popup

Company

Data Uhite Truck Steel 313/668—2612 IE[.I 8876. 77]
MI

Baptist Im-pak 313/769-3838]| Ann Arbor 3276. 16
Soltis & Inc. 313/769-9768| Ann Arbor MI
Hennekee House World 5177/351-6879| East Lansing MI
Legal Inc 313/624-3487| Farmington Hill
Calif Beauty Inc. 616/241-3767|Grand Rapids
Johnson Specialties 517/784-5598} Jackson
Conputer Logic Hurdman 517/393-96837| Lansing
California Alarm 3137/356-5421] Southfield
Adder Incorporated 313/573-5873| Warren

System County Medical Health|216-/285-1281]Chardon

Legal Corp. 513/731-8895|Cincinnati
Micro Time Corp 513/381-5929| Cincinnati
Polytron Business Machines |513/231-4793|Cincinnati

Figure 19: Browse Window with Companies in Michigan and Ohio
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Perhaps it would be better to see the data ordered by company name
within each state, instead of by city. Give it a try.

Specifying and Ordering Selection Conditions

Close the Browse window.

Choose the Order By... check box.

Select CUSTOMER.CITY then choose Remove.

Select CUSTOMER.COMPANY then choose Move —.
Choose OK. The RQBE window appears as in Figure 20.

A

Choose Do Query. The Browse window appears as in
Figure 21.

The companies are now ordered alphabetically by company name within
each state. Because you haven’t changed the selection criteria, only com-
panies located in Ohio or Michigan are displayed.
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ROBE - UNTITLED
Output Fields

Databases Output To

Brouse J

QUERY
L 1 Options...

»CUSTOMER 3+ 2t COMPANY
3 PHONE

3 CITY

3 11 STATE

3 YTDPURCH
3

[X] Select Fields...

[X]1 Order By...

[ 1 Group By...
[ 1 Having...

< Add >
< Clear >

< See SQL >
« Do Query »

Field Name Select

Criteria

Example

% CUSTOMER.STATE OH, MI

<Insert>
<Remove>

< Or >

Figure 20: RQBE Window

Phone City

B15/573-5573

313/769-3038| Ann Arbor
616/241-3767| Grand Rapids
313/356-5421| Southfield
517/393-9837| Lansing
313/668-2612] Ann Arbor

Company

Adder Incorporated F

Baptist Im—pak

Calif Beauty Inc.
California Alarm
Computer Logic Hurdman
Data White Truck Steel

.25
3276. 16
2304.
1982.
3132.
8876.

Hennekee House World
Johnson Specialties
Legal Inc

Soltis & Inc.

DPCS Produce

Financial Stamps Of Builders
Legal Corp.

Maximal Computing Prosthesis

517/351-6879
517,784-5598
313/624-3487
313/763-9768
6086-323-6358
513/434-5036
513/731-8835
614/261-4356

East Lansing
Jackson
Farmington Hill
Ann Arbor
Ironton

Dayton
Cincinnati
Hilliard

1921.
358.
9521.
848.
136.
1915.
3743.
1656.

Figure 21: Browse Window with Companies Ordered Alphabetically by
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RQBE allows you to specify multiple selection conditions.

Suppose you want to look at only those companies in Ohio or Michigan
whose year-to-date purchases are more than 51,000.00.

By now you realize how easy it is to specify this using the RQBE window.

Specifying Even More Selection Conditions
1. Close the Browse window.

2. Place the cursor below CUSTOMER.STATE and choose
CUSTOMER.YTDPURCH from the Field Name popup.

3. Choose More Than from the comparison popup.
4. In the text box below Example, type 1000.

5. When the RQBE window appears as in Figure 22, choose
Do Query. The Browse window appears. (Figure 23)

As expected, all of the records displayed match the conditions that you
specified.

With RQBE, just a few keystrokes allow you to retrieve and combine in-
formation from your database.
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Databases Output Fields Output To
»CUSTOMER k4 COMPANY [X] Select Fields... ‘
3 PHONE
$ 2t CITY [X] Order By...
$ 11t STATE [ 1 Optioms...
3 YTDPURCH [ 1 Group By...
< Add > 3 [ 1 Having... < See SQL >
< Clear > « Do Query »
Field Name NOT Example U~L Select
Criteria
$ CUSTOMER. STATE £ 11In OH, MI L1
£ CUSTOMER. YTDPURCH [ [ 1| <Insert>

<Remove>

< Or >

Session 2

Figure 22: RQBE Window

Company

Baptist Im-pak

Calif Beauty Inc.
California AlarmM
Computer Logic Hurdwan
Data White Truck Steel
Hennekee House World

Legal Inc
Financial Stamps Of Builders|513/7434-5836

Legal Corp.

Maximal Computing Prosthesis

PC Bogg Center
Raymond Computing
Sacred City Steel Inc.

Steven Softuware Solutions

313-/769-3838
616/241-3767
313/356-5421
517/393-9837
313/668-2612
517/351-6879
313/624-3487

513/731-8835
614/261-4356
419/629-6499
513/229-2846
216/292-4892
614/445-1187

Grand Rapids
Southfield
Lansing

Ann Arbor
East Lansing
Farmington Hill
Dayton
Cincinnati
Hilliard

Neu Bremen
Dayton
Cleveland
Columbus

Figure 23: Companies in Michigan or Ohio with Year-to-Date
Purchases > $1000
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Consider this scenario. You spoke to a man on a plane about an order
and you entered his information into your CUSTOMER database file.
Nine months later he calls and says, “I talked to you on the plane from
Denver and if you can tell me my name, I will give you a one million
dollar order.”

“Oh my gosh!” you think. But you don’t remember anything about him
except that his company’s name begins with “Tr”. Aren’t you glad that
you have RQBE?

Gathering Specific Information With RQBE

1. Close the Browse window.

2. Check the Select Fields... check box then select CUS-
TOMER.CONTACT and choose Move —. Rearrange the
fields so that CONTACT is below COMPANY in the
Selected Output list. Choose OK.

3. Select CUSTOMER.YTDPURCH from the Field Name popup
then choose the Remove push button under Select
Criteria.

4. Change CUSTOMER.STATE to CUSTOMER.COMPANY on the
Field Name popup control.

5. Select Like from the comparison popup.

6. Type Tr in the Example text box.

7. When the RQBE window appears as in Figure 24, choose
Do Query. The Browse window appears as in Figure
25.

Query output lists only companies beginning with “Tr” so you can scroll
until you find the right name.

“Mr. Kieckheser, how could I forget you. How are things at Triad Resort
Computers?”

This is when you write Fox Software with your “unsolicited” testimonial.

Session 2



ROBE - SESSIONZ
Output Fields

Databases

»CUSTOMER 3 2t COMPANY
CONTACT

PHONE

it STATE
YTDPURCH

3
3
3 CITY
3
< Add > 3

[X]1 Select Fields...
[X] Order By...

[ 1 Group By...

[ ] Having...

< Clear >

Retrieving Your Data

Output To

QUERY
[ 1 Options...

< See SQL >
« Do Query »

Field Name NOT

Example

U=L Select

Criteria

$ CUSTOMER. COMPANY [ 1 Like

Tr

L1
<Insert>

<Remove>

< Or >

Figure 24:

Company

RQBE Window

Contact

Phone

Tri-Chem Systems
True Computer
Triad Systems

Tri-3 Latent Softuare
True DSSD
Tri-8 Data Data-Corp

Triad Resort Computers

Charlie Dobos
Bill Olsen
Marion Albright
Jeff Lund

Bill Griffin
Paul Hedgepath

Frank Kieckheser

Figure 25: Query Results

Session 2

415/941-2488
415/943-8436
389-734-6280
212/689-2378
516/231-5288
215/868-7225

215/328-8870
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When you close the RQBE window, FoxPro asks if you want to save your
changes. This allows you to use a specific RQBE window many times
without re-entering all of the same information. Go ahead and save this
RQBE window — you will use it again.

Closing the RQBE Window
1. Close the Browse window.

2. Close the RQBE window then choose Yes from the Save
Changes alert. The Save As dialog appears.

3. Make sure TUTORIAL appears on the Directory popup
control, type Session2 in the text box as shown in
Figure 27 then choose Save.

You have worked hard and deserve another break. But try not to take
as long as last time.

In this session you set out to learn that Queries are Easily Done. As
they say in Latin, Q.E.D.

Session 2
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Do you uant to save changes to
C:\FOXPRONTUTORIAL\UNTITLED. QPR?

« Ves » < No > <C Cancel >

Figure 26: Save Changes Alert

Save Current Document As:

»[..1] Drive C “
UNTITLED. QPR
Directory | TUTORIAL “

« Save »

[ 1 All Files < Cancel >

SESSIONZ

Figure 27: Save As Dialog
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Reporting on Your Data

In this session you 'll learn how to use FoxPro’s
RQBE to quickly design and generate professional
reports from your data.

®* Opening an existing query . . . . . . page 2
® Generatingareport. .. .. ... .. page 6
® Modifyingareport ... ...... page 10
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Reporting on Your Data

In the last session you used RQBE to display information in a Browse

window.

Another way to present information is in a printed report.

You can use the RQBE facility to create reports for every situation. You
can then customize the report using FoxPro’s powerful Report Writer.

The first report you'll create is a phone list of all of the customers
located in California. Youll begin with the query that you created in
Session 2.

Opening an Existing Query
1.
2.

Close the Command window.

Choose Open... from the File menu popup and make sure
Query is showing on the Type popup control in the
Open File dialog. (Figure 1)

. Select SESSION2.QPR, then choose Open.

You'll include the following fields in your phone list: COMPANY, PHONE,
CONTACT, CITY and STATE. The information should be presented in al-
phabetical order by company.

S6-2

Generating a Report with RQBE
1.
2.

Choose the Select Fields... check box.

Select CUSTOMER.YTDPURCH from the Selected Output
list and choose Remove.

. Rearrange the order of your fields in the Selected Output

list so that CONTACT is below PHONE and choose OK.

Change CUSTOMER.COMPANY to CUSTOMER.STATE on the
Field Name popup.

5. Type CA in the text box below Example.

Choose Report/Label on the Output To popup.

7. When the RQBE window appears as in Figure 2, choose
Do Query.

Session 3
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Open:
[..1 Drive C
| c |
Directory | TUTORIAL “
«  Open »
[ 1 All Files < Neuw >

Query ﬂ Type < Cancel >

Figure 1: Open File Dialog

Type Popup Control
Output To Popup Control

ROBE - SESSIONZ2
Databases Output Fields Output To

»CUSTOMER $ 2t COMPANY [X] Select Fields... Report/Labelﬂ
PHONE

CONTACT [X1 Order By...
CITY [ 1 Options...
it STATE [ 1 Group By...
< Add > [ 1 Having... < See SQL >
< Clear > « Do Query »

Field Name NOT Example U~L Select
Criteria

$ CUSTOMER. STATE [ 1 Like CA [1
<Insert>

<Remoue>

< Or >

Figure 2: RQBE Window
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Take a look at the report that is generated from these settings as shown
in Figure 3.

This initial report includes all of the correct information, but a clearer
layout will enhance its effectiveness.

Viewing the Report and Returning to RQBE
To scroll through the entire report:

+ Continue to press any key until you return to the RQBE
window.

To return immediately to the RQBE window:

¢ Press Escape.
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(' System File Edit Database Record Program UWindou
Add Associates 415/897
CA Press any key to continue ...
Advantage Computer School 4887946 se
cA
American Forum 885/682-5588 Gui Dupuy Santa Bar
bara CA
Atec Data Service 488/246-5353 Randy Keji Santa Cla
ra CA
Automated Mayo Miley 714/548-6862 Bill Hopkins Orange
cA
Azimuth Bavis & Systems 4157989-1683 Chuck Heitmeier San Franc
isco CA
Azimuth Corp 619/271-8518 Al Reetz San Diego
CA
Battery Weaver 415/952-7761 Brian Case S.San Fra
ncisco CA
BelMar Fishing Systems 4157/323-2469 Mike Ozer Menlo Par
3 CA
BelMar Tronixs Computer Compuserve 213/452-9369 Andy Rigney Santa Mon
ica cA
Big Incorporated 818/762-5886 Bert Dalgleish N. Hollyu
ood CA
Blake Inc. 4157992-8718 Bob Dot Daly City
cA
\_ /
Figure 3: Initial Report Displayed on Screen
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You can create a custom layout by making a few selections in the RQBE
Display Options dialog.

This is done by telling FoxPro what report form to use to display the
data. RQBE can also automatically create a report form for you based on
the information that you specify in the RQBE window.

For example, your Session 3 report will include the fields you select, in
the order you specify.

Generating a Report with RQBE

1. Choose the Options... check box in the RQBE window.
(Figure 4)

2. Choose the Report radio button in the RQBE Display
Options dialog and check the Quick Report... check
box. (Figure 5)

3. In the RQBE Quick Report dialog, type SESSION3 in the
Save as text box (Figure 6) then choose OK.

4. Notice that the Preview Report/Label check box is auto-
matically checked. Choose OK in the RQBE Display
Options dialog.

Session 3
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Reporting on Your Data

Databases Output Fields Output To
»CUSTOMER $ 21 COMPANY [X]1 Select Fields...
3 PHONE
3 CONTACT [X1 Order By...
3 CITY [ 1 Options... ] ——
$ 11 STATE [ 1 Group By...
< Add > 3 [ 1 Having... < See SQL >
< Clear > « Do Query »
Field Name NOT Example U~L Select
Criteria
$ CUSTOMER. STATE [ 1 Like CA L1

<Insert>
<Renove>

< Or >

Figure 4: RQBE Window

Report
Radio
Button

— Formatting Options

ROBE Display Options:

C > Screen Display

(+> Report

C > Label
[X]1

Report/Label Form Name
SESSION3

OQutput Destinations
[ 1 To Printer
[ 1 To File

[ 1 Overurite File

Session 3

—— [ 1 Quick Report... [ 1 Overurite
[X]1 Previeu Report/Label
[ 1 Shou Summary Info Only « 0K »
[ 1 Eject Page Before Report
[ 1 Report Heading < Cancel >
[ 1 Suppress Column Headings
(-) Console On C ) Console Off
[X]1 Pause Betueen Screens
Figure 5: RQBE Display Options Dialog
e e

ROBE Quick Report:

(+) Column Layout
C ) Form Layout

Report Width

Fieldl Field2
XXXXXX XXXXXX
XXXXXX XXXXXX
XXXXXK XHXXXXX

Save as NNV E]

<« OK »

< Clear >

Figure 6: Quick Report Dialog
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Doing the Query

Choose Do Query.

Remember the Preview Report/Label check box that was automatically
checked? This is why the output appears in a Page Preview window,
with columns and headings, rather than on the screen. See Figure 7.
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System File

Edit Database

Record Program
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Windou

RQBE

Azimuth Bavis & Systems

Azimuth Corp

BelMar Tronixs Computer

Big Incorporated
Blake Inc.

Bob Leuis Walker & Jackson

Bulldog Inc.
Business M. Business

& S Computing & Systems

« Done » < More >

415/897-2810
488/946-1317
885/682-5580
488/246-5353
714/548-6062
415/989-1683
619/271-8518
415/952-7761
415/323-2469
2137452-3369
818/762-5886
415/992-8710
213/533-7332
415/864-7557
619/564-2889
415/325-4385
Column: 8

Contact

Len Silverman
Duane Marshall
Gui Dupuy

Randy Keji

Bill Hopkins
Chuck Heitmeier
Al Reetz

Brian Case

Mike Ozer

Andy Rigney
Bert Dalgleish
Bob Dot

Dan Tillotson
Bill Kane

Larry Uan Lockern
Parky Kmickle

Novato

San Jose
Santa Barbara
Santa Clara
Orange

San Francisco
San Diego
S.San Francisco
Menlo Park
Santa Monica
N. Hollyuwood
Daly City
Long Beach
San Francisco
San Diego
Menlo Park

Figure 7: Session 3 Report in the Page Preview Window

Session 3
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Let’s look at the report form you've just created and spruce it up in the
Report Layout window.

Opening a Report Form

1. Choose the Done push button at the bottom of the Page
Preview window to return to the RQBE window.

2. Choose Open... from the File menu popup then make sure
Report is showing on the Type popup control.
(Figure 8)

3. Select SESSION3.FRX then choose Open.

A Session 3 report form appears as in Figure 9. The report form is
divided into three sections or bands:

* The PgHead band contains information that appears at the top of
each page in the report.

e The Detail band is printed once for each record that meets the
selection criteria.

¢ The PgFoot band contains information that appears at the bottom of
each page in the report.

The overall appearance of the report form matches the appearance of
the printed report.

Session 3
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Open:

[..1 Drive C ﬂ
SESSION3. FRX

Directory | TUTORIAL “

« Open »

[ 1 All Files < Neuw >

Report ﬂ Type ¢ Cancel >

[X] Restore Environment

Figure 8: Open File Dialog

SESSION3. FRX
R: 8C: 8 Page Header
PgHead Company Contact
PgHead
PgHead
PgHead
Detail
PgFoot
PgFoot
PgFoot

PgFoot

Figure 9: Session 3 Report Form
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You can change the appearance of the report by adding, moving or delet-
ing items from the report form. These items can be plain text, fields
from databases, expressions or functions. For now, youll experiment
with the text and fields.

2.
With the mouse:
1.

Moving Field Headings in a Report Form
With the keyboard:
1.

Place the cursor on each field heading and press the
Spacebar to select it, then press the arrow keys to cen-
ter the field heading over the appropriate field. Be
sure to scroll right to see all of the headings.

Press Enter to confirm the move.

Point to each field heading and click to select it, then drag
the heading until it is centered over the appropriate
field. Be sure to scroll right to see all of the headings.

. Press Enter to confirm the move.

Creating and Centering Titles in a Report Form
1.

Place the cursor on the top line of the PgHead band, type
Customer Phone List then press Enter.

To center the title, select it and choose Center from the
Report menu popup. (Figure 10)
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SESSION3. FRX

Customer Phone List

Company Phone Contact

PgFoot ELEIVX®)

Figure 10: Session 3 Report Form Showing Centered Headings

Session 3 S6-13



Reporting on Your Data

Doing the Query

1. Choose RQBE - SESSION 2 from the bottom of the
Window menu popup.

2. Choose Do Query.

Notice that the report now reflects the changes that you made to the
Session 3 report form. See Figure 11.
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Windou

RQBE

Company

Add Associates

Belmar Fishing Systems
Belmar Tronixs Computer
Big Incorporated
Blake Inc.

Bob Leuis Walker & Jackson

& S Computing & Systems
< More >

« Done »

Customer Phone List

Phone

415/897-2810
488/946-1317
885/682-5588
488/246-5353
714/548-60862
415/989-16083
619/271-8518
415/952-7761
415/323-2469
2137452-9369
818/762-5886
415/992-8710
213/533-7332
415/864-7557
619/564-2889
415/325-4385
Column: 8

Contact

Len Silverman
Duane Marshall
Gui Dupuy

Randy KeJji

Bill Hopkins
Chuck Heitmeier
Al Reetz

Brian Case

Mike Ozer

Andy Rigney
Bert Dalgleish
Bob Dot

Dan Tillotson
Bill Kane

Larry Uan Lockern
Parky Kmickle

City

Novato

San Jose
Santa Barbara
Santa Clara
Orange

San Francisco
San Diego
S.San Francisco
Menlo Park
Santa Monica
N. Hollyuood
Daly City
Long Beach
San Francisco
San Diego
Menlo Park

Figure 11: Page Preview Window Showing Centered Headings

Session 3
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Try making a few changes to achieve an even more professional look.

Placing and Sizing a Box in a Report Form

1. Choose Done from the bottom of the Page Preview win-
dow then choose SESSION3.FRX from the Window
menu popup.

2. Position the cursor in the Report Layout window where
you want the box to appear.

3. Choose Box from the Report menu popup.

4. Size the blinking box so that it frames the field headings.
(Figure 12)

» With the keyboard, press the Right and Down Arrow keys
to stretch the box, then press Enter.

» With the mouse, click on the box and drag, then release
the mouse button.

Moving Fields in a Report Form

1. Move the DATE() field to the top left corner of the PgHead
band. (Figure 12)

o With the keyboard, position the cursor on DATE(), press
the Spacebar to select it then press the arrow keys to
move DATE() to the top left corner of the PgHead band.

e With the mouse, point to DATE(), click to select it then
drag DATE() to the top left corner of the PgHead band.

2. Repeat the above steps to move PAGE and _PAGENO to the
top right corner of the PgHead band. You’ll need to
scroll right to see these fields.
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SESSION3. FRX
Page Footer
Customer Phone List

Company Phone Contact

Seonpany

Figure 12: Report Layout Window with Box and Moved DATE( ) Field
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Doing the Query

Choose RQBE - SESSION 2 from the bottom of the
Window menu popup then choose Do Query.

Again, the changes you made to the Session 3 report form are reflected
in the report that is displayed. See Figure 13.
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System File Edit Database Uindouw

Record Program

84/84/31 Customer Phone List

| Company

Phone

Contact

Add Associates

Advantage Computer School

American Forum
Atec Data Service
Automated Mayo Miley

Azimuth Bavis & Systems

Azimuth Corp

Battery Weaver

Belmar Fishing Systems
Belmar Tronixs Compute
Big Incorporated

Blake Inc.

Bob Lewis Walker &
[Bulldog Inc.

Business M. Business

& S Computing & Syst

« Done » < More >

415/8937-2810
4088/946-1317
885/682-5588
4088/246-5353
714/548-6862
415-/989-1603
619/271-8518
415/952-7761
415/323-2469
r  2137452-9363
818/762-5886
415/992-8710
213/533-7332
415/864-7557
619/564-2809
ems 415/325-4305
Column: 8

Len Silverman
Duane Marshall
Gui Dupuy

Randy Keji

Bill Hopkins
Chuck Heitmeier
Al Reetz

Brian Case

Mike Ozer

Andy Rigney
Bert Dalgleish
Bob Dot

Dan Tillotson
Bill Kane

Larry Uan Lockern
Parky Kmickle

Novato

San Jose
Santa Barbara
Santa Clara
Orange

San Francisco
San Diego
S.San Francisco
Menlo Park
Santa Monica
N. Hollyuwood
Daly City
Long Beach
San Francisco
San Diego
Menlo Park

Figure 13: Page Preview Showing Box and Moved Fields
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Once the report looks exactly the way that you want it to, you can
change the output destination so the report is actually sent to the
printer, if you have one available. If you don’t have a printer, choose
Done to return to the RQBE window then skip to the last step box.

Changing the Output Destination
1. Choose Done to return to the RQBE window.
2. Check the Options... check box.
3.
4. Check the To Printer check box in the Output Destinations

. Choose Do Query. Figure 15 shows the printed report.

Deselect the Preview Report/Label check box.

area of the RQBE Display Options dialog (Figure 14)
then choose OK.

Make sure your printer is ready. If not, nothing will hap-
pen.

Save this report and query for later use.

S6-20

Closing RQBE and the Report Layout Window
1. Choose Save as... from the File menu popup.

2. Type Session3 in the text box then choose Save.
3.
4

. Close the report window then choose Yes when FoxPro

Close the RQBE window.

asks about saving changes.
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RQBE Display Options:
— Formatting Options Qutput Destinations

C ) Screen Display [X]1 To Printer Output

(+> Report [ 1To File Destinations

C D> Label [ 1 Overurite File Area
[X1 Report/Label Form Name

SESSION3
[X1 Quick Report... [ ] Overurite
[ 1 Previeu Report/Label
[ 1 Shou Summary Info Only « OK »
[X] Eject Page Before Report
[ 1 Report Heading < Cancel >
[ 1 Suppress Column Headings
¢ ) Console On (-> Console Off
[ 1 Pause Betueen Screens
Figure 14: RQBE Display Options Dialog
84/84/391 Customer Phone List Page 1
@ @
Company Phone Contact City St]
fdd fAissociates 415/897-2818 Len Silverman Nouvato cA

& Advantage Computer School 488/946-1317 Duane Marshall San Jose cn | @
American Forum 805/682-5588 Gui Dupuy Santa Barbara cA
Atec Data Seruice 4P88/246-5353 Randy Ke ji Santa Clara cA
flutomated Mayo Miley ?714/548-6862 Bill Hopkins Orange cA

@ Azimuth Bavis & Systems 415/989-1603 Chuck Heitwmeier San Francisco CA @
Azimuth Corp 619/271-8518 Al Reetz San Diego [o2]
Battery HWeaver 4157952-7761 Brian Case S.San Francisco CA

@ Belmar Fishing Systems 415/323-2469 Mike Ozer Menlo Park CA @
Belnar Tronixs Computer 213/452-9369 Andy Rigney Santa Monica CA
Big Incorporated 818/762-5886 Bert Dalgleish N. Hollyuood cA
Blake Inc. 415/992-8718 Bob Dot Daly City o]

@ Bob Lewis Walker & 213/533-7332 Dan Tillotson Long Beach CA @
Bulldog Inc. 415/864-7557 Bill Kane San Francisco CA
Business M. Business 619/564-2889 Larry Uan Lockern San Diego cA
C & S Conputing & Systems 415/325-4385 Parky Kmickle Menlo Park cA

@ C. Graph Systems 415/229-1488 Cindy Summerley Martinez A @
Cameron Design Uogeltanz 714/858-4656 John Wigal Huntington Bch CA
Canadian International 415/781-4584 Jerry Aluiston San Francisco ca
Carolina Systems 6197481-4894 Rich Schuartz Solano Beach CA

® Carsonville W. B. 415/283-7568 David Reiss Lafayette ch | B
Cascade Rumberg & 415/863-8219 Greg Gubboney San Francisco cA
Cezar Beach Services 619/265-5983 Zarina Marshall San Diego CA

@ Clover Data Inc. 415/651-8696 Bob Kieckheser Fremont cA @
Coleman Ltd 787/444-3358 Adam H. Ueinsaft Eureka ca
Computeach 415/881-2383 George Hedgepath Hayuard ca
Conputer Bud 415/825-7484 Phil Linak Concord ca

@ Conputer Technologies 415/276-7868 John Houery San Leandro cA @
Control Communication & 818/796-5338 Robert Totah Arcadia CA
Corporate Romtec 714/544-2134 Keuin Driemeir Tustin CA
Designer Greenhouses 714/553-5965 Bill Mostov Irvine ca /

\ Designer Komputers Group 289/477-5675 Alan Au Stockton
ond Inc. 213/865- d Steven: erritos

Figure 15: Printed Report
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Reporting with Multiple
Databases

In this session gou’ll see how easy it is to use
FoxPro’s RQBE to design and generate reports
from multiple databases.

¢ Connecting multiple databases . . . page 4
® Grouping yourdata. ... ... .. page 12
¢ Changing band size ... ... .. page 14
® Creating a computed field . . . . . page 16
® Suppressing repeated values . .. page 20
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Reporting with Multiple Databases

In the last session you created a phone list report using one database

and RQBE. In this session you will gather information from two
databases to create a report.

Begin with the query that you saved at the end of Session 3.

Opening an Existing Query

1. Choose Open... from the File menu popup and make sure
Query is showing on the Type popup control.

2. Open SESSION3.QPR. (Figure 1)
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RQBE — SESSION3
Databases Output Fields Output To

»CUSTOMER 3 2t COMPANY [X] Select Fields... Report/Label
PHONE

CONTACT [X] Order By...
CITY [X] Options...
11 STATE L 1 Group By...
< Add > L 1 Having... < See SQL >
< Clear > « Do Query »

Field Name NOT Example U~L Select
Criteria

$ CUSTOMER. STATE [ 1 Like CA L1
<Insert>

<Remove>

< Or >

Figure 1: SESSION3.QPR

Session 4 S7-3



Reporting with Multiple Databases

S7-4

You'll send the output to a Browse window first so that you can scroll
through the data, then you’ll add the INVOICES database.

To report on multiple databases, the databases must have something in
common. CUSTOMER.DBF and INVOICES.DBF both have CNO, a customer
number, in common. CNO is a link between CUSTOMER.DBF and IN-
VOICES.DBF that is sometimes called the join condition.

Your report will list invoices for each company in California.

Connecting Multiple Databases
1. Choose Browse from the Output To popup.

2. Choose the Add push button below the Databases list,
then choose INVOICES.DBF. The RQBE Join Condition
dialog appears.

3. Select INVOICES.CNO from the left popup. Like appears
on the center popup by default. Select CUS-
TOMER.CNO from the right popup. (Figure 2)

4. Choose OK. The solid bar next to INVOICES.CNO
indicates that CUSTOMER.DBF and INVOICES.DBF are
linked. (Figure 3)

5. Choose the Select Fields... check box in the RQBE win-
dow.

6. Remove CUSTOMER.CITY and CUSTOMER.STATE from the
Selected Output list.

7. Select INVOICES.IDATE and INVOICES.ITOTAL from the
Database Fields list and choose Move —. You’ll
have to scroll to see these fields.

8. Choose OK. The RQBE window appears as in Figure 3.

9. Choose Do Query. The results appear in a Browse win-
dow as in Figure 4.
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ROBE Join Condition:
INVOICES. CNO i“ [ 1 NOT Like II CUSTOMER. CNO II
[ 1 Ignore Upper/Louer Case « 0K »
< Cancel >

Figure 2: RQBE Join Condition Dialog

ROBE - SESSION3
Databases Output Fields Output To

11 COMPANY [X]1 Select Fields... |
PHONE

3
3
3 CONTACT [X] Order By...
3
3
3

CUSTOMER
»INUCICES

IDATE [ 1 Options...
ITOTAL [ 1 Group By...
[ 1 Having... < See SQL >

< Add >

< Clear > « Do Query »

Field Name NOT Example U=L Select
Criteria

3] INVOICES. CNO [ 1 Like CUSTOMER. CNO L1
$ CUSTOMER. STATE [ ] Like CA [ 1] <Insert>
<Remove>

< Or >

Figure 3: RQBE Window

SESSION3
Company Phone Contact

Atec Data Service I488/246-5353 Randy Keji |

Atec Data Service 488/246-5353| Randy Keji

Atec Data Service 4088/246-5353| Randy Keji

Atec Data Service 488/246-5353| Randy Keji

Atec Data Service 4887/246-5353| Randy Keji
Automated Mayo Miley 714/540-6862|Bill Hopkins
Azimuth Corp 619/271-8518]| Al Reetz
Belnar Tronixs Computer Compuserve |213/452-9363|Andy Rigney

C. Graph Systems 415/229-1488|Cindy Summerley
Carsonville W. B. Associates 415/283-7568| David Reiss
Computeach 415/881-2383| George Hedgepath
Conputer Technologies 415/276-7868| John Houery
Designer Greenhouses 714/553-5985|Bill Mostou
Designer Greenhouses ?14/553-5985|Bill Mostou
Designer Komputers Group 289/477-5675|Alan Au

Dr. Micro Consulting 488/733-1479|0liver Ansarti

Figure 4: Query Results
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The fields look fine but if a company has more than one invoice, the
invoices are not in any particular order.

Let’s order the invoices according to company and invoice date and do
the query again.

Ordering Fields
1. Close the Browse window.
2. Choose the Order By... check box.

3. Select INVOICES.IDATE in the Selected Output list and
choose Move —.

4. Choose OK. The RQBE window appears. (Figure 5)

5. Choose Do Query. The data appears in a Browse win-
dow. (Figure 6)
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RQBE - SESSION3

Output Fields

CUSTOMER
»INUOICES

$ 1t COMPANY
$ PHONE
k2 CONTACT
$ 2t IDATE

$ ITOTAL

< Add >
< Clear >

[X]1 Select Fields..
[X]1 Order By...

[ 1 Group By...
[ 1 Having...

Output To

==

SESSION3
[ 1 Options...

< See SQL >
« Do Query »

Field Name

Example

U~L Select

] INUOICES. CNO
t CUSTOMER. STATE ca

CUSTOMER. CNO

Criteria
L1

[ 1] <Insert>
<Remove>

< Or >

Session 4

Figure 5: RQBE Window

SESSION3

Company

Phone

Contact

Atec Data Service 4887 246-5353||[Randy Keji l

Atec Data Service

Atec Data Service

Atec Data Service

Atec Data Service

Automated Mayo Miley
Azinuth Corp

Belmar Tronixs Computer Compuserve
C. Graph Systens
Carsonville W. B. Associates
Computeach

Computer Technologies
Designer Greenhouses
Designer Greenhouses
Designer Komputers Group

Dr. Micro Consulting

488/246-5353
488/246-5353
488/246-5353
488/246-5353
714/548-60862
619/271-8518
213/452-9369
415/229-1408
415/283-7568
415/881-2383
415/276-7868
714,553-5985
714/553-5905
289/477-5675
488/733-1479

Randy Keji
Randy Keji
Randy Keji
Randy Keji

Bill Hopkins
Jﬁl Reetz

Andy Rigney
Cindy Summerley
JDauid Reiss
George Hedgepath
John Mouery
Bill Mostou
Bill Mostou
Alan Au

Oliver Ansarti

Figure 6: Query Resulits
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Now that the information is well organized, let RQBE build a report for
you.

Generating a Report with RQBE
1. Close the Browse window.

2. Choose Report/Label on the Output To popup in the RQBE
window.

3. Check the Options... check box in the RQBE window.

4. Choose the Report radio button in the RQBE Display Op-
tions dialog.

5. Choose the Quick Report... check box.

6. In the RQBE Quick Report dialog, type SESSTON4 in the
Save as text box (Figure 7) then choose OK.

7. Choose OK in the RQBE Display Options dialog.

8. Choose Do Query. The Page Preview window appears.
(Figure 8)
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RQBE Quick Report:

olumn Layout

(> C
C ) Form Layout

Report Width

Save as NINLLE!

« OK »

Fieldl FieldZ
XXKXKX XXXXXX
XXXXXK XXXXKX
XXXKKX KXXXXX

< Clear >

le Edit

Figure 7: RQBE Quick Report Dialog

Database Record Program UWindou RQBE

Azimuth Co
Belmar Tronixs Computer 2137452-3369

Service
Service
Service
Service
Service

408/246-5353
4088/246-5353
4088/246-5353
4088/246-5353
488/246-5353

Mayo Miley 714/5408-6862

rp

. Graph Systems
Carsonville W. B. Associates 415/283-7568

Computeach

619/271-8518
415/229-1488

415/881-2383

omputer Technologies 415/276-78608
Designer Greenhouses 714/553-5985
Designer Greenhouses 714/553-5985
Designer Komputers Group 209/477-5675
Dr. Micro Consulting 408/733-1479

« Done »

< More >

Column: [*]

Contact

Randy Keji
Randy Keji
Randy Keji
Randy Keji
Randy Keji

Bill Hopkins

Al Reetz

Andy Rigney
Cindy Summerley
David Reiss
George Hedgepath
John Mouery
Bill Mostov
Bill Mostov
Alan Au

Oliver Ansarti

Idate

857177398
85726796
857287908
85/38-98
85731798
85708873908
85708398
85718798
85712796
85787738
85718798
85711798
85789798
85713798
857127308
85715798

Itotal

Figure 8: Session 4 Report Form in the Page Preview Window

Session 4
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Now try some cosmetic work.

Moving Fields and Placing a Box in a Report
1. Choose Done in the Page Preview window.

2. Choose Open... from the File menu popup and make sure
Report is showing on the Type popup control.

3. Select SESSION4.FRX then choose Open. The Report
Layout window appears. (Figure 9)

4. Move the field headings down to the third PgHead band
over the appropriate fields.

5. Move the DATE() field to the top left corner of the PgHead
band. Scroll right to see the _PAGENO field. Move
_PAGENO to the top right corner of the PgHead band.
Move PAGE also.

6. Type Invoice Report on the top line of the PgHead
band and press Enter.

7. Center the title.

8. Place and size a box so that it frames the field headings.
Your screen should look like Figure 10.
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SESSION4.FRX
Detail

phone —— Joontact [

Figure 9: Session 4 Report Form

SESSION4. FRX
Detail
Invoice Report

Company Phone Contact

Figure 10: Session 4 Report Form with Title, Centered Headings and
Box
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S7-12

When your data is ordered by a field, such as COMPANY, you can use the
Report Writer to group all the information about each company.

In these next few steps you will create a data grouping for the COMPANY
field. Let’s do it now.

Grouping Your Data

1. Choose Data Grouping... from the Report menu popup.
The Group dialog appears.

2. Choose the Add push button in the Group dialog. The
Group Info dialog appears.

3. Type company in the Group... text box. (Figure 11)

4. Choose OK in the Group Info dialog. The Group dialog
appears. (Figure 12)

5. Choose OK in the Group dialog.
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Group Info:

< Group.... >

Options:
« OK »

1 Neu Page
1 Suap Page Header < Cancel >
1 Suap Page Footer
1 Reprint Header

1 Reset Page Number

e

# of rous follouwing header:

Figure 11: Group Info Dialog

Group:
« OK »
< Add >
< Change >
< Delete >

Figure 12: Group Dialog
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When you grouped the data, the Report Writer added two bands to the
report form:

* The group header band, just above the detail band, is printed each
time the group changes.

* The group footer band, just below the detail band, is printed each
time the group changes.

In the current example, the group header and group footer will be
printed each time COMPANY changes.

Changing Band Size and Copying a Field
1. Change the size of the group footer band.

» With the keyboard, place the cursor in the group footer
area of the report form and choose Add Line from the
Report menu popup.

* With the mouse, point to “1-company” in the group footer
band and drag the mouse down.

2. Select ITOTAL and choose Copy from the Edit menu
popup. Place the cursor in the bottom line of the
group footer band directly beneath the “I” in the
ITOTAL field and choose Paste from the Edit menu
popup. (Figure 13)

Once information is grouped, you can perform calculations on each
group, put headers and footers on each group, and so on.
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Group Header Band

PgHead
PgHead

Reporting with Multiple Databases

SESSION4. FRX
Page Header
Invoice Report

PgHead

Phone Contact Idate Itotal

PgHead

Figure 13: Session 4 Report Form

Group Footer Band with Added Line Copied ITOTAL Field

Session 4

S7-15



Reporting with Multiple Databases
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The group footer is also used to do calculations on the information that
appears in the details for the group.

In the group footer for ITOTAL, let’s add the data in all the ITOTAL fields
in the group.

Creating a Computed Field

1. In the group footer, choose ITOTAL to display the Report
Expression dialog.

2. Choose the Calculate... check box to display the Calculate
Field dialog. (Figure 14)

3. Choose the Sum radio button then choose OK. The
Report Expression dialog reappears. (Figure 15)

4. Choose OK.
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Reset: company n

Calculate: Nothing

Count

Sum

Average

Louest

Highest

Std. Deviation

Uariance

AAAAAAAAN
W W W W W

« OK >»

< Cancel >

Figure 14: Calculate Field Dialog

Report Expression:

< Expr... > TSNS
< Forvat... > IS Vidth: W

[ 1 Style... [ 1 Suppress...

[X1 Calculate...
[ 1 Comment...

« OK » < Cancel >

Figure 15: Report Expression Dialog
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Place a line between the two ITOTAL fields, then do the query to see the
results of your handiwork.

Drawing a Line
1. Place the cursor below the “I” in the top ITOTAL field.
2. Choose Box from the Report menu popup.
3. Turn the blinking box into a line. (Figure 16)

e With the keyboard, use the arrow keys to shrink the box
to a line, press the Right Arrow until the line is the
desired length then press Enter.

» With the mouse, click on the box and drag until the box
has no depth and the line is the desired length, then
release the mouse button.
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SESSION4. FRX
Page Header
PgHead Invoice Report
PgHead
PgHead Phone Contact Idate Itotal
PgHead
rl—compa;

Detail

PgFoot

Figure 16: Session 4 Report Form
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Doing the Query
1. Choose RQBE — SESSION3 from the Window menu
popup.

2. Choose Do Query. The Page Preview window appears.
(Figure 17)

The report looks very good, but let’s make it even better.

When a company has more than one invoice, the company information is
repeated for each invoice.

Your report will be easier to read if this information is not repeated for
each invoice.

Suppressing Repeated Values in a Report
1. Choose Done in the Page Preview window.
2. Choose SESSION4.FRX from the Window menu popup.

3. Select COMPANY and choose Field... from the Report menu
popup. The Report Expression dialog appears.

4. Check the Suppress... check box. The Suppress Repeated
Values dialog appears.

5. Choose the On radio button in the Suppress Repeated
Values dialog (Figure 18) then choose OK.

6. Choose OK in the Report Expression dialog.
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System File Edit

Database
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Record Program UWindow RQBE

84/38/91

Invoice Report

Page

Company

Phone

Contact

Idate

Itotal

Service
Service
Service
Service
Service

Automated Mayo Miley

Azimuth Corp

Belmar Tronixs Computer

« Done » < More > Column:

4088/246-5353
488/246-5353
488/246-5353
408/246-5353
4088/246-5353

714/548-6862

618-/271-8518

2137452-3363

Randy Keji
Randy Keji
Randy Keji
Randy Keji
Randy KeJji

Bill Hopkins

Al Reetz

Andy Rigney

85/17/38
85/26798
857287908
8573898
8573198

85-/88/38

85-788/90

85718798

Figure 17: Session 4 Report in Page Preview Window

Suppress Repeated Ualues:

(> On

¢ ) Off

« OK

Reset:

»

< Cancel >

company

Figure 18: Suppress Repeated Values Dialog

Session 4

2721.
441.
744.
163.
762.
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This report will look better with a blank line between the invoices for
each different company.

Add a line to the group footer band to place a space between groups.

Changing the Size of a Band
1. Add a line to the group footer band. (Figure 19)

2. Move ITOTAL back up to the second group footer band,
under the line. (Figure 19)

3. Choose RQBE — SESSION3 from the Window menu
popup.

4. Choose Do Query. Your report should appear as in
Figure 20.
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SESSION4. FRX
Page Header
Invoice Report

Phone Contact Idate Itotal

Figure 19: Session 4 Report Form

Group Footer Band with Added Line Space Added by Group Footer Band

System File Edit Database Record Program Windouw RQBE
=

B84/38/91 Invoice Report Page

Company Phone Contact Idate Itotal

Atec Data Service 40887246-5353 Randy Keji 85717798 2721.
488/246-5353 Randy Keji 85/26798  441.
488/246-5353 Randy Keji 85/28738 744.
408/246-5353 Randy Keji 85738798  163.
4088/246-5353 Randy Keji 85/31/98 ?762.

Automated Mayo Miley ?14/548-6862 Bill Hopkins 085-/088/98

Azimuth Corp 619/271-8518 Al Reetz 857688790

« Done » < More > Column: 2]

Figure 20: Session 4 Report with Repeated Values Suppressed
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Now that’s a polished report! Go ahead and send this report to the
printer, if you have one available. If you don’t have a printer, choose
Done from the Page Preview window then skip to the last step box.

Sending a Report to the Printer
1.
2.
3.

Choose Done from the Page Preview window.
Choose the Options... check box in the RQBE window.

Uncheck the Preview Report/Label check box in the RQBE
Display Options dialog.

. Choose the To Printer check box in the Output Destina-

tions area. (Figure 21)

5. Choose OK.

Choose Do Query. The printed report is represented in
Figure 22.

Save this report and query and take a break.

Saving a Report and Query
1.

Choose Save as... from the File menu popup.

2. Type Session 4 in the text box, then choose Save.

3.

4. Close the report window then choose Yes when FoxPro
asks about saving changes.

Close the RQBE window.
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ROBE Display Options:

— Formatting Options Output Destinations
C > Screen Display [X] To Printer
C+) Report [ 1 To File
C ) Label [ 1 Overurite File

[X]1 Report/Label Form Name
SESSION4. FRX

[X]1 Quick Report... [ 1 Overurite

[ 1 Previeu Report/Label

[ 1 Shou Summary Info Only « OK »
[X1 Eject Page Before Report
[ 1 Report Heading < Cancel >

[ 1 Suppress Column Headings
C > Console On (<> Console Off
[ 1 Pause Betueen Screens

Figure 21: RQBE Display Options Dialog

85/81/91 Invoice Report Page 1
@ | Company Phone Contact IDate ITotal I @
Atec Data Service 408/246-5353 Randy Keji 85717798 2721.19
[:::) 488/246-5353 Randy Keji 05/26-98 441.91 | @
4088/246-5353 Randy Keji 857/28798 744.49
408/246-5353 Randy Keji 85738790 163.72
4088/246-5353 Randy Keji 85731798 762.56 @
@ 4833.87
Automated Hayo Miley 714/548-6862 Bill Hopkins 85/88798 2336.34 @
® 2336.34
Azimuth Corp 619/271-8518 Al Reetz 85768798 2847.88 ®
@ 2847.88
Belmar Tronixs Computer 2137452-93638 findy Rigney 8571898 2353.43 @
* 2353.43
@ C. Graph Systems 415/229-1488 Cindy Summerley 05712798 1642.85 @
1642.85
@ Carsonuille W. B. Associates 415/283-7568 David Reiss 85/87/98 1186.24 @
1188.24
@ Computeach 415/881-2383 George Hedgepath 85/18/98 1379.92
N 1379.92 ﬁ
Technologies uery 85/11/9

Figure 22: Printed Report
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More Reporting

In this session you’ll learn to include formatted
fields, functions and summary bands in your
reports — with ease.

® Including functions in a query . . . . page 4
® Groupingdata ............ page 8
® Ordering data by functions . ... page 10
¢ Formattingdata . ......... page 18
® Creating a summary band . . . . . page 24
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More Reporting

More Reporting

In the last session you used RQBE to design and generate a report using
information from two databases. In this session you’ll learn to include
functions and group the data in your query.

Begin by creating a new query.

Opening the RQBE Window

1. Choose New... from the File menu popup, choose the
Query radio button then choose OK.

2. Select CUSTOMER.DBF then choose Open. The RQBE
window appears as in Figure 1.
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RQBE - UNTITLED

Databases Output Fields Output To

CNO N cx1 select Fielas... l
COMPANY =

CONTACT [ 1 Order By.
ADDRESS

CITY L 1 Group By...
STATE M L1 Having... < See SQL >
« Do Query »

»CUSTOMER

L 1 Options...

L X X X X 4

< Add >
< Clear >

Field Name NOT

Example u=L Select
Criteria

<Insert>
<Remoue>

< Or >

Figure 1: RQBE Window
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Previously, you've specified fields to include in the query output. You'll
now learn to include functions. The Sum function is one type of function
that adds information in a field.

The results of a specified function appear as a column in your Browse
window or report. Try specifying a few functions.

Including Functions in a Query

1. Choose the Select Fields... check box, then choose
Remove All to clear the Selected Output list.

2. Choose CUSTOMER.STATE from the Database Fields list
and choose Move —.

3. For each bullet line below, select the first item from the
Functions popup and select the second item from the
corresponding submenu (Figure 2) then choose
Move —.

« AVG( ) and CUSTOMER.YTDPURCH
« COUNT()and *

- SUM( ) and CUSTOMER.YTDPURCH
» MIN() and CUSTOMER.YTDPURCH
« MAX( ) and CUSTOMER.YTDPURCH

4. When the RQBE Select Fields dialog appears as in Figure
3, choose OK.
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Database Fields Selected Output

L}
CUSTOHER.CNO[ L4

CUSTOMER. STATE

CUSTOMER. COM|
CUSTOMER. CON| CUSTOMER.CNO > D>
CUSTOMER. ADD| CUSTOMER.COMPANY
CUSTOMER.CIT| CUSTOMER.CONTACT
CUSTOHER.STQH CUSTOMER. ADDRESS e >
CUSTOMER. ZIP| CUSTOMER.CITY

CUSTOMER. PHO| CUSTOMER.STATE All>
CUSTOMER. ZIP
—— Functions/| CUSTOMER.PHONE [ 1 No Duplicates
l CUSTOMER. ONO

LE R R R R X X 4

COUNT(OO»|| CUSTOMER.YTDPURCH « OK »
SUMCO> »]| CUSTOMER.LAT
AUGCO >
—] MINO »
MAXO >

CUSTOMER. LONG < Cancel >

Submenu

Functions Popup

Figure 2: RQBE Select Fields Dialog

Database Fields Selected Output
CUSTOMER. CNO c < Move » > |3 CUSTOMER. STATE
CUSTOMER. COMPANY C 3 AUGCCUSTOMER. YTDPURCH
CUSTOMER. CONTACT c < All » > |t COUNTC36>
CUSTOMER. ADDRESS c 3 SUM(CUSTOMER. YTDPURCH
CUSTOMER.CITY c k4 MINCCUSTOMER. YTDPURCH
CUSTOMER. STATE c < Remove > |3 MAXC(CUSTOMER. YTDPURCH
CUSTOMER. ZIP c k3
CUSTOMER. PHONE c <Remove Al1> |3

— Functions/Expressions [ 1 No Duplicates
| AJ < Cancel >

Figure 3: RQBE Select Fields Dialog with Functions/Fields Selected
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Now that you have selected the fields, you can order them by state.

Ordering the Data by State

1. Choose the Order By... check box in the RQBE window.

2. Move CUSTOMER.STATE to the Ordering Criteria list
(Figure 4), then choose OK.
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Selected Output Ordering Criteria
CUSTOMER. STATE < Mouve + > T CUSTOMER. STATE
AUGCCUSTOMER. YTDPURCH>
COUNT(>> < Remove >

kS

ks

$
SUMCCUSTOMER. YTDPURCH> k2
MINCCUSTOMER. YTDPURCH> Order Options %
MAX(CUSTOMER. YTDPURCH>| |<(-> Ascending k2
C ) Descending ks

[ 1 Ignore Case k4

L ks

2

2

2

<« 0K »

< Cancel >

Figure 4: RQBE Order By Dialog
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Group By.... is the next new feature that youll use. Group By... takes
your data and groups it based on fields and functions that you specify.

In this report you want the information grouped by state. Go ahead and
group the data by state.

Grouping the Data by State

1. Choose the Group By... check box in the RQBE win-
dow.

2. Move CUSTOMER.STATE to the Group By Fields list
(Figure 5), then choose OK.

You are now ready to do the query and see the results.

Doing the Query
1. Choose Do Query.

2. Size the Browse window so that it stretches across your
screen. (Figure 6)
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Database Fields

Group By Fields

CUSTOMER. CNO < Move + > $ CUSTOMER. STATE

CUSTOMER. COMPANY $

CUSTOMER. CONTACT < Remove > 2

CUSTOMER. ADDRESS 3

CUSTOMER.CITY 3

CUSTOMER. STATE k

CUSTOMER. ZIP E 3

CUSTOMER. PHONE « OK » 3

CUSTOMER. ONO kS

CUSTOMER. YTDPURCH < Cancel > 3

Figure 5: RQBE Group By Dialog
l R A
State|Avg_ytdpur Cnt Sum_ytdpur Min_ytdpur|Hax_ytdpur
AK 14828.12 1 14828.12] 14820.12] 14820.12
AL 6271.24 2 12542. 48 2244.58| 18297.90
AR 1688.87 1 1688.87 1688.87 1688.87
Az 3910.37 8 31282.95 348.34| 17777.86
BC 2208.21 1 2208. 21 22600.21 2200.21
cA 3713.22 123 456726.45 18.16] 17623.25
co 2916.69 9 ZBZSB.ZBr 161.70] 12995.31
CT 1843.28 9 16589.55 80.084 3452.82
DC 44,50 1 44.58 44,50 44,50
DL 283.93| 1 283.93i 283.93 283.93
FL 3237.44 25 80936.02 129.22] 16085.92
GA 3224.21 12 38690. 51 205.14| 12277.45
HI 7296. 10 3 21888.29 2982.70 9829.03
1A 1947.91 2 3895.81 335.37 3560. 44
1D 4399.12 1 4399.12 4399, 12 4399, 12
L 3266.68 24 78386.02 58. ga| 7919.49
IN 2430.33 5 12151.66 1336.81 5311.38
KS 956. 69 3 2878. 87 247.88| 2874.65
Figure 6: Browse Window with Functions
Session 5
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That was pretty amazing, but “you ain’t seen nothin’ yet!” How about
organizing the data by average so that the company with the highest
average year-to-date purchases is displayed first, followed by the com-
pany with the next highest average, and so on.

As it is written, so it shall be.

Ordering the Data by Average Year-to-Date Purchases
1. Close the Browse window.
2. Choose the Order By... check box.
3. Remove CUSTOMER.STATE from the Ordering Criteria list.
4

. Choose the Descending radio button in the Order Options
area of the RQBE Order By dialog.

5. Move AVG(CUSTOMER.YTDPURCH) to the Ordering
Criteria list (Figure 7) then choose OK.

6. Choose Do Query. The Browse window appears.
(Figure 8)

You can order by functions as easily as by fields!
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Selected Output Ordering Criteria

CUSTOMER. STATE < Move =+ > $ 1 AUGCCUSTOMER.YTDPU
AUGCCUSTOMER. YTDPURCH> k4
COUNTGe> < Remove > 3
SUMCCUSTOMER. YTDPURCH> 3
. MINCCUSTOMER. YTDPURCH> Order Options  :
Desgendmg MAXCCUSTOMER. YTDPURCHY| |< > Ascending t
Radio ¢+) Descending 3
Button [ 1 Ignore Case kS
$
t
<« OK » k4
3

< Cancel >

Figure 7: RQBE Order By Dialog

State| Aug_ytdpur Sum_ytdpur Min_ytdpur|Max_ytdpur

G| ST T N O TN TN
Wy

9558. 62 1911? 23 14793.66
7296. 18 21888.29 2982.?8 9829.03
6271.24 12542. 48 2244.58| 18297.98
5638.58 5638.50 5638.508 5638.
5276.38 31658.29 1123.43| 1178@7.
56819.53 5619.53 5019.53 5019.
4399.12 4399.12 4399.12 4398.
4185.73 58608. 16 595.46| 116086.
4132.38 28926. 87 1218.92| 11433.
4833.53 24281.280 1187.86] 12485.
3918.37 31282.95 348.34| 17777.
3838.72 15354. 89 926.39| 18974.
3713.22 456726.45 18.16] 17623.25
3628.133 58853. 23 136.77] 11174.78
3628.139 166896. 89 32.58] 17548.14
3601.33 3681.33 3601.33 3681.33
3293.63 32936. 34 358.34 9521.57

3
2
1
6
1
1
14
7
6
8
4

Figure 8: Browse Window with Companies Ordered By Average
Year-to-Date Purchases

Session 5 S8-11



More Reporting

Now that you have the data you want, try putting it into a report form
and massaging it into shape.

Generating a Report
1. Close the Browse window.
2. Select Report/Label from the Output To popup.

3. Choose the Options... check box to display the RQBE Dis-
play Options dialog.

4. Choose the Report radio button.
5. Choose the Quick Report... check box.

6. Type SESSIONS in the Save as text box in the RQBE Quick
Report dialog (Figure 9) then choose OK.

7. Choose OK in the RQBE Display Options dialog.

8. Choose Do Query. The Page Preview window displays
your results. (Figure 10)
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ROBE Quick Report:

(<> Column Layout
C > Form Layout Fieldl FieldZ
XXXXXX XXXXXX
Report Width XXXXXX XXXXXX

Save as NINYILE

« OK » < Clear >

Figure 9: RQBE Quick Report Dialog

State Avug_ytdpur Sum_ytdpur Min_ytdpur Max_ytdpur

14828.
19117,
21888.
12542.
5638.
31658.
5819.
4398.
58608.
28926.
24201,
31282.
15354.
456726.
58853.
166836.

[

1
2
3
2
1
b
1
1
q
?
6
8
q

Done » < More > Column:

Figure 10: Page Preview Window with Session 5 Report
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Let’s make the data really look great.

Take a look at the report form you just created.

Opening a Report Form
1. Choose Done in the Page Preview window.

2. Choose Open... from the File menu popup and make sure
Report is showing on the Type popup control.

3. Select SESSION5.FRX then choose Open. The report is dis-
played. (Figure 11)

As you can see, Quick Report... places fields into the Report Layout win-
dow in a predictable way.
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SESSIONS. FRX

State Aug_ytdpur Sum_ytdpur Min_ytdpur Max_ytd

aug_ytdpur sum_ytdpur Mmin_ytdp

Figure 11: Session 5 Report Form
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S8-16

Take a moment to rearrange the header information to suit your tastes.
(Because we weren't sure what flavors you prefer, our example may look
a little different than yours.)

Rearranging and Editing Fields in a Report Form
1. Edit five of the field headings:

* Select the avg_ytdpur heading and choose Text from the
Report menu popup. You can now backspace, delete
and type just as you would in a word processor.

Change the heading to Avg and press Enter.

* Repeat the previous step for the cnt, sum_ytdpur,
min_ytdpur and max_ytdpur field headings so they ap-
pear as Count, Sum, Min and Max.

2. Move the field headings down to the third Page Header
band then center them over the appropriate fields.

3. Draw a box around the field headings. You may have to
move the fields and field headings to the right slightly
before you draw the box, as Figure 12 shows.

4. Move the DATE(), PAGE and _PAGENO fields to the top line
in the Page Header.
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SESSIONS. FRX
R: B8 C: | Page Header
PgHead Page _PAG]
PgHead
PgHead Aug Count Sum Min Max
PgHead

betail § I ENCHYEIID

PgFoot
PgFoot
PgFoot
PgFoot

Figure 12: Session 5 Report Form with Edited and Rearranged
Headings and Box
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Because the numbers in this report represent dollar amounts, it would
be nice if they looked like dollar amounts in the report. To accomplish
this, you need to use formats.

When you specify a format, you tell FoxPro how the information in a
field should appear. In your report, you want the information to appear
like a dollar amount. Follow these steps, then we’ll discuss them in
more detail.

Formatting Data in a Report

1. Choose the AVG_YTDPUR field. Be sure to select the field
and not the field heading.

» With the keyboard, position the cursor on the field and
press Enter.

+ With the mouse, double-click on the field.

2. The Report Expression dialog appears with the field auto-
matically entered in the Expr... text box. (Figure 13)
Choose the Format... push button.

3. In the Format dialog, choose the Currency check box,
type 999,999, 999.99 in the Format text box
(Figure 14) and choose OK.

4. When the Report Expression dialog appears as in Figure
15, choose OK.

5. Repeat the steps above for the SUM_YTDPURCH field.
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Report Expression:

< Expr... > aug_ytdpur
< Format... > Width: 16
[ 1 Style... [ 1 Suppress...

[ 1 Calculate... [ 1 Stretch Uertically
[ 1 Comment... [ 1 Float as Band Stretches

« OK » < Cancel >

Figure 13: Report Expression Dialog

Format: Editing Options:
[ 1 Left Justify
C > Character <(-) Numeric [ 1 Blank if Zero
C > Date C ) Logical [ 1 (Negative)
[ 1 Edit “SET" Date
[ 1 British Date
[ 1 CR if Positive
[ 1 DB if Negative
[ 1 Leading Zeros
[X]1 Currency
[ 1 Scientific
« 0K » < Cancel >

Figure 14: Format Dialog

Report Expression:

< Expr... >
< Format... > CEBEEEBEEEPEEEREE] Width: m

[ 1 Style... [ 1 Suppress...
[ 1 Calculate... [ 1 Stretch Vertically
[ 1 Comment... [ 1 Float as Band Stretches

« OK » < Cancel >

Figure 15: Report Expression Dialog
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The format that you specified for these two fields has two parts:

@$ is entered automatically for you when you choose the Currency
check box. This represents the floating dollar sign so that the dollar
sign is printed just before the beginning of the number displayed in
the field. (For example: 4536292 is displayed $45,362.92)

999,999,999.99 determines how the number is displayed. Each nine
shows where the digits are displayed. The period shows where the
decimal point goes. The commas show where commas are placed, if
the number of digits warrants their use.

This will become more clear when you see how the formatting affects the
output.

Practice on a few more fields.

Formatting Data in a Report

1. Choose the MIN_YTDP field. The report form shows
MIN_YTDP because of the width of the field.

2. Choose the Format... push button in the Report
Expression dialog.

3. Choose the Currency check box in the Format dialog, type
999, 999.99 into the text box at the top of the dialog
then choose OK.

4. Type 10 in the Width text box in the Report Expression
dialog (Figure 16) then choose OK. Now the report
form shows MIN_YTDPUR because the field width has
been increased.

5. Repeat the steps above for the MAX_YTDPURCH field.

When specifying the last two formats, you needed to change the width of
the displayed field because you added a comma to the size of the output.

S58-20
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Report Expression:

< Expr... >
< Format... > EFJEEEMEEEREE] Width:

[ 1 Style... [ 1 Suppress...
[ 1 Calculate... [ 1 Stretch Uertically
[ 1 Comment... [ 1 Float as Band Stretches

« OK » < Cancel >

Figure 16: Report Expression Dialog
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Run the report and take a look at how the formatting affected the
numbers.

Generating a Report

1. Choose RQBE - UNTITLED from the Window menu popup.

2. Choose Do Query. The Page Preview window appears.
(Figure 17)

Look at that!
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85/81/91 Page

[State Avg Sun Min Max

AK $14,828.12
WU $9,558. 62
HI $7,296.10
AL $6,271.24
KY $5,638.58
MN $5,276.38
NM $5,0819.53
ID $4,399.12
PA $4,185.73
WA $4,132.38
ur $4,833.53

$14,828.12 $14,820.1Z $14,828.12
$19,117.23 $4,323.57 $14,793.66
$21,888.29 $2,982.78 $9,829.03
$12,542.48 $2,244.58 $18,297.90
$5,638.58 $5,638.58 $5,638.50
$31,658.29 $1,123.43 $11,7087.61
$5,819.53 $5,019.53 $5,819.53
$4,399.12 $4,399.12 $4,399.12
$58,600. 16 $595.46 $11,606.18
$28,926. 87 $1,218.92 $11,433.87
$24,2081. 28 $1,187.86 $12,485.77
Az $3,918.37 $31,282.95 $348.34 $17,777.86
LA $3,838.72 $15,354.89 $926.39 $18,974.47
CA $3,713.22 123 $456, 726. 45 $18.16 $17,623.25
OH $3,628.33 16 $58,853. 23 $136.77 $11,174.70
NY $3,628.19 46 $166,896.89 $32.508 $17,548.14
« Done » < More > Column: e

[,
BN BN WN e

Figure 17: Page Preview of Report 5 with Formatted
Currency Fields
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There are two special bands that you haven’t seen yet. They are the
Title and Summary bands. These optional bands are used to create a
title and summary for your report.

Switch back to the report form and youll find out how to create an end-
of-report summary.

Creating a Summary Band
1. Choose Done in the Page Preview window.
2. Choose SESSION5.FRX from the Window menu popup.

3. Choose Title/Summary... from the Report menu popup.
The Title/Summary dialog appears.

4. Choose the Summary Band check box (Figure 18) then
choose OK. A Summary band is added. (Figure 19)

5. You may want to change the size of the PgFoot band so
that it’s only one line wide. (Figure 19)
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Report Title:

[ 1 Title Band
[ 1 Neu Page

Report Summary:

[X1 Summary Band
[ 1 Neu Page

« OK »

< Cancel >

Figure 18: Title/Summary Dialog

Summary Band

PgHead
PgHead
PgHead
PgHead

PgFoot

Session 5

R: 6C: 6] Summary

More Reporting

State Avg

Summaryd

Detail § sum_ytdpur Min_ytdpurfinax_ytd

Figure 19: Session 5 Report Form with Summary Band
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Now that you have a Summary band, you need to decide what informa-
tion to put in it.

You've already computed a total field. Now youlll place computed fields
in the Summary band.

1.
2.

10.

11.

S8-26

Placing Calculated Fields in a Summary Band

Add an extra line to the Summary band.

Copy all of the fields except STATE and paste them in the
appropriate spot on the bottom line of the Summary
band.

. Draw a line above the fields in the Summary band.

(Figure 20)
Choose the AVG_YTDPUR field in the Summary band.

5. Choose Calculate....
. In the Calculate Field dialog, choose the Average radio

button (Figure 21) then choose OK.
Choose OK in the Report Expression dialog.

. Choose the CNT field and repeat steps 5-7 except choose

the Sum radio button.

Choose the SUM_YTDPUR field and repeat steps 5-7 except
choose the Sum radio button.

Choose the MIN_YTDPUR field and repeat steps 5-7 except
choose the Lowest radio button

Choose the MAX_YTDPUR field and repeat steps 5-7 except
choose the Highest radio button.
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SESSIONS. FRX
R: 8C: 0] Page Header
PgHead
PgHead
PgHead |State Aug Count Sum Min
PgHead

Detail § P ot

PgFoot

Summar
Summar aug_ytdpur sum_ytdpur min_ytdpurfimax_ytd

Figure 20: Session 5 Report Form with Added Summary
Band and Copied Fields

Reset: End of Report n

Calculate: Nothing
Count « OK »
Sum
Average < Cancel >
Louest

Highest

Std. Deviation
Variance

AAAAAAAN
.
W W W W W W W

Figure 21: Calculate Field Dialog
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You now have a Summary band with information calculated from the
data in the Detail band. Try it and see how it looks.

Doing the Query
1. Choose RQBE - UNTITLED from the Window menu popup.

2. Choose Do Query. The Page Preview window appears.

3. Choose More until you reach the bottom of the report
where you can see the Summary band. (Figure 22)
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$1,947.
$1,843.
$1,785.
$1,691.
$1,688.
$1,612.
$1,476.
$974.
$956.
$678.
$283.
$44.

.81 $335.37 $3,568.
$16,589.55 $80.04 $3,452.
$14,282.17 $133.76 $5,297.

$3,382.27  $1,496.42 $1,885.
$1,688.87  $1,688.87 $1,688.
$1,612. $1,612.88 $1,612.
$2,953.14 $947.43 $2,005.
$1,948. $372.64 $1,575.
$2,878. $247.88 $2,0874.
$678. $678.38  $678.
$283. $283.93  $283.93
$44. $44.58 $44.

o WNN - =N W N

$3,337. 500 $1,663,206. $18.16 $17,777.86

« Done » < More > Column: 8

Figure 22: Page Preview of Report 5 Showing
Summary Band
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Now that you have the data right where it wants you, it’s time to go to
press. If you don’t have a printer, choose Done in the Page Preview
window and skip to the step box at the bottom of this page.

Sending the Report to the Printer

1. Choose Done in the Page Preview window to return to the
RQBE window. (Figure 23)

2. Choose the Options... check box.
3. Uncheck the Preview Report/Label check box.

4. Choose the To Printer check box in the Output Destina-
tions area.

5. Choose OK.
. Choose Do Query. The report is printed.

In a later session you will learn about commands. But just for fun take
a look at the command that is behind the fantastic things you have been
doing with the RQBE.

Looking at the SELECT Command

Choose the See SQL push button — above the Do Query
push button in the RQBE window. The See SQL win-
dow appears as in Figure 24.

One tutorialite saw this and ran around shouting, “I can do SQL! Look
at my SELECT command! I can do SQL!” So don’t be embarrassed if that
is what you did.
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Output Fields

»CUSTOMER

< Add >
< Clear >

STATE
AUGCYTDPURCH
COUNTCo
SUMCYTDPURCH
MINCYTDPURCH
MAXCYTDPURCH

[X] Select Fields...

[X]1 Order By...

[X]1 Group By...
[ 1 Having...

More Reporting

Output To
Report-/Label

[X]1 Options...

< See SQL >
« Do Query »

Field Nane

NOT

Exanple

U=L Select

Criteria

<Insert>

<Remove>

< Or >

SELECT CUSTOHMER. STATE,

Figure 23: RQBE Window

UNTITLED. QPR [Read Onlyl

AUGCCUSTOMER. YTDPURCH),

SUMCCUSTOMER. YTDPURCH>, MINCCUSTOMER. YTDPURCH),
FROM CUSTOMER:

GROUP BY CUSTOMER.STATE:
ORDER BY 2 DESCENDING:
INTO CURSOR QUERY_A
REPORT FORM TUTORIALNSESSIONS.FRX TO PRINTER NOCONSOLE

Session 5

COUNT(,

HAX(CUSTOMER. YTDPURCH)>:

Figure 24: SELECT Command
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You have worked hard and created a wonderful report. Save your
creations and gloat for a short time on your success.

Saving the Report
1. Close the See SQL window.

2. Choose Save as... from the File menu popup, type
Session5 in the text box then choose Save.

3. Close the RQBE window.

4. Close the Session 5 report form and choose Yes when
FoxPro asks about saving changes.
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RQBE and the Report
Writer in Action

In this session IXOU’“ see a five step example of
how FoxPro’s RQBE and Report Writer can be

used as analytical tools.

Session 6
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RQBE and the Report Writer in Action

RQBE and the Report Writer in Action

S9-2

In this session you’ll see RQBE and the Report Writer used to perform a
sales analysis. RQBE enables you to extract data from several databases
and the Report Writer allows even more refined reporting.

The examples in this session use the six databases shown in Figure 1.
Figure 1 also shows the fields that the six databases have in common.
Common fields are used to join databases.

The CUSTOMER database can be joined to the INVOICES database by the
customer number field, CNO. The INVOICES database can be joined to
the DETAIL database by the invoice number field, INO. The DETAIL
database can be joined to the PARTS database by the part number field,
PNO. The INVOICES database can also be joined to the SALESMAN
database by the SALESMAN field. The SALESMAN database can be joined
to the OFFICES database by the office number field, ONO.
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CUSTOMER
- m
COMPANY
CONTACT
ADDRESS
CITY SALEPRICE
STATE LTOTAL
ZIP
PHONE
ONO PARTS
YTDPURCH
LAT NAME DESCRIPT
LONG YTDSALES ONHAND
ADDRESS ONORDER
OFFICES CITY LISTPRICE
STATE COST
ZIP YTDUNITS
PHONE YTDSALES
NOTES
ADDRESS
CITY
STATE Figure 1: Six Databases and Their Common Fields
ZIP
PHONE
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Let’s begin with a query that shows the total sales for each salesman.

Note that FoxPro may ask you to locate one of the databases used in
these queries. If so, simply select the database that FoxPro is request-
ing.

Opening STEP1.QPR

1. Choose Open... from the File menu popup. Make sure
that Query appears on the Type popup control.

2. Select STEP1.QPR and choose Open. The RQBE window
appears as in Figure 2.

Doing the Query

Choose Do Query. Query results appear in the Browse
window. (Figure 3)

The total sales for each salesman are extracted from the INVOICES
database. The output fields are the salesman number and the sum of
the invoice totals. The results are grouped by salesman so that a total
invoice amount is shown for each salesman.

Closing Browse and RQBE

1. Close the Browse window.

2. Close the RQBE window.
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ROBE - STEP1
Databases Output Fields Output To

SALESMAN [X] Select Fields... Brouse “
SUMCITOTALD>

k3

$

3 [ 1 Order By... STEP1

3 [ 1 Options...
3

3

»INUOICES

[X] Group By...
< Add > [ 1 Having... < See SQL >
< Clear > « Do Quepy >»

Field Name Example U~L Select
Criteria

{Insert>
<{Remove>

< Or >

Figure 2: STEP1.QPR

Salesman|Sum_itotal
R |
158 19138.39
175 3622.48
188 2952.55
240 3855.189
271 11118.85
281 11447.51
294 5748.208
322 7216.84
328 7567.48
353 5721.11
368 8898.29
366 17439.98
391 11681.77
418 4721.93
423 8814.33

Figure 3: Step1 Query Results in Browse
Window
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Suppose that you want to break this information down by the office in
which the salesmen work. To obtain this information, you need to use
the SALESMAN database. By joining the SALESMAN database with the
INVOICES database, you can extract specific information about each
salesman — in this case, the office number.

Opening STEP2.QPR
1. Choose Open... from the File menu popup.

2. Open STEP2.QPR. The RQBE window appears as in
Figure 4.

Besides being used to join SALESMAN and INVOICE, the office number
field, ONO, has been added to the Output Fields list. ONO is also being
used in addition to SALESMAN to group the query results.

Doing the Query

Choose Do Query. The Browse window appears as in
Figure 5.

Closing the Browse Window and RQBE

1. Close the Browse window.

2. Close the RQBE window.
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RQBE and the Report Writer in Action

ROBE - STEPZ
Output Fields Output To

»INUOICES
SALESMAN

< Add >
< Clear >

ONO [X] Select Fields... Brouse “
SALESMAN

SUMCITOTALY | [ 1 Order By... STEP2
[ 1 Options...

[X1 Group By...
[ 1 Having... < See SQL >
« Do Query »

Field Name

NOT Example U=L Select
Criteria

] SALESMAN. SALESMAN [ 1 Like INUOICES. SALESMAN L1

<Insert>
<{Remoue>

< Or >

Figure 4: STEP2.QPR

Salesman|Sum_itotal

AALULULUUJLUUJNNNNH'—BD-‘

282.22,
1919,39#
3822. 48
2952.55
3855.19

11118.85
11447.51
5748.28
7216.84
7567.48
5721.11
8898. 29
1749.98
11681.77
4721.99
8814.33

Figure 5: STEP2 Query Results in Browse Window
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S9-8

In STEP3.QPR, the OFFICES database is joined to the SALESMAN database
in order to extract the city where each office is located.

Opening STEP3.QPR
1. Choose Open... from the File menu popup.

2. Open STEP3.QPR. The RQBE window appears as in
Figure 6.

In addition, the report STEP3.FRX is used to enhance the appearance of
the output. Using a report also allows the secondary grouping of the
information by the office number field, ONO. A report allows you to get
many levels of group totals as well as totals for an entire report.

Opening STEP3.FRX

1. Choose Open... from the File menu popup. Make sure
Report is showing on the Type popup control.

2. Select STEP3.FRX and choose Open. The Report Layout
window appears as in Figure 7.

3. Take a few moments to examine STEP3.FRX.

4. Close STEP3.FRX.
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RQBE - STEP3
Databases Output Fields Output To

»INUOICES [X] Select Fields... Report/Labelﬂ
SALESMAN

OFFICES SALESHAN [ 1 Order By...
NAME [X]1 Options...
SUMCITOTAL) [X1 Group By...
< Add > [ 1 Having... < See SQL >
< Clear > « Do Query »

Field Name NOT Example UL  Select
Criteria

$] SALESHAN. SALESHAN [ 1 Like INVOICES. SALESHAN

L1
3] OFFICES. ONO [ 1 Like SALESMAN. ONO L1

<{Insert>

<{Remove>

< Or >

Figure 6: STEP3.QPR

Salesman Total Sales

Total Sales All Offices

Figure 7: STEP3 Report in Report Layout Window
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S9-10

Doing the Query

1. Choose Do Query. The Page Preview window appears as
in Figure 8.

2. Choose More to view the entire report.

3. Choose Done to return to the RQBE window.

4. Close the RQBE window.

Notice how the Report Writer has permitted you to:

Change the headings to be more informative
Provide totals for each office

Provide a grand total for all offices

Put spaces between office groups

Use the box drawing facility to provide the line between the office
figures and the office total
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Office

Boston
Boston
Boston
Boston

Atlanta
Atlanta
Atlanta
Atlanta
« Done »

Session 6

Salesman

Janet A. McCarthy
Robert Uatters
Doris Dupuy

T Staziola Tounsend

John Hodge

Houard Schneider
Jay Kennedy
Tom Caravello

322 E. Faulkner
328 Keith Sutherland
353 Jim Surbrook
360 Ned Hicks

< More > Column: e

Figure 8: STEP3 Report in Page Preview Window

Total Sales

282.
1,919.
3,822.
2,952.

8,176.

3,855.
11,118.
11,447.

5, 748.

32,161.

7,216.
7,567.
5,721.
8,898.

22
39
40
55

56

19
85
51
208

75

84
48
11
29
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In STEP4.QPR, the CUSTOMER database joins the party so that the report
can show a breakdown of data by company for each salesman.

Opening STEP4.QPR

1. Choose Open... from the File menu popup. Make sure
Query appears on the Type popup control.

2. Select STEP4.QPR and choose Open. The RQBE window
appears as in Figure 9.
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RQBE - STEP4
Databases Output Fields Output To

»INVOICES CITY [X1 Select Fields... Report/Labelﬂ
SALESHAN ONO

OFFICES SALESMAN [ 1 Order By...
CUSTOMER NAME [X] Options...
COMPANY [X]1 Group By...
< Add > SUMCITOTALY M [ 1 Having... < See SQL >
< Clear > « Do Query »

Field Name NOT Example UL Select
Criteria

OFFICES. ONO [ 1 Like SALESMAN. ONO <Insert>

SALESHAN. SALESMAN [ 1 Like INUOICES. SALESMAN
CUSTOMER. CNO [ 1 Like INUOICES. CNO

<Remove>

< Or >

Figure 9: STEP4.QPR
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Opening STEP4.FRX

1. Choose Open... from the File menu popup. Make sure
Report is showing on the Type popup control.

2. Open STEP4.FRX. The Report Layout window appears as
in Figure 10.

3. Examine STEP4.FRX.

. Close STEP4.FRX to return to the RQBE window.

Doing STEP4.QPR

1. Choose Do Query. The Page Preview window appears
as in Figure 11.

[\J

. Choose More to view the entire report

. Choose Done to return to the RQBE window.

> W

. Close the RQBE window.

Notice how the Suppress... option clarifies the report by eliminating
duplicates of cities and salesmen’s names.
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Summary
Summar
SunmMary

RQBE and the Report Writer in Action

Customer

Total Sales All Offices §

Figure 10: STEP4 Report in Report Layout Window

Salesman
117 Janet A. McCarthy
158 Robert Watters

1?5 Doris Dupuy

188 T Staziola Tounsend

Neu York 248 John Hodge

2?71 Houard Schneider

« Done » < More > Column: 4]

Customner

Snou Aerial Realtors
Balance Computing Systems
Posna Associates

Silicon Computer Calgary
Auard Ammonia Greenhouses
A. Arts Computers

Print Mayo Consultation
Boehringer PCA

Ross & Associates Products

Systems Poetics and

The Circle Distributing
Wilson Solutions
Business State Computers
Bob Produce

Clover Office Shooters

Figure 11: STEP4 Report in Page Preview Window

Session 6
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STEP5.QPR concludes the analysis process by adding the DETAILS and
PARTS databases. These databases are added to display more detailed
information for each invoice.

Opening STEP5.QPR

1. Choose Open... from the File menu popup. Make sure
Query is showing on the Type popup control.

2. Open STEP5.QPR. The RQBE window appears as in
Figure 12.
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Databases Output Fields Output To

»SALESMAN CITY [X] Select Fields... Report/Labeln
OFFICES NAME

INUOICES CNO [X] Order By...
CUSTOMER COMPANY [X] Options...
INO [ 1 Group By...
< Add > DESCRIPT [ 1 Having... < See SQL >
< Clear > « Do Query »

Field Nawne NOT Example UL  Select
Criteria

OFFICES. ONO 1 Like SALESMAN. ONO
%] INVOICES. SALESMAN 1 Like SALESMAN. SALESMAN <{Insert>
%] CUSTOMER. CNO 1 Like INUOICES. CNO

DETAIL. INO 1 Like INUOICES. INO <Remoue>
3] PARTS. PNO 1 Like DETAIL. PNO

Figure 12: STEP5.QPR
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S9-18

Opening STEP5.FRX

1. Choose Open... from the File menu popup. Make sure
Report is showing on the Type popup control.

2. Open STEP5.FRX. The Report Layout window appears as
in Figure 13.

3. Examine STEP5.FRX.

4. Close STEP5.FRX.

Doing the Query

1. Choose Do Query. The Page Preview window appears
as in Figure 14.

2. Choose More to view the entire report.

3. Choose Done to return to the RQBE window.

The final result is a report that organizes the information by sales office.
Within each sales office, the information is broken down by salesman.
For each salesman, the information is broken down by company. For
each company, the information is broken down by invoice. For each in-
voice, information is given on the parts contained in that invoice.

The report also lists overall totals as well as totals by invoice, company,
and salesman.

Notice how boxes can be used to further clarify the data being presented
in the report.

This should give you an idea about how to use RQBE and the Report
Writer to analyze your data and quickly extract the data that you want
to see.
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SALES OFFICE:

Company Name Inut Item Description

SALES ACTIVITY FOR [T

TOTAL FOR

Figure 13: STEP5 Report in Report Layout Window

SALES OFFICE: Atlanta

Conpany Name Inut Item Description Qty Price

SALES ACTIVITY FOR E. Faulkner

Atlanta First Computer Cursive irishman
Defeat confocal
Holst rash
Runty riordan
Skimpy ampex
Soiree intuit
Suit bead corvus
Sulfate images
Woodyard lizard

PR RERNANOU S

« Done » < More > Column:

Figure 14: STEP5 Report in Page Preview Window
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Working With Your Own
Database

In this session you'll learn to create your own
database and add, delete and modify records.

® C(Creating a database structure . . . . page 2
® Defining a database structure . . . . page 4
¢ Entering data in a database . . . . . page 6
® Modifying a database structure . . page 10
® Marking records for deletion. . . . page 16
® Packing a database . . . ... ... page 20
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Working With Your Own Database

Working With Your Own Database

S10-2

So far, you've been using databases that we’ve provided. Now, it’s time
to create and manipulate your own database.

The first step in creating a database is to decide what information you
want to store in the database. Suppose you want to keep track of infor-
mation about wine. You must decide what information about your wines
that you want to save.

You decide that winery, type, flavor, origin, date of purchase, date of
corking, cost and present value are important. Each of these pieces of
information will be one field in your database. You may also want a
field for some other comments about your wine.

Go ahead and start building a database called CELLAR.

Creating a Database Structure

1. Choose New... from the File menu popup. The New File
dialog appears. (Figure 1)

2. The Database radio button is chosen by default, so choose
OK. The Structure dialog appears. (Figure 2)
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Neu:

W W W W W N W

Database
Program
File
Index « OK »
Report
Label < Cancel >
Screen
Menu
Query
Pro ject

AAAAAAAAAN

Figure 1: New File Dialog

Structure: Untitled
Name Type Width Dec

Field

<{Insert>

<Delete>

« OK »

<Cancel>

Fields: a Length: 1 Available: 3999

Figure 2: Structure Dialog
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Working With Your Own Database

The cursor appears in the Name field. Now you can add the name, type
and width of each of the fields shown in Figure 3. For more information
on field types, see the FoxPro Interface Guide.

As you define your fields, the Structure dialog’s status line displays how
many fields you have defined, the total length of all defined fields and
how much space is still available for more field definitions.

Defining a Database Structure

1. Type Winery in the Name field; Character appears on the
Type popup by default; type 20 in the Width field;
skip the Dec field.

2. Using Figure 3 as a guide, define the remaining fields.

3. When the Structure dialog appears as in Figure 3, choose
OK. The Save As dialog appears.

Naming a Database and Preparing to Add Records

1. Type CELLAR in the Save As dialog text box (Figure 4)
then choose Save.

2. FoxPro asks if you want to input records now (Figure 5).
Choose Yes.
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Structure: Untitled

Name Type Width Dec
Field
3
$ <Insert>
$
$ <Delete>
$
$ i
£ COST
E-PUALUE 2 « OK »
ECOMMENTS
<Cancel>
Fields: 9 Length: 112 Available: 3888 Status Line

Figure 3: Structure Dialog with Field Information

Name the neu database:

»[..1 Drive c "
CUSTOMER. DBF

DETAIL. DBF

INUOICES. DBF
OFFICES. DBF Directory | TUTORIAL ﬂ
PARTS. DBF

SALESMAN. DBF

« Save »

[ 1 All Files < Cancel >

CELLAR

Figure 4: Save As Dialog

Input data records nou?

« Yes » < No >

Figure 5: Input Records Alert
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Working With Your Own Database

A Browse window appears, in Change mode, with the cursor in the first
field of the first record. In Figures 6 and 7, the COMMENTS memo field

has been opened, resized and moved to the location shown.

Go ahead and add the following information.

S510-6

AN

® ® N

10.

11.

12.

13.

Entering Data in a Database Structure

Type Mogen David and press Enter.
Type Generic and press Enter.
Type Concord and press Enter.
Type ? and press Enter.

Type 02 12 91. You do not need to type the /. The cur-
sor moves to the next field automatically.

Press Enter to skip the DCORK field.
Type 3.59. The cursor moves to the next field.
Type 3.59. The cursor moves to the next field.

Open the memo window by pressing Ctrl+PgDown or
double-clicking with the mouse. Type This was a
gift from Bert. Close the memo window.

Press Enter to position the cursor in the first field of the
second record.

Using Figure 7 as a guide, add the following information
to the next record: MD 20/20, Generic, Grape, 2,

03 23 91, skip the DCORK field, 3.25, 3.25, This

was a gift from Ernie. Close the memo win-

dow.

Figures 6 and 7 show how the Browse windows and as-
sociated memo windows appear after you add informa-
tion. We've rearranged the windows on the screen so
they appear side by side.

Close the Browse window.
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CELLAR. COMMENTS
Winery i This was a gift from Bert.
Type i
Flavor
Origin
Dpurch
Dcork
Cost
Puvalue
Comments

Winery

Type

Flavor
Origin

Dpurch

Dcork

Cost

Pualue
Comments memo

CELLAR. COMMENTS
Winery Mogen David This was a gift from Ernie.
Type Generic
Flavor Concord
Origin 7
Dpurch 82/12/91
Dcork
Cost
Pualue
Comments

Winery
Type
Flavor
Origin
Dpurch
Dcork
Cost
Puvalue
Comments

Figure 7: CELLAR.DBF
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You have just added records to your database during the creation
process. You can also append records to a database that already exists
through the Record menu popup.

Adding Records to a Database

1. Choose Append from the Record menu popup. The
Browse window appears in Append mode.

2. Using Figure 8 as a guide, add the following data to
record three: Boone'’s, Generic, Wild Mountain,
California, 03/24/91, skip the DCORK field,
2.39,2.39,Present from Mom and Dad.

3. Using Figure 9 as a guide, add the following data to
record four: Barton & Guestier, Chablis,
White, France, 08/22/89, 01/01/87, 11.36,
17.95,My first real investment.

Figures 8 and 9 show how information in your Browse window and as-
sociated memo windows appear.
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CELLAR CELLAR. COMMENTS
Present from Mom and Dad.

Winery
Type
Flavor
Origin
Dpurch
Dcork
Cost
Pvalue
Comments

Winery

Type

Flavor

Origin

Dpurch

Dcork

Cost

Pualue
Comments memo

Figure 8: CELLAR.DBF

CELLAR CELLAR. COMMENTS
My first real inuvestment.

Winery Boone’s

Type Generic
Flavor UWild Mountain
Origin California
Dpurch  837/24/91
Dcork /7

Cost 2.39
Pvalue 2.39
Comments Memo

Winery
Type
Flavor
Origin
Dpurch
Dcork
Cost

Comments [y=I0)

Figure 9: CELLAR.DBF
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Working With Your Own Database

FoxPro gives you the flexibility to change the structure of your database
as your needs change. Suppose that you want to use this database not
only for wines that you are collecting but also for wines that you have
tasted.

To do this, you need to add a consumption date and a rating field. Be-
cause you've learned at a recent wine-tasting that wines are categorized
by class, not flavor, you also decide to change the FLAVOR field to CLASS.

Let’s make these modifications.

Modifying a Database Structure
1. Close the Browse window.

2. Choose Setup... from the Database menu popup. The
Setup dialog appears as in Figure 10.

3. Choose the Modify push button in the upper left corner of
the Setup dialog. The Structure dialog appears.

4. Position the cursor on the FLAVOR field and change it to
CLASS as shown in Figure 11.

5. Position the cursor on the COST field and choose the
Insert push button. NEWFIELD appears above the
COST field. (Figure 11) Change NEWFIELD to DCON-
SUM, then choose Date from the Type popup.

6. Position the cursor on COST and choose Insert. Change
NEWFIELD to RATING, choose Numeric from the Type
popup then change the Width field to 1.
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Modify Push Button
1Database: C:\PROZBB\TUTORIAL\CELLAR. DBF
Structure: <Modify> Indexes: Index
»UINERY C 20 8
TYPE c 10 8 < Add... >
FLAVUOR c 15 %]
ORIGIN c 20 2] <Modify...>
DPURCH D 8 a
DCORK D 8 ] < Remove >
COST N 10 2
PUALUE N 18 2 <{Set Order> “
COMMENTS M ie %]
Fields: 9 Length: 112 Index expr:
Index filter:
[X]1 Set Fields...
C > On C+> OfF « OK »
[ 1 Filter...
[ 1 Format...

Figure 10: Setup Dialog with CELLAR.DBF Information

Structure: C:\PRO280\TUTORIAL\CELLAR.DBF
Name Type Width Dec
Field

Changed Field|

<Insert>

<Delete>

New Field

« QK »

<Cancel>

Fields: 18 Length: 122 Available: 3878

Figure 11: Structure Dialog Showing Changes to
CELLAR.DBF
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Now you have a database that meets your needs. If not, you can easily
change it.

Making Database Structure Changes Permanent

1. When the Structure dialog appears as in Figure 12,
choose OK.

2. FoxPro asks if you want to make the structure changes
permanent. (Figure 13) Choose Yes.

3. The Setup dialog now reflects the changes you’ve made.
(Figure 14)
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Structure: C:\PROZB6\TUTORIAL\CELLAR.DBF
Name Type Width Dec
Field

{Insert>

<Delete>

« OK »

{Cancel>

Fields: 11 Length: 121 Available: 3879

Figure 12: Structure Dialog with Changes

Make structure changes permanent?

« Yes » < No >

Figure 13: Structure Changes Alert

Database: C:\PROZB6\TUTORIALN\CELLAR.DBF

Structure: <Modify> Indexes: Index
»WINERY C 20 %]
TYPE C 18 8 < Add... >
CLASS c 15 ‘]
ORIGIN c 20 %) {Modify...>
DPURCH D 8 %]
DCORK D 8 a < Remove >
DCONSUM D 8 %]
RATING N 1 ] <{Set Order>
COST N 10 2
Fields: 11 Length: 121 Index expr:
Index filter:

[X] Set Fields...

C ) On () Off « 0K »
[ 1 Filter...
[ 1 Format...

Figure 14: Setup Dialog with Changes
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Working With Your Own Database

You've seen that adding records is a simple matter of typing in data
while in Append mode. Deleting records is just as easy. First, browse
the database in question.

Browsing CELLAR.DBF
1. Choose OK to exit the Setup dialog.

2. Choose Browse from the Database menu popup. An
alert appears (Figure 15) to tell you that the default
browse setup will be used. This is because you have
changed the structure of the database since the last
time you browsed the database. Your next keystroke
will remove the alert from your screen.

3. Size the Browse window so it stretches across your screen
as shown in Figure 16.

Notice the column between the fields and the window border. (Figure 16)
A dot ( » ) appears in this delete/recall column when you mark the record
for deletion.
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Invalid BROWSE setup —— default setup used

Figure 15: Default Browse Setup Alert

Delete/Recall Column

CELLAR

Fiogen David

MD 206-/28 Generic Grape
Boone’ s Generic Uild Mountain

Barton & Guestier Chablis

Figure 16: CELLAR.DBF Showing Delete/Recall Column
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Go ahead and mark a couple of records for deletion.

Marking Records for Deletion
With the keyboard:

1. Use the Up and Down Arrows to select the record with
the name “MD 20/20.”

2. Choose Toggle Delete from the Browse menu popup. A
dot appears in the delete/recall column. (Figure 17)

3. Repeat steps 1 and 2 but mark “Boone’s” for deletion.

With the mouse:

1. Position the pointer on the delete/recall column next to
“MD 20/20” and click. A dot appears in the column.
(Figure 17)

2. Repeat the step above but mark “Boone’s” for deletion.

These records are only marked for deletion. They have not yet been
deleted. FoxPro is waiting for you to give the word to delete these
records. That word is pack.

Packing a database permanently removes all of the marked records.
This process is irreversible, so you must be very sure that only those
records that you really, really want to get rid of are marked for deletion.
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Hinery Type Class Origin

-MD 26/28 Generic Grape ?

*Boone’s Generic Uild Mountain |California

Barton & Guestier Chablis Uhite France

Figure 17: CELLAR.DBF with Records Marked for Deletion

Two records marked for deletion

Session 7 S10-17



Working With Your Own Database

Suppose you change your mind about deleting one of the records you
have marked. Let’s go in and unmark it.

Recalling a Record Marked for Deletion
With the keyboard:

1. Press the Up and Down Arrows to select the record with
the winery name “Boone’s.”

2. Choose Toggle Delete from the Browse menu popup.
The dot in the delete/recall column disappears.
(Figure 18)

With the mouse:

Position the pointer on the dot next to “Boone’s” in the
delete/recall column and click. The dot disappears.
(Figure 18)
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Uinery

R
?

-MD 28/28 Generic Grape ?
Boone’ s Generic Wild Mountain |California

Barton & Guestier Chablis White France

Figure 18: CELLAR.DBF with One Record Marked for Deletion
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Working With Your Own Database

Now it’s time to impose the sentence on the record marked for deletion.

Packing the Database

1. Choose Pack from the Database menu popup. An alert

appears asking if you want to pack the database.
(Figure 19)

2. Choose Yes.

Verify that the record marked for deletion is indeed gone.

Browsing the Database

1. Choose Browse from the Database menu popup.

2. Look high and low for the record — “MD 20/20” is gone.
(Figure 20)
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Pack C:\TUTORIALN\CELLAR.DBF?

« Yes » < No >

Figure 19: Pack Alert

Winery Type Class Origin Dpurc
Mogen David Generic Concord 7 82712
Boone’ s Generic Wild Mountain |JCalifornia 83724
Barton & Guestier |[[Chablis |hite | PR | X

Figure 20: CELLAR.DBF Packed
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Editing the data in your database is easy, too.

Editing Data in the Database

Position the cursor after “Concord” in the CLASS field of
the first record and add “Grape” so the record ap-
pears as in Figure 21.

You've accomplished many tasks during this session that in the past
could only have been accomplished by techo-whizzes.

Please take some time and enjoy the intermission while we rearrange
the props.
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Field changed from Concord to Concord Grape

Winery Type Origin

Mogen Dauvid Concord Grape 7

Boone’ s Generic Uild Mountain al ifornia
Barton & Guestier Chablis White France

Figure 21: CELLAR.DBF with Edited Field
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Designing a Custom
Input Screen

In this session you'll learn to use FoxPro’s
powerful Screen Builder to design your own
custom input screen.

® (Creating a quick screen . . . . ... page 2
® DPlacing fields in a user window . . . page 4
® (Creating a scrollablelist . . . . . .. page 12
® Generating screencode . . ... .. page 14
® (Creating a calculated field . . . . . . page 20
® Creatingapopup . . . . ... .. .. page 24

® Adding a control panel . . . . .. .. page 26

Creating a screenset. . . ... ...
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Designing a Custom Input Screen

S11-2

So far, you've looked at data in several ways. You've used the Browse
window to view data in tabular form. Change mode allowed you to look
at fields in each record one below the other. With reports, you placed
data exactly where you wanted it for display and printing purposes.

The Screen Builder lets you include your data in a screen that you
design — not only for display but for input and modification as well. In
this session you'll create and use a screen for your CELLAR database.

Let’s begin by creating a quick screen.

Creating a Quick Screen
1. Make sure CELLAR.DBF is open.

2. Choose New... from the File menu popup, choose the
Screen radio button then choose OK. An untitled
Screen Design window appears. (Figure 1)

3. Choose Quick Screen... from the Screen menu popup.
The Quick Screen dialog appears. (Figure 2)

4. Choose OK in the Quick Screen dialog. The fields from
CELLAR.DBF are placed in the Screen Design window.
(Figure 3)
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UNTITLED. SCX

Figure 1: Screen Design Window

Quick Screen:

C > By Column Layout

(> By Rou Layout Fieldl xxxxxx
Field2 xxxxxx

[X]1 Titles Field3 xxxxxx

[ 1 Fields... Field4 xxxxxx

[X]1 Add Alias

[ 1 Memory variables
Maximum field width:

« OK » < Cancel >

Figure 2: Quick Screen Dialog

UNTITLED. SCX

Figure 3: Screen Design Window with CELLAR.DBF Fields
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With the Screen Builder, you can place fields in a window that you
design.

Placing Fields in a User Window

1. Choose Screen Layout... from the Screen menu popup.
The Screen Layout dialog appears.

2. Choose the Window radio button at the top of the Screen
Layout dialog. (Figure 4)

3. Type Wineing Is My Hobby in the Title text box.
(Figure 4)

4. Type 15 in the Height text box and 64 in the Width text
box. (Figure 4)

5. Choose the Type... push button. The Window Type
dialog appears as in Figure 5.

6. Choose Dialog from the Type popup then choose OK.
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Window Radio Button

|

C ) DeskTop
Title Text
Box Nane:
Title:
Footer:

Size:

(<) Uindou

<Type...>
Wineing Is My Hobby

Height/W1dth Screen Code:
Text Boxes Height: [BE [ 1 Setup...
Width: 64 [ 1 Cleanup & Procs... « OK »
Position: READ Clauses: < Cancel >
Rou: [ 1 Activate... [ 1 Shou...
Column: [ 1 valid... [ 1 When...
[X] Center [ 1 Deactivate...
Environment: [X] Add alias
< Save > < Restore > < Clear >
Figure 4: Screen Layout Dialog
Type Popup

Type: L User

System
Cbialog |

Attribut] Alert

[ 1 Close

[ 1 Float
[X1 Shadou

[ 1 Minimize

Color Schemes:

d

d

) Double « OK »
>

>

< Cancel >

Primary:

Popup:

User u1nds“

User Henu§“

Figure 5: Window Type Dialog

Session 8

S11-5



Designing a Custom Input Screen

Returning to the Screen Design Window

Choose OK in the Screen Layout dialog. The Screen
Design window appears as in Figure 6.

Now you can move the fields and field titles around so that they are
pleasing to your eye. Figure 7 shows one possible outcome.

Moving Fields and Field Titles
Move the fields and field titles to match Figure 7.

* With the keyboard, move the cursor to each field and
field title, press the Spacebar then use the arrow
keys to move the field or field title to the desired
location. Press Enter to confirm the move.

¢ With the mouse, click on each field and field title and
drag it to the desired location.
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UNTITLED. SCX

Wineing Is My Hobby

¢ uinery
¢ type...

Figure 6: Screen Design Window

UNTITLED. SCX

Wineing Is My Hobby

Pualue [EEFNEINT
Cost EHEEIS SN

Dcork [HELLT32
Dpurch XIS
Dconsum 7R (SIS

Comments  pBRNLITT-01 £

Figure 7: Screen Design Window with Moved Fields
and Field Titles
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It might look nicer if a few of the field titles were changed.

Editing Field Titles

1. Edit the following field titles to match Figure 8: Change
DPURCH to PURCHASED, DCORK to CORKED, DCONSUM
to CONSUMED and PVALUE to VALUE.

To edit a title, select the field title and choose Text from
the Screen menu popup. Type the desired title.
Press Enter when you're finished editing each title.

2. Using Figure 8 as a guide, position the cursor where you
want the text “Date” to appear, type Date then press
Enter.
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UNTITLED. SCX

Wineing Is My Hobby
Origin ZHEEGTS T EE) NI

Type Class Rating

UEIT-M18: pualue Date
Cost SHEETTS SN

Corked [SEN[LYdN
Purchased SHEGIJINS
Consumed @RS

LTI 311: comments

Figure 8: Screen Design Window with Edited Field Titles
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Try drawing a line beneath “Date.”

S11-10

Drawing a Line

Add a line beneath “Date,” as shown in Figure 9, by
positioning the cursor in the location you want the
line to appear and choosing Box from the Screen
menu popup.

o With the keyboard, use the arrow keys to shrink the
blinking box to a line then press the Right Arrow
key until the line is the desired length. Press Enter
to confirm the action.

¢ With the mouse, click on the blinking box and drag until
the line has no depth and is the desired length then
release the mouse button.
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UNTITLED. SCX

Uineing Is My Hobby

Value JGEENVESHT Date
[ ISMT: cost...

Corked [HEEGLISN
Purchased [SIJge
Consumed [gilileiNiEs

IR 11: comments

Figure 9: Screen Design Window with Line
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The COMMENTS field is a memo field and can contain a variable amount
of information. Let’s change how this field is displayed to reflect its
unique structure.

S11-12

Changing the Display of the Memo Field

1. Choose the COMMENTS field. The Screen Field dialog ap-
pears.

2. Choose the Edit radio button at the top of the Screen Field
dialog and choose the Scroll bar check box. The dialog
should appear as in Figure 10. Choose OK.

3. Size the COMMENTS field to match Figure 11.

» With the keyboard, Ctrl+Spacebar on the field so that it
blinks. Use the arrow keys to size the field then press
Enter.

* With the mouse, Ctrl+click on the field so that it blinks.
Hold down the mouse button then drag until the field
is the desired size.
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Edit Radio Button

Field:
C ) Say C ) Get (> Edit
< Edit... >
<« OK »
< Forrat.... > [
< Cancel >
Range:
[ 1 Upper... [ 1 Lower...
[ 1 Uhen... [ 1 Error... [X1 Scroll bar +——j— g(}:lr()l}(%ar
[ 1 Valid... [ 1 Comment... [ 1 Allou tabs eck box
[ 1 Message... [ 1 Disabled [ 1 Refresh
Figure 10: Screen Field Dialog
. UNTITLED. SCX

L}

R: B8C: b Move
Uineing Is My Hobby

origin

Type Class Rating §

Ualue [CHERYENTE Date
Cost SHENl 13S0

Corked [HENITTEY

Purchased EHEGINg

. Consumed (g
Sized

Memo Field JliConments Iy

| S

Figure 11: Screen Design Window with Sized Memo Field
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To use this screen, you need to tell FoxPro to generate a program. Don’t
worry about the whys and hows of programs right now — you will learn
about those in a little while. As your screen is generated, you will see a
thermometer that indicates the progress of the generation.

Go ahead and generate your first screen.

Generating Screen Code

1. Choose Generate... from the Program menu popup.
FoxPro asks if you want to save changes to your un-
titled screen. Choose Yes.

2. In the Save As dialog, type CELLAR as shown in Figure 12
then choose Save.

3. FoxPro asks if you want to save environment information.
Choose Yes.

4. The Generate dialog appears as in Figure 13. Choose
Generate.
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Save Screen fis:

»C..1 Drive c “
Directory | TUTORIAL "

« Save »

[ 1 All Files < Cancel >

CELLAR

Figure 12: Save As Dialog

- Screens - Code Options
k: CELLAR [X1 Open Files
3 < Edit > [X]1 Close Files
b < Add > [X]1 Define Windous
3 < Remove > [X]1 Release Windous
kS < Arrange > [X1 READ CYCLE
k2 [ 1 Multiple READs
- Screen Code
< Output File... > < Comment Options... >
C: \TUTORIALNCELLAR. SPR
Generate
Push « Generate » < Cancel >

Button - -
Figure 13: Generate Dialog
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To see the results of your screen, close the Screen Design window and do
the program CELLAR.SPR.

Doing CELLAR.SPR
1. Close CELLAR.SCX.

2. Choose Do... from the Program menu popup. The Do
dialog appears. (Figure 14)

3. Select CELLAR.SPR and choose Do.

Figure 15 shows the screen you designed. The screen contains informa-
tion from the current record in CELLAR.DBF.
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Do Program File:

[..1 Drive C n
BIGEXAM. QPR

CELLAR. SPR |
SESSIONS. QPR
Directory | TUTORIAL “
<« Do »
< Cancel >
[ 1 All Files
Figure 14: Do Dialog
Uineing Is My Hobby
winery [FCNEEHNMNEE  Origin
Type Class Rating [
Ualue 3.59 Date
Cost 3.59

Corked /7
Purchased [J2gVigcll
Consumed /s 7/

Comments This uas a gift from Bert.

Figure 15: Screen with Fields from CELLAR.DBF
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As it stands, you can only use the screen to look at one record. Let’s
modify the screen so that it is more flexible.

Opening an Existing Screen
1. Press Escape to remove the screen from your monitor.

2. Choose Open... from the File menu popup and make sure
Screen is showing on the Type popup control.

3. Select CELLAR.SCX then choose Open. CELLAR.SCX ap-
pears as in Figure 16.
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CELLAR. SCX

Uineing Is My Hobby

Value [HEUEIDE
[« 139 cost. ..

Comments BN

Figure 16: CELLAR.SCX
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It might be useful to have your screen display the amount of money that
you would make if you sold a bottle of wine. This amount can be calcu-
lated by subtracting the cost from the present value.

Create a calculated field to do this arithmetic for you.

Creating a Calculated Field in a Screen

1. Draw a line on the screen under the COST field as
shown in Figure 17.

2. Position the cursor where you want the text “Net” to ap-
pear as shown in Figure 17. Type Net then press
Enter.

3. Using Figure 17 as a guide, position the cursor next to
“Net” where your calculated field will appear.

4. Choose Field... from the Screen menu popup. The
Screen Field dialog appears.

5. Choose the Say radio button at the top of the Screen
Field dialog.

6. Type CELLAR.PVALUE - CELLAR.COST in the Say text
box.

7. Choose the Refresh check box.

8. When the dialog appears as in Figure 18, choose OK.
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CELLAR. SCX

Uineing Is My Hobby

Ualue JUHENIESTIE Date
Cost SHETIS SN

—— Corked [“HENIgN
Net Purchased HEITING

Consumed [gR(INES

Figure 17: CELLAR.SCX with Calculated Field

) Field:
Say Radio
Button (> Say C > Get C > Edit

< Say... bMcellar. pvalue - cellar. cost] Say Text Box

« OK »
< Format.... >
< Cancel >
Range:
[ 1 Upper... [ 1 Louer...
[ 1 UWhen... [ 1 Error... [ 1 Scroll bar
[ 1 Valid... [ 1 Comment... [ 1 Allou tabs
[ 1 Message... [ 1 Disabled  [X] Refresh Refresh Checl

Box

Figure 18: Screen Field Dialog
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Another useful piece of information is the age of the wine. The age can
be computed by subtracting the date the wine was corked from today’s
date.

When this calculation is performed, FoxPro returns the number of days
between the corked date and today’s date. If you divide this number by
365, you will get the age of the wine in years.

Create this calculated field.

Creating Another Calculated Field

1. Position the cursor where the text “Age (years)” is to ap-
pear on the screen as shown in Figure 19, type Age
(years) and press Enter.

Position the cursor directly beneath the “Age (years)” text.
Choose Field... from the Screen menu popup.
Choose the Say radio button.

o s N

Type (DATE() - cellar.dcork) /365 in the Say text
box.

6. Choose the Refresh check box.

7. When the Screen Field dialog appears as shown in Figure
20, choose OK.
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CELLAR. SCX

=ineing Is My Hobby

ZY0TCN10: pualue Date
Cost SHEEZ IS S

—_— Corked [SHENIYN
Net Purchased RIS fge (years)

Consumed g (L1 13: (DATEO -

Figure 19: CELLAR.SCX with Another Calculated Field

Field:

(-) Say ¢ ) Get ¢ > Edit

< Say... PB(DATEC(Y - cellar.dcork>”36

<« OK >»

< Forvat.... >
< Cancel >
Range:
[ 1 Upper... [ 1 Lower...

[ 1 When... [ 1 Error... [ 1 Scroll bar
[ 1 Valid... [ ] Comment... [ 1 Allou tabs
[ 1 Message... [ 1 Disabled [X]1 Refresh

Figure 20: Screen Field Dialog
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The rating system that you devised for your wines is based on a scale of
1 to 5. It would be easier to remember and rate your wines if these
values were displayed as descriptive text.

Create a popup to accomplish this.

Creating a Popup
1. Delete the RATING field but leave the “Rating” field title.

2. Position the cursor directly beneath the “Rating” field
title.

3. Choose Popup... from the Screen menu popup. The
Popup dialog appears.

4. Choose the Choose... push button. The Choose
Field/Variable dialog appears.

5. Choose Rating from the Database Fields list so that the
Choose a Field or Variable text box appears as in Fig-
ure 21, then choose OK.

6. Type Fatal, Septic, Nauseating, So-so, Sub-
lime, Intense, Awesome in the list on the left
side of the Popup dialog as shown in Figure 22.

7. Choose So-so from the Initial popup.

8. When the Popup dialog appears as shown in Figure 22,
choose OK. CELLAR.SCX now contains a popup as
shown in Figure 23.
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Choose a Field or Uariable:<varN>
cellar.rating

Database Fields: Memory Uariables:
Database:
WINERY CNH > ALIGNMENT | C
TYPE cg CELLAR ﬂ _BOX L
CLASS c _INDENT N
ORIGIN c _LMARGIN N
DPURCH D _PADUANCE C
DCORK D « OK » _PAGENO N
DCONSUM D _PBPAGE N
»RATING N M < Cancel > _PCOLNO N

Figure 21: Choose Field/Variable Dialog

> L > n P
ist Popup rray Topup ChOOSG... Push
3 Uariable: Button and
3 Tex
: Cchoose. . > CINTTRTCITTI |-|—oxt Dox
k4
3 Options:
3
% [ 1 When... [ 1 Comment...
[ 1 Valid [ 1 Disabled
143 [ 1 Message... [ 1 ist Element...
Initial [ 11 Elements...
Popup
Control
—— Initial: « 0K » < Cancel >

Figure 22: Popup Dialog

CELLAR. SCX

Uineing is my Hobby

Rating

Value EHEEDCINGE Date ‘ So-so “
[ IS M8: cost...

—_— Corked [‘HEITEY
,Gimi1: cellar. Purchased 3T Age (years)
[LLETUT B7: dconsjl12: (DATEQ -

Comments
18: comments

Figure 23: CELLAR.SCX with Rating Popup
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To use this new screen, FoxPro must regenerate the program.

We've also provided a screen called CONTROL3.SCX that you can combine
with your screen to allow you to navigate through your database.

Let’s use the screen generator to combine two screens and create a pro-
gram.

Combining Two Screens

1. Choose Generate... from the Program menu popup. An
alert appears asking if you want to save changes to
CELLAR.SCX. Choose Yes.

2. Choose the Add push button in the Generate dialog. The
Open File dialog appears. (Figure 24)

3. Select CONTROL3.SCX then choose Add. The Generate
dialog appears as in Figure 25.

4. Choose Arrange from the Generate dialog.

5. Using Figure 26 as a guide, arrange the screens on your
monitor.

6. Choose Save from the Arrange menu popup. The
Generate dialog reappears.

7. Choose Generate. An alert tells you that CELLAR.SPR al-
ready exists and asks if you want to overwrite it.
Choose Yes.
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Select screen file name:

[..1 Drive c n
CELLAR. SCX

CONTROL3. SCX I

Directory | TUTORIAL

« Add »

< Cancel >

[ 1 All Files

Figure 24: Open File Dialog

- Screens - Code Options

$ CELLAR
B CONTROLS |
kS

[X] Open Files

< Edit > [X] Close Files

< Add > [X]1 Define Windous
< Remove > [X]1 Release Windous
< Arrange > [X] READ CYCLE

[ 1 Hultiple READs

- Screen Code
< Output File... > < Comment Options... >
C: \TUTORIALN\CELLAR. SPR

« Generate » < Cancel >

Figure 25: Generate Dialog

Controls=—=

Wineing Is My Hobby

Figure 26: Screen Arrangement
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To use these screens, commonly called a screen set, do the program CEL-
LAR.SPR.

Doing CELLAR.SPR
1. Close the Screen Design window.

2. Choose Do... from the Program menu popup.

3. Select CELLAR.SPR and choose Do. The screen set you've
designed appears as in Figure 27.

Note that the windows in Figures 27 and 28 are in slightly different
positions. You can move these windows just like the other windows you
have encountered.

Navigating Through Your Database

1. Choose any of the following push buttons from the Con-
trols screen to move through CELLAR.DBF: Top, Prior,
Next or Bottom.

2. Choose Append from the Controls screen. A blank input
screen appears so you can add another record to
CELLAR.DBF.

3. Type in the information as shown in Figure 28, then
choose Quit from the Controls screen.

We know that the power of the Screen Builder can leave you breathless,
so the coach calls a time out for you to catch your breath.
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<{Prior >

< Next >

<Bottom>
{Append>

< Quit >

Designing a Custom Input Screen

Uineing is my Hobby

Winery Origin

Type [ WConcord Grape Rating

Value 3.59 Date Auesome “

Cost 3.58

_— Corked 4

Net 8.08 Purchased [JJZgVigl} Age C(years)
Consumed /7 7 8.08

CommMents

This was a gift from Bert. I

Figure 27: Screen Set

Controls screen moved down

<Prior >

< Next >

<Bottom>

<Append>

< Quit >

Session 8

Uineing is my Hobby

uinery CUPACOCNNN  Orisin O
Tupe Class Rat ing
Value -5.88 Date Fatal “
Cost 9.00
—_— Corked [‘L¥diNIgss
Net -5.088 Purchased [BYgatg:f Age (years)
Consumed /7 7/ 3.87

Comments
This is one of Aunt Uilma’'s best! I

Figure 28: Appended Record
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Generating an
Application with FoxApp

In this session you'll generate an application using
FoxApp. You'll also learn more about the
Command window.

6 UOISSAS

® StartingFoxApp ........... page 2
® TUsing CELLAR.DBF with FoxApp . . . page 4
® Generating an application . . . . . . page 6
® Starting an application. . . . . . .. page 8
® Opening an application file . ... page 12
® The Command window . . . . . . . page 14
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Generating an Application with FoxApp

Generating an Application with FoxApp

In Session 7 you created and modified your own database. In the last
session you designed an attractive custom screen for your database. In
this session you are going to “pull it all together” and learn about a
program called FoxApp, the FoxPro Application Generator.

FoxApp is not really part of FoxPro — it’s one of the sample programs
provided to illustrate the flexibility and power of FoxPro. Feel free to
look at and change FoxApp if you so desire.

FoxApp gives you a way to organize the tools that you've learned about
so far. FoxApp takes a database and a screen and creates an application
that allows you to manage your database even more efficiently.

The easiest way to learn about FoxApp is to use it.

Starting FoxApp

1. Choose Do... from the Program menu popup. The Do
dialog appears. (Figure 1)

2. Select FOXAPP.APP and choose Do. The FoxApp dialog ap-
pears. (Figure 2)
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Do Program File:

L..1
APPABOUT. PRG
APPCTRL. PRG
APPCTRL1. PRG
APPMENU. PRG
APPPROC. PRG
APPSHELL. PRG
APPSRCH. PRG
FOXAPP. APP

[ 1 All Files

Drive Cc "
Directory | FOXAPP “

<« Do »

< Cancel >

Figure 1: Do Dialog

FoxPro Application Generator

Step 1: Create or modify a database

Database name:

< Create > < Modify > <File List>

Step 2 : Design a screen

Screen name:

I
< Create > < Modify >  <File List>

« Generate »

< Cancel >

Figure 2: FoxApp Dialog

Session 9
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S12-4

The first step when using FoxApp is to select a database. If the
database does not yet exist, FoxApp allows you to create it. FoxApp also
allows you to change the structure of a database.

Because the database CELLAR already exists, tell FoxApp to use it.

Using CELLAR.DBF with FoxApp

1. Choose the File List push button in the Step 1 area of the
FoxApp dialog. The Open File dialog appears.
(Figure 3)

2. Select CELLAR.DBF then choose Open. The FoxApp dialog
appears as in Figure 4.

When you selected your database, FoxApp found the screen with the
same name and automatically placed it in the Screen Name text box in
the FoxApp dialog.

If an appropriate screen is not available, FoxApp is very flexible — it

allows you to access the FoxPro Screen Builder so you can design and
modify a screen to use in your application.
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Database name

[..1 Drive g

CUSTOMER. DBF

DETAIL. DBF

INUGICES. DBF Directory | TUTORIAL “

OFFICES. DBF

PARTS. DBF

SALESMAN. DBF « QOpen »
< Cancel >

[ 1 All Files

Figure 3: Open File Dialog

FoxPro Application Generator

Step 1: Create or modify a database

Database name:

C:\PROZBO\TUTORIAL\CELLAR. DBF

< Create > < Modify > <File List>

Step 2 : Design a screen

Screen name:

C: \PROZ2BB\TUTORIAL\CELLAR. SCX

< Create > < Modify > <File List>

« Generate »

< Cancel >

Figure 4: FoxApp Dialog with CELLAR.DBF and
CELLAR.SCX Information
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Now that you have a database and a screen to work with, tell FoxApp to
generate your application.

FoxApp first asks you to name your application. In your case, the
default is the name you've already given to your database and screen.
This would make an ideal name for an application.

Generating an Application with FoxApp

1. Choose the Generate push button at the bottom of the
FoxApp dialog. The Save As dialog appears with
CELLAR.APP entered in the text box. (Figure 5)

2. Choose Save. FoxApp tells you it is generating your ap-
plication and displays a thermometer indicating its
progress. (Figure 6)
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Name your application:

»C..1] Drive C H
Directory |TUTORIAL “

« Save »

[ 1 All Files < Cancel >

CELLAR. APP

Figure 5: Save As Dialog

/, System File Edit Database Record Program UWindou ‘\

Generating application Cellar

Generating Screen Code...
\PROZBO\TUTORIAL\CELLAR. SPR

Figure 6: FoxApp’s Message and Thermometer
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S12-8

When FoxApp finishes generating your application, a message appears
on your screen telling you to press any key to start your application.

Starting Your Application

Press any key. Your application appears as in Figure 7.

Your application consists of an input screen, a control screen and a
menu bar.

The input screen and control screen help you to navigate easily through
your database file, as you learned to do in Session 8.
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Wineing is my Hobby

uinery Origin
Type Class Rating

Value Date Fatal ||
Cost 0.00
_— Corked [LZdiNEg:i:
Net -5.00 Purchased [EY@4RgE]
Consumed /s 7/
Comments
This is one of Aunt Wilma’s best! I

Age C(years)
3.87

Ir( Top > < Prior > < Next > < Bottom > < Search > < Quit >]

Session 9

Figure 7: Generated Application
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The System and Edit menu popups in your application are shortened
versions of FoxPro’s System and Edit menu popups.

The Application and Utilities menu popups contain a variety of options,
as shown in Figure 8. These options enable you to perform additional
operations on your database file. You're already familiar with the ac-
tions of many of the options on these popups. The Top, Bottom, Next
and Prior options correspond to the push buttons on the control screen.
Notice that your application allows you to add, copy and delete records as
well as browse your database. You can even create a report or a query.
Your application places all of these options at your fingertips!

You're probably anxious to play with your application. Go ahead and
play for a while. When you're done, choose the Quit push button on the
control screen.
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/ N\
Application Utilities
Top F2 Construct index
Bottom F3 Pack
Next F4 Status Bar
Prior F5 Clock
Extended video
Add record *Sticky

Copy record
Delete record "D

Brouse “B
Search... s
Filter... “F
Order... ~0
Query. .. ~Q
TS | Print report. ..
Printer setup...
Form layout
Modify report... Columnar layout
N J

Figure 8: Application and Utilities Menu Popups
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Applications are simply a series of FoxPro commands that have been
entered into a file. Commands are statements that tell FoxPro what to
do. When FoxApp generated your application, it placed many FoxPro
commands into several files.

Let’s look at one of these files.

Opening an Application File

1. Choose Open... from the File menu popup. Make sure
Program is showing on the Type popup control, select
STARTUP.PRG then choose Open. A program editing
window appears with FoxPro code in it.

2. Scroll through some of the commands. (Figure 9)

3. Close the program editing window.
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SELECT @
USE C:\FOXPRO\TUTORIAL\CELLAR.DBF
SET ORDER TO 1
ENDIF
IF RECCOUNTO> = @
APPEND BLANK
ENDIF
GOTO TOP
CLEAR
DO WHILE tbailout
% Display the screen control panel
DO appctrl WITH 22,3
% Display the main screen file
DO cellar.spr
ENDDO
% Clean up after the application
RELEASE ALL LIKE .
SET PROCEDURE TO
CLOSE DATABASES
CLEAR ALL

Figure 9: STARTUP.PRG
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You can enter commands in the Command window.

The Command window contains a history of all the commands used since
you started FoxPro. You can scroll through these commands to look at
them, or even re-execute them if you desire. Figure 10 shows the Com-
mand window as it may appear during a FoxPro session.

Everything that you do when you use the interface can be accomplished
by entering commands into the Command window.

FoxPro’s commands are organized alphabetically and explained in detail
in the FoxPro Commands & Functions manual. Each command is also
explained in FoxPro’s on-line help system.
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Generating an Application with FoxApp

SET DEFAULT TO C:\FOXPRO\FOXAPP

DO C:\FOXPRO\FOXAPP\FOXAPP.APP

USE C:\FOXPRONTUTORIAL\CUSTOMER. DBF
BROWSE LAST

CHANGE

GO BOTTOM

RECALL ALL

USE C:\FOXPRON\TUTORIAL\SALESMAN. DBF
BROWSE LAST

Figure 10: Command Window
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If the Command window isn’t visible, activate it and try out some com-
mands.

Typing Commands in the Command Window

1. If the Command window isn’t visible, choose Command
from the Window menu popup.

2. Type CLOSE ALL in the Command window then press
Enter.

3. Type CLEAR in the Command window then press Enter.

4. Type USE CUSTOMER in the Command window then
press Enter.

5. Type BROWSE in the Command window then press Enter.
The Command window appears as in Figure 11.

6. Close the Browse window.

At this point, things should look familiar. You issued the USE command
which opened the CUSTOMER database. The BROWSE command you
entered activated the Browse window. When you closed the Browse win-
dow, you returned to the Command window.

By observing what happens in the Command window when you select
menu options, you can easily learn many FoxPro commands.
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Command

CLOSE ALL
CLEAR
USE CUSTOMER

BROUWSE

Figure 11: Command Window with Commands You Typed
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[ Now What?

This session reviews what you've learned and
directs you to other sources so you can continue
to learn about FoxPro.

¢1eyM MON
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Now What?

Congratulations! You've just been introduced to one of the most power-
ful database management systems in the universe. You've learned to:

Create databases and fill them with data

View data in a Browse window

Extract specific data using RQBE
Create professional reports with the Report Writer

Design custom screens with the Screen Builder

Create a simple application

You can now use FoxPro’s powerful tools to quickly and efficiently
manage your data. But this is just the beginning. FoxPro is a dynamic
and multi-faceted database management system. You can continue your
studies and develop your own custom applications that utilize all of
FoxPro’s functionality.

There are many places to learn more about FoxPro. The first place to
look is in the remaining FoxPro manuals.

Foxro

5 g 9
facd]

Interface Guide
Fox Software

FoxPro |

Commands & Functions

Fox Software

Fo

:
Developer's Guide
Fox Software

xPro |

S13-2

The Interface Guide teaches you more about FoxPro’s
interface, including FoxPro’s menus, Report Writer,
Label Designer, Screen Builder, Menu Builder, RQBE
and Project Manager.

Commands & Functions contains FoxPro’s commands,
functions and system memory variables, listed al-
phabetically for easy access. It includes examples to
demonstrate how to use the language.

The Developer’s Guide covers topics of particular inter-
est to those who develop applications. Topics include
tips for using projects, screens, menus, browse, select,
arrays, low-level file I/O, optimization, text merge and
FoxDoc. Customizing help, debugging applications and
customizing FoxPro are also discussed.
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The following additional sources are available:

Classes on FoxPro in your area. Consult the training list included
with the product and the Fox Software Developers Directory for
trainers in your area. Also check with local colleges and universities.

Fox Software Developers Directory. This book can assist you in find-
ing consultants and third party FoxPro applications.

FOXFORUM on CompuServe. See the Customer Support chapter in
the appendix of the Developer’s Guide.

Fox Software Developer Conference. Contact the Fox Software
Marketing Department for registration information.

Current FoxPro books. A third party book list is included with the
product.

User groups. Contact the Fox Software Marketing Department for a
list of Fox user groups in your area.

Database oriented magazines.

As you can see, many options are available for learning more about
FoxPro. You can choose the option that meets your needs.

Good luck!
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DOS and FoxPro

This appendix section discusses how to use pos
to create and organize FoxPro files on your com-
puter. It is not intended to be a pos tutorial — if
you are not familiar with pos, consult your pos
manual or one of the many available pos books.

e WhatisDOS? . . . . ... ... .... page 2
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What is DOS?

What is DOS?

DOS is an acronym for Disk Operating System. DOS controls your
computer and the devices connected to it (the keyboard, printers,
disk drives and so on).

Your computer uses DOS to create and organize information in the
form of files — all information on your computer is contained in
files. A file can contain a program (like FoxPro), data (like a
FoxPro database), text (created with the FoxPro text editor) and so
on.

DOS File Names

When you create a file in FoxPro, you are asked to supply a file
name. Certain DOS rules apply to the file name.

A file name can be from one to eight characters long, and cannot
contain spaces. DOS reserves certain characters for its own use,
and these characters cannot be included in a file name. Reserved
characters are:

DOS Reserved Characters

" ? \ /
* + = I
[ ] < >

Any combination of letters, numbers and symbols other than the
reserved characters above can be used in a file name.

DOS File Extensions

In addition to the file name, you can include an optional extension
when naming a file. A file extension is a period followed by one to
three characters. The characters you can include in a file exten-
sion are the same as those allowed in a file name. The file exten-
sion usually indicates the file type. For example, FoxPro database
files have a .DBF extension and program files have a .PRG exten-
sion.
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The following table lists some of the default file extensions used
for FoxPro files and the corresponding file type.

Extension File Type
.CDX Compound Index
.DBF Database
FRX Report
.LBX Label
.MNX Menu
PJX Project
.PRG Program
.QPR Query
.SCX Screen

Special Files

Three special text files affect the operation and performance of
FoxPro. Two of these files, CONFIG.SYS and AUTOEXEC.BAT, are
used to configure your computer. The third, CONFIG.FP, is a file
that configures FoxPro when FoxPro is started. These files and
their use by FoxPro are discussed in greater detail in the FoxPro
Developer’s Guide.

The CONFIG.SYS system configuration file is a special file that is
read whenever you turn on your computer. It initializes your com-
puter, and can contain settings that affect FoxPro.

Two settings in your CONFIG.SYS file affect FoxPro — FILES and
BUFFERS. The FILES setting determines how many files can be
opened in FoxPro, and the BUFFERS setting can be adjusted to op-
timize FoxPro’s performance.

The AUTOEXEC.BAT file contains a set of DOS commands that are
executed when you turn on your compute. A DOS PATH command
can be included in your AUTOEXEC.BAT file to tell DOS and FoxPro
where to look for files. A DOS SET command can be included to tell
FoxPro where to look for its configuration file.

CONFIG.FP, the FoxPro configuration file, can include a long list of
commands that adjust FoxPro to your liking. You can also specify
where the temporary files that FoxPro creates are located. Proper
placement of these temporary files can greatly improve FoxPro’s
performance.
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How Does DOS Organize Files?

DOS organizes files by drive and directory.

Disk Drives

Files are stored by your computer on disk. There are two types of
disks — external floppy disks that you insert into your computer,
and fixed disks permanently installed in your computer. During
the FoxPro installation process, FoxPro files contained on a set of
floppy disks are copied onto your computer’s fixed disk. FoxPro
then uses the files on your fixed disk.

Floppy and fixed disks reside in a disk drive. A disk drive is the
mechanical device that writes and reads information to and from a
disk. Disks drives are referenced by a drive letter — a single al-
phabetic character used to identify the drive. A and B are usually
used to identify floppy disk drives, and the letters C through Z
identify fixed disk drives. Fixed disks are sometimes called hard
drives.

Specifying the Current Disk Drive

A4

During the installation of FoxPro you may have to specify a cur-
rent disk drive. DOS commands act on the current disk drive
(when a different disk drive isn’t specified with the command).
You can specify the current disk drive from the DOS prompt.

To make a disk drive the current drive, type the drive letter fol-
lowed by a colon (:) at the DOS prompt, then press Enter. For
example, to make the A drive the current drive, at the DOS prompt

type
A:

and press Enter.
To make the C drive the current drive, at the DOS prompt type
C:

and press Enter.
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Disk Drive Directories

A large number of files can be stored on a disk. To organize these
files, a directory can be created to group files together. For ex-
ample, FoxPro program files are usually placed in a directory
named FOXPRO.

A directory can contain files and additional directories called sub-
directories. FoxPro demonstration files are usually placed in a
subdirectory named DEMO in the FOXPRO directory, and the
tutorial files are placed in a subdirectory named TUTORIAL.

Subdirectories can, in turn, contain more subdirectories. This or-
ganization of directories in other directories creates a tree-like
structure. The main directory is called the root directory, with all
other directories branching from the root directory.

Changing Directories

You can move from directory to directory with the DOS change
directory command, CHDIR. When you move to a directory, it be-
comes the current working directory. DOS commands act on the
current directory (when a directory path isn’t included with the
command).

To move to the root directory, you can use the DOS command
CHDIR\
To move to another directory, place the directory name immedi-

ately after the CHDIR\ command. For example, to move to the
FoxPro directory, use the command

CHDIR\FOXPRO
To move to a subdirectory in a directory, place a backslash be-
tween the directory and subdirectory names. For example, to

move to the TUTORIAL subdirectory in the FOXPRO directory, use
the command

CHDIR\FOXPRO\TUTORIAL

DOS and FoxPro A-5



How Does DOS Organize Files?

Creating New Directories

To create a new directory or a subdirectory, use the DOS MKDIR
make directory command, MKDIR. Before installing FoxPro you can
create a directory to place the FoxPro program files in.

Use CHDIR to move to the directory where you create the new
directory or subdirectory. Issue the command MKDIR followed by
the name of the new directory or subdirectory. The following DOS
commands make the FOXPRO directory the current directory, and
then create a subdirectory named EXAMPLES:

CHDIR\FOXPRO
MKDIR EXAMPIES

When. naming directories and subdirectories, you must follow the
same rules that apply when creating file names.
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acronym — A word formed from the initial letters of a name or phrase,
such as ROM (from read-only memory).

active window — The frontmost window on the screen, where the next ac-
tion will take place. The controls on an active window are visible.

address — (n) A number that specifies the location of a single byte of
memory. Addresses can be given as decimal integers or as hexadecimal
integers. (v) The act of referring to a specific storage location.

aggregate function — In SQL, SUM( ), AVG( ), MIN( ), MAX( ), COUNTY( ), NPV( ),
STD(), VAR().

alert — A warning or report of an error in the form of an alert box, a
sound from the computer’s speaker or both.

algorithm — A step-by-step procedure for solving a problem or accomplish-
ing a task.

alias — An additional name assigned to a database. A database may be
referenced by its alias and the work area it is opened in.

AND — A logical operator that produces a true result if both of its
operands are true, and a false result if either or both of its operands are
false. See also: OR, NOT.

APl — An acronym for Application Program Interface. FoxPro’s API al-
lows your C and Assembly language routines to interact with FoxPro.

application program — A program written for some specific purpose such
as word processing, database management, graphics, telecommunication
or accounting.

application software — A collective term for application programs.

argument — A value on which a function or statement operates. It can be
a number or a variable. For example, in the FoxPro statement
SPACE(10), the number 10 is the argument. See also: operand.

arithmetic expression — A combination of numbers and arithmetic
operators (such as 3 + 5) that indicates an operation to be carried out.
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arithmetic operation — One of the five actions computers can perform
with numbers: addition, subtraction, multiplication, division and ex-
ponentiation.

arithmetic operator — An operator, such as +, that manipulates numeric
values to produce a numeric result. See also: logical operator, relational
operator.

array — An ordered collection of data. Each element of the array can be
referenced by a numerical subscript.

ASCIl — Acronym for American Standard Code for Information Inter-
change, pronounced “ASK-ee”. It’s a code in which the numbers from 0
to 127 stand for text characters. ASCII code is used for representing text
inside a computer and for transmitting text between computers or be-
tween a computer and a peripheral device.

assembler — A language translator that converts a program written in
assembly language into an equivalent program in machine language.

assembly language — A low-level programming language in which in-
dividual machine language instructions are written in a symbolic form
that’s easier to understand than machine language itself. Each assembly
language instruction produces one machine language instruction. See
also: machine language.

auto indent — A choice from the Preference... option of the Edit meu
popup which automatically indents a line by the same amount as the
previous line.

average — An internal computation that returns the arithmetic mean for
the name field or expression.

back up — (v) To make a spare copy of a disk or of a file, on a disk.
Backing up your files and disks ensures that you won’t lose information
if the original is lost or damaged. (n) A copy of a disk or of a file on a
disk. It’s a good idea to back up all of your important disks and to use
the copies for everyday work, keeping the originals in a safe place.

band — An area in report that can contain text, database fields, calcu-
lated values, or user-defined functions as well as lines and boxes.
Several different types of bands appear in a report.
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basic optimizable expression — A basic optimizable expression can form
an entire expression or can appear as part of an expression. The rules for
combining basic optimizable expressions appear in the FoxPro Com-
mands & Functions manual and in the FoxPro Developer’s Guide.

batch file — A batch file contains commands that control the operation of
the computer. These commands take the place of input from the key-
board.

binary — Characterized by having two different components, or by having
only two alternatives or values available. Binary is sometimes used as a
synonym for binary system.

binary digit — The smallest unit of information in the binary number sys-
tem, a 0 or a 1 (also called a bit).

binary file — A file whose data is to be interpreted in binary form.
Machine language programs and pictures are stored in binary files.

bit — A contraction of binary digit. It is the smallest unit of information
that a computer can hold. The value of a bit (1 or 0) represents a simple
two-way choice such as yes or no, on or off, positive or negative, and
something or nothing.

body — The statements or instructions that make up a part of a program,
such as a loop or a subroutine.

Boolean operator — An operator, such as AND, that combines logical
values to produce a logical result, such as true or false. It is also known
as a logical operator. See also: arithmetic operator, operator, relational
operator.

boot — Another way to say “start up.” A computer boots by loading a
program into memory from an external storage medium, such as a disk.
Starting up is often accomplished by loading a small program that then
reads a larger program into memory.

branch — (v) To pass program control to a line or statement other than
the next in sequence. (n) A statement that performs a branch. See also:
conditional branch, unconditional branch.

breakpoint — A breakpoint causes execution to pause and returns control
temporarily to you.

browse — To display data in a Browse window.
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buffer — A holding area of the computer’s memory where information can
be stored by one program or device and then read at a different rate by
another. In editing, it is an area in memory where cut or copied data is
held, sometimes called the clipboard. See also: type-ahead buffer and
clipboard.

bug — An error in a program that causes it not to work as intended.

byte — A unit of information consisting of a fixed number of bits. On
many systems, one byte consists of a series of eight bits, and a byte can
represent any value between 0 and 255. The bit sequence represents an
instruction, letter, number, punctuation mark, or other character. See
also: kilobyte, megabyte.

calculated value — A value that is a report created from a formula. A
formula can consist of database fields, constants, and/or functions con-
nected by operators.

call — (v) To request the execution of a subroutine, function or procedure.
(n) A request from the keyboard or from a procedure to execute a named
procedure. See also: procedure.

called program — A routine, UDF or procedure that is executed.

calling program — A program that executes the called routine, UDF or
procedure

cancel — To stop execution of a command file and return control to
FoxPro.

Capslock key — A key that, when engaged, causes subsequently typed
letters to appear in upper-case. It has the same effect on letter keys as
the Shift key.

carriage return — An ASCII character (decimal 13) that ordinarily causes a
printer or display device to place the next character at the left margin.

case-sensitive — Able to distinguish between upper-case characters and
lower-case characters. Programming languages are case sensitive if they
require all upper-case letters, all lower-case letters, or proper use of
upper-case and lower-case letters.

central processing unit (CPU) — The brain of the computer; the
microprocessor that performs the actual computations in machine lan-
guage. See also: microprocessor.
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character — Any symbol that has a widely understood meaning and thus,
conveys. Letters, numbers and punctuation are characters that can be
displayed on the monitor and printed on a printer. See also: control
character.

character code — A number used to represent a character for processing
by a computer system.

character expression — A collection of character data that’s treated as a
unit.

character field — A field, with a maximum width of 254, that may include
all keyboard characters (letters, numbers and punctuation symbols) and
any graphic (box-drawing), foreign alphabet and special symbol charac-
ters.

character keys — The letter, number, symbol and punctuation keys on a
computer keyboard used to generate or format text; any key except Alt,
Capslock, Ctrl, Esc, Shift, Enter, etc.

character limit — The maximum number of characters allowed in a single
command.

character pitch — The number of characters per inch printed along a
horizontal line.

character set — The entire set of characters that can be either shown on
a monitor or used in printed output. With a printer, it’s the entire set of
characters that the printer is capable of printing.

character style — A set of stylistic variations, such as bold, italic and un-
derline, which can be applied to a character set.

check box — A pair of square brackets followed by text. Settings can be
turned on and off by choosing the check box. If a check box has an X in
it, the setting is on.

choose — To select a command or an option from a menu, or a control in
a dialog.

clause — An additional statement that follows a command or function key
word.

clear — To erase data from the screen and/or from memory.
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cleanup code — Code that is executed after the menu definition code and
may contain code snippets for procedures.

code snippets — A code snippet is a procedure or an expression as-
sociated with a specific menu pad, menu popup or menu option. You can
also define code snippets that perform actions on the entire menu system.

click — Press and release the mouse button once.

click on — To position the mouse pointer on something, then press and
release the mouse button.

clipboard — The holding place for what you last cut or copied; a buffer
area in memory. Information contained on the clipboard can be inserted
(pasted) into other documents.

clock chip — A special chip in which the current date and time are
stored. This chip is powered by a battery when the system is off, thus
preserving the information.

close — To make a window disappear from the screen.

clusters — Disk space is allocated to files in units called clusters. The
size of a cluster depends on your particular system.

code — (1) A number or symbol used to represent some piece of informa-
tion. (2) The statements or instructions that make up a program.

color pair — A foreground and background color combination. A variety
of these combinations are available for you to choose from the color
palette of the Color Picker dialog.

color palette — The color palette is part of the Color Picker dialog and
contains color pairs — background and foreground color combinations —
which you can choose for each radio button.

color scheme — A group of color pairs that can be specified using the
radio buttons in the Color Picker dialog.

color set — A group of color schemes that determines how FoxPro will
assign colors to objects. Different color sets can be defined for
monochrome, CGA and VGA monitors. Users may also want to define
color sets to make the interface more aesthetically pleasing.
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column — The vertical arrangement of character cells on the display
screen.

command — An instruction that causes the computer to perform some ac-
tion. A command can be typed from a keyboard, selected from a menu
with a hand-held device (such as a mouse), or embedded in a program.

command condition — Specifies the set of database records to which a
For or While clause applies.

command key word — A portion of a command that is English-like and
describes the action that will occur.

command scope — A condition that specifies the general set of database
records to which a command applies.

command structure — The nature and interrelations of all the possible
instructions that can be sent to a device, such as a computer or printer.

compact single entry index — An index file limited to one index entry.
This index file must be explicitly opened and be active to be updated
with a database.

compiler — A language translator that converts a program written
in a high-level programming language (source code) into an equivalent
program in some lower-level language such as machine language (object
code) for later execution.

compiler directive — A REGION# command used in a program to isolate
memory variables and avoid name collisions in screen sets.

compound index file — An index file containing multiple index entries,
called tags.

computer language — See programming language.

concatenate — Means literally, to chain together. It involves combining
two or more strings into a single, longer string by joining the beginning
of one to the end of the other. It also refers to combining two or more
files.

conditional branch — A branch whose execution depends on the truth of
a condition or the value of an expression. See also: unconditional branch.
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configuration — (1) The total combination of hardware components —
central processing unit, video display device, keyboard, and peripheral
devices — that makes up a computer system. (2) The software settings
that allow various hardware components of a computer system to com-
municate with each other.

constant — In a program, a symbol that represents a fixed, unchanging
value. See also: variable.

context-sensitive — Able to perceive the situation in which an event oc-
curs. For example, an application program might present help informa-
tion specific to the particular task you’re performing, rather than a
general list of commands; such help would be context-sensitive.

control — A push button, check box, radio button, popup control, list or
text box in a dialog that is used to designate, confirm or cancel actions.

control break — An expression that defines the contents of a group in a
report.

control character — A nonprinting character that controls or modifies the
way information is printed or displayed. Control characters have ASCII
values between 0 and 31. Typically, control characters are typed from a
keyboard by holding down the Ctrl key while pressing some other key.

control code — One or more nonprinting characters included in a text file
whose function is to change the way a printer prints the text. For ex-
ample, a program may use certain control codes to turn boldface printing
on and off. See also: control character.

control key — A general term for a key that controls the operation of
other keys (e.g., Alt, Capslock, Ctrl and Shift). When you hold down or
engage a control key while pressing another key, the combination makes
the other key behave differently.

Control key — A specific key that produces control characters when used
in combination with other keys, usually abbreviated Ctrl.

control key shortcuts — The keystroke combinations that you can use in-
stead of choosing menu options.

controlling database — When databases are related, the controlling
database controls the order in which the records in other databases are
accessed.
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coordinate — One of a pair of numbers that designates a position on the
screen. The numbers correspond to the columns (vertical placement) and
rows (horizontal placement) of the screen display.

copy — To make a copy of the selected text and place it on the clipboard,
leaving the original text intact.

count — An internal computation that returns the number of records dis-
played in a given portion of a report.

CPU — See central processing unit.

current input device — The source, such as the keyboard or a modem,
from which a program is currently receiving its input.

current output device — The destination, such as the display screen or a
printer, currently receiving a program’s output.

cursor — A symbol on the screen that marks where the user’s next action
will occur or where the next character typed from the keyboard will ap-
pear.

cut — To remove something by selecting it and choosing Cut from a
menu. The item that you cut is placed on the clipboard. In other editing
applications, delete serves the same purpose.

data — Facts, figures, values, and other materials that are used or
operated on by a program. The smallest unit of data that a computer can
understand is a bit.

database — A collection of information that is organized so that it can be
readily manipulated and sorted by a computer user.

database management system — A software system for organizing, stor-
ing, retrieving, analyzing and modifying information in a database.

database field — Any data item contained in a database record. One or
more fields make up a database record, and one or more records make up
a database file.

data format — The form in which data is stored, manipulated or trans-
ferred. Transmitted and received serial data typically has a data format
of one start bit, five to eight data bits, an optional parity bit, and one or
two stop bits.
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date field — A field, with a length of eight, used for dates in the format of
month (MM), day (DD) and year (YY).

data grouping — Categorizing data in groups in a report corresponding to
a specified order. Headers and footers can be defined to print every time
the value for a group changes.

data type — One of the six different types of data in FoxPro including
character, numeric, float, logical, date and memo.

debug — To locate and correct an error, problem or malfunction in a com-
puter program. Usually synonymous with troubleshoot. See also: bug.

decimal system — The common form of number representation in which
numbers are expressed in the base 10 system, using the ten digits, 0
through 9.

default — A preset response to a question or prompt. The default is auto-
matically used by the computer if you don’t supply a different response.
Default values prevent a program from stalling or crashing if no value is
supplied by the user.

default button — The push button in dialogs, enclosed by double angle
brackets, that is chosen when you press Ctrl+Enter.

delete — To remove a character or word from a file, or a file from a disk.
Keys such as the Backspace key and the Delete key erase one character
at a time.

Delete key — A key that erases the character on which the cursor is pos-
tioned.

delimiter — A character that marks the beginning or end of a sequence of
characters and is not considered part of the sequence itself. For example,
the double quotation mark (") is one delimiter for string constants — the
string “DOG” consists of the three characters D, 0, and G, and does not
include the quotation marks.

deselect — To remove the highlighting.

desk accessories — Generally useful items such as a calculator, calen-
dar, ASCII chart, file and directory manager, etc. that are listed on the
System menu popup.
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desktop — The screen, that underlies all system and user-defined win-
dows is sometimes called the desktop.

destination — When you are making a copy of a file, the destination is
the location you are copying to. See also: source.

details level — The details level of the Help window displays information
for a topic.

detail band — An area of the report that typically contains one or more
lines for each record that is printed from the database.

device name — The name used in path names to refer to a particular
device without regard to the files associated with the device.

dialog — A box that contains a message requesting more information to
complete a command or an expression.

dimension — The maximum size of one of the subscripts of an array.

dimmed — Text and areas that are dimmed have little contrast with the
surroundings, making them less obvious.

directory — A list of the contents of a directory, subdirectory or a disk.
It’s a file that contains a list of all the names and locations of other files
stored on a disk. These other files may themselves be directories (called
subdirectories).

disable — To make a control (or part of it) unavailable for use, you can
disable it. Disabled items appear in disabled colors and cannot be
selected or chosen.

disabled — Sometimes, certain menu pads, menu options and controls in
dialogs appear dimmed and cannot be chosen. These are disabled.

disk — An information storage medium consisting of a flat, circular, mag-
netic surface on which information can be recorded in the form of small
magnetized spots, similar to the way sounds are recorded on tape. See
also: hard disk.

disk drive — The device that holds a disk, retrieves information from it,
and saves information to it.
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Disk Operating System (DOS) — The software system that enables the
computer to control and communicate with disk drives and other
peripherals.

disk space — The amount of space available on a disk for storing or
processing a document or an application.

display — A general term to describe what you see on the screen of your
display device when you’re using a computer.

display color — The color currently being used on the display screen.

display device — A device that displays information, such as a television
or video monitor.

dock — The act of minimizing a window and placing it in the lower right
corner of the screen.

double-click — To position the mouse cursor where you want an action to
take place, and then to press and release the mouse button twice in quick
succession without moving the mouse.

double-click drag — To double-click without releasing the mouse button
on the second click, and continue holding down the mouse button while
you drag.

drag — To position the pointer, press and hold down the mouse button,
move the mouse and then release the mouse button.

duration — The length or persistence of a signal in time. See also: fre-
quency.

edit — To change or modify. Editing includes inserting, removing, replac-
ing or changing text.

editor — A program that helps you create and edit a particular form of
information. FoxPro has a built-in text editor.

element — A member of a set or collection; specifically, one of the in-
dividual variables making up an array.

embedded — Contained within. For example, the string “HUMPTY
DUMPTY” is said to contain one embedded space.
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emulate — To operate in a way identical to a different system.
enabled — Available to be acted upon (a control).

end-of-line character — A character indicating that the preceding text
constitutes a complete line.

Enter key — A key that causes the cursor to move to the beginning of the
next line. It’s also used in some cases to confirm or terminate an entry
or a command.

error code — A number or other symbol representing a type of error.

error condition — The state of the hardware or program after it has
detected a fault in one or more of the commands sent to it.

error message — A message displayed or printed to tell you about an
error or problem in the execution of a program or in your communication
with the system. An error message is often accompanied by a beep.

escape character — An ASCII character that, with many programs and
devices, allows you to perform special functions when used in combina-
tion with other keys.

escape code — A sequence of characters that begins with an escape char-
acter and constitutes a complete command. Usually synonymous with
escape sequence.

Escape key — A key that generates the escape character. The Escape
key is labeled Esc on the keyboard. In many applications, pressing Esc
allows you to return to a previous menu or to stop a procedure.

escape sequence — A sequence of keystrokes or output characters that
begins with the Esc character. Escape sequences are typically used for
positioning the cursor, controlling the display of text on the screen, or as
codes to control printers.

event-driven — Instead of having to follow a rigid sequence determined by
a program, the sequence of actions is determined by the user, for the
most part. The computer responds to you instead of making you respond
to it.

execute — To perform the actions specified by a program command or se-
quence of commands.
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expression — A number, variable, word or group of words that can be
evaluated to form a new value (of character, numeric, logical, float or
date type).

expression list — One or more expressions separated by commas.

Expression Builder — The Expression Builder is a dialog that contains
menus, field names and variables from the active database(s), and an
area where an expression appears as you are building it.

field — A particular type or category of information in a database file.

field object — An object in a report or screen that draws its definition
from a database field or memory variable.

file — Any named, ordered collection of information stored on a disk. Ap-
plication programs and operating systems on disks are examples of files.
You make a file when you create text or other data, give the material a
name, and save it to disk.

file management — A general term for copying files, deleting files, and
other chores involving the contents of disks.

file name — The name that identifies a file. The maximum character
length of a file name and the rules for naming a file vary under different
operating systems. See also: path name.

file server — A combination of controller software and a mass-storage
device that allows computer users to share common files and applications
through a network.

file structure — The arrangement of fields in a database file.

file type — The categories of files specified by FoxPro extensions: .APP,
.DBF, .PRG, .CDX, .FRX, etc.

flag — A variable whose value (usually 1 or 0, standing for true or false)
indicates whether some condition holds or whether some event has oc-
curred. A flag is used to control the program’s actions at some later
time.

flat copy — When a flat copy is performed, all the files in all the tagged
directories are copied to one single directory. The directory structure is
not preserved.
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floating-point notation — A method of representing numbers inside the
computer in which the decimal point (more correctly, the binary point) is
permitted to float to different positions within the number. Some of the
bits within the number itself are used to keep track of the point’s posi-
tion.

font — (1) In typography, a complete set of type in one size and style of
character. (2) In computer usage, a collection of letters, numbers,
punctuation marks, and other typographical symbols with a consistent
appearance; the size can be changed readily.

font size — The size of a font of characters in points. Examples of font
size are 12 point and 18 point.

format — (n) (1) The form in which information is organized or presented.
(2) The general shape and appearance of a printed page, including page
size, character width and spacing, line spacing, and so on. (v) To divide a
disk into tracks and sectors where information can be stored. Blank
disks must be formatted before you can save information on them for the
first time. The word format is synonymous with initialize.

form feed — An ASCII character (decimal 12) that causes a printer or
other paper handling device to advance to the top of the next page.

frequency — In alternating current (AC) signals, the number of complete
cycles transmitted per second. Frequency is usually expressed in hertz
(cycles per second), kilohertz (kilocycles per second), or megahertz
(megacycles per second). In acoustics, frequency of vibration determines
musical pitch. See also: duration.

function — A preprogrammed calculation that can be carried out on re-
quest from any point in a FoxPro program. Because a function takes in
one or more arguments and returns a single value, it can be embedded in
an expression.

generated code — Code created by GENSCRN, the FoxPro screen gener-
ator or GENMENU, the FoxPro menu generator. Generated screen
programs have an .SPR extension and generated menu programs have an
.MPR extension. These programs are for debugging purposes and should
not be directly edited.

generated name — A unique name generated by SYS(2015). These names
are inserted in generated programs with corresponding clauses and code
snippets.
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generator directive — A command that communicates solely with GENSCRN, the
FoxPro screen generator.

graph — A pictorial representation of data.
graphic object — Lines and boxes used in reports and screens.

group band — A group consists of fields that appear together based on
some criteria that you specify by choosing the Data Grouping... option on
the Report menu popup.

group footer — Report band in which objects can be defined to print each
time a group expression changes. Group footers usually contain calcu-
lated values for data in the group.

group header — Report band in which objects can be defined to print
each time a group expression changes. Group headers usually contain
information to preface the data that will follow.

group objects — Combining two or more objects in a report or screen so
that they act as one object to be moved, copied and pasted.

hard disk — A disk made of metal and sealed into a drive or cartridge. A
hard disk can store very large amounts of information compared to a
floppy disk.

hard disk drive — A device that holds a hard disk, retrieves information
from it, and saves information to it. Hard disks made for microproces-
sors are permanently sealed into the drives.

hexadecimal — The representation of numbers in the base-16 system,
using the ten digits 0 through 9 and the six letters A through F. For
example, the decimal numbers 0, 1, 2, 3, 4, ... ,8, 9, 10, 11, ... ,15, 16, 17
would be shown in hexadecimal notation as 00, 01, 02, 03, 04, ... ,08, 09,
0A, 0B, ... ,0F, 10, 11. Hexadecimal numbers are easier for people to
read and understand than binary numbers, and can be converted easily
and directly to binary form. Each hexadecimal digit corresponds to a
sequence of four binary digits, or bits.

hide — To make a window invisible without closing it.

high bit ASCII characters — These ASCII characters have decimal values
of 128 to 255. They are called high ASCII because their high bit (first
binary digit) is set to 1 (for on) rather than 0 (for off).

Glossary B-17



high-level language - input/output (I/O)

B-18

high-level language — A programming language that is relatively easy
for people to understand. A single statement in a high-level language
typically corresponds to several instructions of machine language. See
also: low-level language.

highlight — To make something visually distinct. For example, when you
select a block of text, the selected text is highlighted.

highlighted — Text that is emphasized so that it stands out from the sur-
roundings. Highlighting something typically indicates that it is selected
or is about to be chosen. Highlighted text may appear differently
depending on the type of monitor and color settings that you use.

hot key — A highlighted letter that you can type to immediately choose
the desired control in a dialog, display a menu popup when the menu bar
is activated, or choose a menu option from a displayed popup.

independent IDX — Index files containing one index entry. An inde-
pendent compound index file never has the same name as the database
and will not automatically open with a database.

index — A file containing a list or table of entries that identifies the se-
quence or record ordering of a database file, based on key fields.

indexed database — A database whose entries have been ordered in a
logical sequence.

index key — A file whose entries identify the logical position of data in a
database.

index variable — A variable whose value changes on each pass through a
loop. It is often called a control variable or a loop variable.

infinite loop — A section of a program that will repeat the same sequence
of actions indefinitely.

initialize — (1) To set to an initial state or value in preparation for some
computation. (2) To prepare a blank disk to receive information by or-
ganizing its surface into tracks and sectors. It is the same as formating.

input — Information transferred into a computer from some external
source, such as the keyboard, a disk drive or a modem. See also: output.

input/output (I/0) — The process by which information is transferred be-
tween the computer’s memory and its keyboard or peripheral devices.
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insert — To add a character or portion of text at the cursor position,
shifting the text at the right of the cursor to the right.

insert mode — The default text editing mode in which any character you
type is inserted at the cursor position and the text at the right of the
cursor is shifted to the right.

insertion point — The place in a document where something will be
added.

integer — A whole number in fixed-point form.

interactive — Operating by means of a dialog between the computer sys-
tem and a human user.

interface — The point at which independent systems or diverse groups in-
teract. It consists of the devices, rules or conventions by which one com-
ponent of a system communicates with another. It is also the point of
communication between a person and a computer.

interrupt — A temporary suspension in the execution of a program that
allows the computer to perform some other task, typically in response to
a signal from a peripheral device or another external source.

invisible buttons — Screen controls that are invisible. The behavior of in-
visible buttons can be defined in object level clauses for the buttons.

1/0 — See input/output.

join condition — A join condition specifies the relationship between two
databases and is often a field common to both databases, such as a cus-
tomer number or a transaction number.

K — See kilobyte.
keyboard shortcut — See control key shortcut and hot key.
key field — A field that is used in an index; part of the index key.

key word — A special word or sequence of characters that identifies a
particular type of statement or command, such as RUN, USE, or PRINT.
Keywords are sometimes called reserved words because FoxPro reserves
these special words for internal use.
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kilobyte (K) — A unit of measurement consisting of 1024 (2'°) bytes. In
this usage, kilo (from the Greek, meaning a thousand) stands for 1024.
Thus, 64K memory equals 65,536 bytes. See also: megabyte.

leading zero — A zero occurring at the beginning of a decimal number. It
is deleted by most computing programs.

line feed — An ASCII character (decimal 10) that ordinarily causes a
printer or video display to advance to the next line.

line feed pitch — The number of lines printed per vertical inch.

line length — The number of characters that fit on a line on the screen or
on a page.

link — To connect programs compiled or assembled at separate times so
that they can be executed together. See also: compiler.

list — To display on a monitor or print on a printer the contents of
memory or of a file.

literal — A character that is entered as a constant part of a format. For
example, the /’s in a date field (8/11/89) are literals.

load — To transfer information from a peripheral storage medium (such
as a disk) into main memory for use; for example, to transfer a program
into memory for execution.

local — Within the current program module.

local alias — In the SQL SELECT command, the local alias is a temporary
name for a database specified in the FROM clause.

lock — To prevent documents, files or entire disks from being altered.
Files can be locked with software commands. Entire disks can be physi-
cally locked by using a write-protect tab on the disk jacket; in this sense
lock is synonymous with write-protect. See also: unlock.

logic — (1) In microcomputers, a mathematical treatment of formal logic
using a set of symbols to represent quantities and relationships that can
be translated into switching circuits or gates. AND, OR and NOT are ex-
amples of logical gates. Each gate has two states, open or closed, allow-
ing the application of binary numbers for solving problems. (2) The sys-
tematic scheme which defines the interactions of signals in the design of
an automatic data processing system.
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logical field — A field that accepts only true or false conditions.

logical operator — An operator, such as AND, that combines logical values
to produce a logical result (true or false); sometimes called a Boolean
operator. See also: arithmetic operator, relational operator.

loop — A section of a program that is executed repeatedly until a limit or
condition is met, such as a variable reaching a specified ending value.

low-level language — A programming language that is relatively close to
the form the computer’s processor can execute directly. One statement in
a low-level language corresponds to a single machine language instruc-
tion. See also: high-level language.

machine language — The form in which instructions to a computer are
stored in memory for direct execution by the computer’s processor. Each
model of computer processor has its own form of machine language. See
also: assembly language.

macro substitution — Macro substitution allows memory variables to
replace names. Macro substitution places an ampersand (&) before the
memory variable to tell FoxPro to use the value of the memory variable
as a name. A command or function containing a name expression ex-
ecutes faster than one containing macro substitution; always use a name
expression instead of macro substitution.

main memory — The part of a computer’s memory whose contents are
directly accessible to the microprocessor; usually synonymous with ran-
dom-access memory (RAM). Programs are loaded into main memory,
where the computer holds information while you work. It is sometimes
simply called memory. See also: read-only memory, read-write memory.

main report — The main report follows the report title and consists of the
page header, report body and page footer.

megabyte (MB) — A unit of measurement equal to 1024 kilobytes, or
1,048,576 bytes. See also: kilobyte.

memo field — A memo field includes any letters, numbers and punctua-
tion symbols from the keyboard plus any of the graphic (box-drawing),
foreign alphabet and special symbol characters. The default memo width
is 10 for the purpose of defining the database structure, but there is no
actual size limit other than disk space.
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memory — A hardware component of a computer system that can store
information for later retrieval. See also: main memory, random-access
memory, read-only memory, read-write memory.

memory location — A unit of main memory that is identified by an ad-
dress and can hold a single item of information of a fixed size.

memory-resident — Held continually in memory even while not in use.
For example, DOS is a memory-resident program.

memory variable — A location in the computer’s memory where data is
stored. You can change the contents of a memory variable but its name
and storage area are reserved for use until you end the FoxPro session or
release the memory variable. Memory variables and their values are lost
unless you save them to disk before exiting FoxPro or shutting off the
computer.

menu — A list of choices presented by a program, from which you can
select an option.

menu bar — A horizontal strip that appears at the top of the screen and
contains menu pads.

menu options — Commands, found on the menu popups, that perform
specific actions.

menu pads — A word, phrase or icon on the menu bar that designates
one menu. Positioning the cursor on a menu title highlights the title and
display its options below it.

menu popup — List of related options. When you choose an option from
a menu popup, you are telling FoxPro what action to take.

menu title — The menu pads found on the menu bar.

menu system — The combination of the menu bar, menu pads, menu
popups and menu options.

microcomputer — A computer whose processor is a microprocessor.

microprocessor — A computer processor contained in a single integrated
circuit. The microprocessor is the central processing unit (CPU) of the
microcomputer. See also: processor.
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minimize — The act of causing a window to become one line tall by 16
characters wide with the title of the window remaining visible.

modal — A window or dialog that does not allow another window or
dialog to be brought in front of it until that window or dialog is dis-
missed, for example, the Expression Builder dialog.

mode — A state of a computer or system that determines its behavior (a
manner of operating).

mouse — A small device you move around on a flat surface next to your
computer. The mouse controls a pointer on the screen. The pointer’s
movements correspond to those of the mouse. You use the pointer to
choose options, to move data, and to draw in graphics programs.

mouse button — The button(s) on the top of the mouse. In general,
pressing a mouse button initiates some action on whatever is under the
pointer, and releasing the button confirms the action. In FoxPro the left
mouse button is used.

multi-tasking — A process that allows a computer to perform two or more
tasks during a given period of time; it is accomplished by alternating the
actions of the computer between tasks.

name expression — Although a name cannot be a memory variable or
array element, you can create a name expression that substitutes the
value of a character type memory variable or array element as the name.
Name expressions provide flexibility in FoxPro commands and functions.
Store the name to the memory variable (or array element). The name
can then be substituted into a command or function by enclosing the
memory variable in parentheses.

nested loop — A loop contained within the body of another loop and ex-
ecuted repeatedly during each pass through the outer loop. See also:
loop.

network — A collection of interconnected, individually controlled com-
puters, together with the hardware and software used to connect them.
A network allows users to share data and peripheral devices (such as
printers and storage media), to exchange electronic mail, etc.

non-modal — A window or dialog that allows another window or dialog in
front of it while that window or dialog is opened, for example, the Com-
mand window.
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NOT — A unary logical operator that produces a true result if its operand
is false, and a false result if its operand is true. See also: AND, OR

non-compact single entry index — Non-compact single entry index files
should be created only if you need to maintain compatibility with older
versions of FoxPro (prior to FoxPro 2.0) or if you're sharing data with
FoxBASE+ and FoxBASE+/Mac.

non-procedural — You control the interface by manipulating objects. You
don’t need to type commands.

null — An undefined value. Null is different from zero; zero is a value
just like other numbers, whereas null means no value at all (of the ex-
pected type). A null string does not contain anything. For example, “ ” is
not a null string because it contains a space character; “” represents a
null string.

numeric field — A field for numbers used in calculations such as quan-
tities, prices and credit limits. It can include numbers, a decimal point
and a leading plus or minus sign.

numeric keypad — A calculator-style keypad, either built-in or peripheral,
which you can use to type numbers. The layout of numbers on the
keypad makes it easier and faster to use than the regular keyboard.

object level clause — An @...GET clause defined for a specified object in a
screen.

object program — The translated form of a program produced by a lan-
guage translator, such as a compiler or assembler. It is also called ob-
ject code. See also: source program.

off line — Not currently connected to or under the control of the com-
puter. It is used to refer to equipment such as printers and disk drives,
information storage media such as disks, and the information they con-
tain. See also: on line.

on line — Currently connected to and under the control of the computer.
Used to refer to equipment such as printers and disk drives, information
storage media such as disks, and the information they contain. See also:
off line.

on-line help — A mini-reference guide, accessible while using FoxPro,
that provides additional information about FoxPro commands and func-
tions.
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open — To make available. You open files or documents so you can work
with them.

operand — A value to which an operator is applied; the value on which
an operation code operates. See also: argument.

operating system — A program that organizes the actions of the parts of
the computer and its peripheral devices. See also: Disk Operating Sys-
tem.

operator — A symbol or sequence of characters, such as + or AND, specify-
ing an operation to be performed on one or more values (the operands) to
produce a result. See also: arithmetic operator, logical operator, relation-
al operator, unary operator.

optimize — To cause something to work as effectively as possible. For
example, optimizing an application means to use code that causes the
application to run as quickly as possible in a given environment.

option — (1) Something chosen or available as a choice; for instance, an
item on a menu popup. (2) An argument whose provision is optional.

options — A list of actions to choose from that are listed on a menu.

optional character set — An alternate character set that includes special
symbols, foreign characters and accents.

OR — A logical operator that produces a true result if either or both of its
operands are true, and a false result if both of its operands are false. See
also: AND, NOT.

orphaned — Standing alone at the bottom of a page and separated from
information on the next page.

output — Information transferred from a computer to some external des-
tination such as the display screen, a disk drive, a printer, or a modem.
See also: input.

overflow — The condition that exists when an attempt is made to put
more data into a given memory area than it can hold; for example, a
computational result that exceeds the allowed range.

override — To modify or cancel an instruction by issuing another one.
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overwrite mode — A text editing mode in which any character you type
replaces the text under the cursor.

pack — To permanently remove the records in a database that have been
marked for deletion.

page — A window full of information.

page down region — The region on the scroll bar between the down
arrow and the center of the bar. Clicking in this area causes a window
to scroll through a full page of text at a time.

page footer (PgFoot) — An area that is printed at the bottom of every
page of a report.

page header (PgHead) — An area that is printed at the top of every page
of a report.

page layout — The Page Layout dialog contains all information about
how a report is printed on paper. Top, bottom and side margins, as well
as the number of rows per page, are all part of the page layout.

page up region — The region on the scroll bar between the up arrow and
the center of the bar. Clicking in this area causes a window to scroll
through a full page of text at a time.

parallel printer — A printer that accepts information from the computer
by way of a parallel interface.

parameter — An argument that determines the outcome of a command.
pass — A single execution of a loop.

pass by reference — When a variable is passed to a user-defined function
(UDF) by reference and the UDF changes the value of the passed variable,
the variable’s original value in the calling program is also changed.

pass by value — When a variable is passed to a user-defined function
(UDF) by value, the variable’s value may be changed by the procedure or
UDF, but the variable’s original value in the calling program is not
changed.

paste — To place the contents of the clipboard at the insertion point.
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path name — The full name by which an operating system identifies a
file. A path name is a sequence of file names, each preceded by a slash,
that specifies the path from device to directory to file that the operating
system takes to locate that file. See also: file name.

peripheral — (adj) At or outside the boundaries of the computer itself,
either physically (as a peripheral device) or logically (as a peripheral
card). (n) Stands for peripheral device.

peripheral device — A piece of hardware such as a video monitor, disk
drive, printer or modem used in conjunction with a computer and under
the computer’s control. Peripheral devices are often (but not necessarily)
physically separate from the computer and connected to it by wires,
cables or some other form of interface. Such devices often require
peripheral cards.

point — (1) A unit of measurement for type; 12 points equal 1 pica, and 6
picas equal 1 inch; thus, 1 point equals approximately 1/72 inch. (2) To
position the pointer at a location on the screen. Roll the mouse to place
the pointer on an object.

pointer — (1) A small solid box or arrow on the screen that follows the
movement of the mouse and shows where your next action will take
place. (2) An item of information consisting of the memory address of
some other item; for example, pointers to the most recently stored vari-
able, the most recently typed program line, and the most recently read
data item.

point of call — The point in a program from which a subroutine or func-
tion is called.

popup — The menu that appears when you choose a popup control in a
dialog.

popup control — A rectangle with double lines on the right and bottom
edges that you can choose to display the associated menu popup.

position — To place the cursor at a desired location in a window or dialog.

precedence — The prioritized order in which operators are applied
in evaluating an expression.

press — To strike a key and then release it; you hold a key down only if
you want to repeat a character or if you are using a modifier key with
another key.
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printer — A device that produces a copy on paper of the text or graphics
you create using your computer.

printer port — A socket on the back panel of your computer that acts as a
connection to a printer.

procedure — A set of instructions that work as a unit. It is the same as a
subroutine.

processor — The hardware component of a computer that performs the
actual computation by directly executing instructions represented in
machine language and stored in main memory. See also: microprocessor.

program — (n) A set of instructions describing actions for a computer to
perform in order to accomplish some task, conforming to the rules and
conventions of a particular programming language. (v) To write a pro-
gram.

program line — The basic unit of a program, consisting of one or more
statements.

programming language — A set of symbols and associated rules or con-
ventions for writing programs.

project — A project is a special database file that keeps track of all
programs, screens, menus, libraries, reports, labels, queries, format files
and other types of files that are needed to create an application.

projection list — In the SQL SELECT command, the project list is the list of
database fields, constants and expressions to appear in the query output.

prompt — A message on the screen that tells you of some need for
response or action. A prompt usually takes the form of a symbol, a mes-
sage, a dialog box or a menu of choices.

push buttons — Key words enclosed in angle brackets. The action as-
sociated with a push button occurs immediately when you choose a push
button unless the it contains an ellipsis (...). The ellipsis indicates that
another dialog will appear.

queue — A list in which entries are added at one end and removed at the
other, causing entries to be removed in first-in, first-out (FIFO) order.

query — A question posed to obtain information. In FoxPro, RQBE and
the SQL SELECT command can be used to query databases.
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radio button — A set of parentheses followed by text. Radio buttons are
grouped so that only one can be chosen at a time, like the buttons on a
car radio. Choose a radio button to activate it. When a radio button is
chosen, a bullet appears in the parentheses and any previously chosen
radio button becomes deselected.

random-access memory (RAM) — Memory in which information can be
referred to in an arbitrary or random order. As an analogy, a book is a
random-access storage device because it can be opened and read at any
point. RAM usually means the part of memory available for programs
from a disk; the programs and other data are lost when the computer is
turned off. A computer with 512K RAM has 512 kilobytes available to the
user. (Technically, the read-only memory (ROM) is also random access,
and what’s called RAM should correctly be termed read-write memory.)
See also: read-only memory, read-write memory.

read — To transfer information into the computer’s memory from an ex-
ternal source (such as a disk drive or modem) or into the computer’s
processor from an external source (such as the keyboard or main
memory).

READ level clause — A READ clause defined for a specific screen.

read-only memory (ROM) — Memory whose contents can be read, but not
changed; used for storing firmware. Information is placed into read-only
memory once, during manufacture; it then remains there permanently,
even when the computer’s power is turned off. See also: random-access
memory, read-write memory.

read-write memory — Memory whose contents can be both read and
changed. The information contained in read-write memory is erased
when the computer’s power is turned off and is permanently lost unless
it has been saved on a disk or other storage device. See also: random-ac-
cess memory, read-only memory.

record — A unit of storage in a database file. Every database file can
contain a large number of records; each record is comprised of fields.

record length — The length of a database file’s records, in bytes.

recursion — The continued repeating of an operation or a group of opera-
tions. A recursive procedure or function is one that, while running, calls
itself.

related database — A database that is linked to the controlling database.
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relation — The link between databases that allows data to be accessed
from more than the currently SELECTed database. The link is based on a
common field or a value (record number).

relational expression — An expression that describes a link between two
databases based on a common field or value.

relational operator — An operator, such as > (greater than), that manipu-
lates numeric and other types of values to produce a logical result. See
also: arithmetic operator, logical operator.

report detail band — The area between the page header and the page
footer, consisting of detail lines based on the records from the selected
database(s).

report footer band — A band in the Report Layout window that contains
the data that will appear at the bottom of a page (page numbers, section,
etc.).

report header band — A band in the Report Layout window that con-
tains information that appears once per page. Typically, items placed in
a page header include a report title, column headings and current date.

report object — Graphic, field or text object in the Report Layout window.

reserved word — A word or sequence of characters reserved by FoxPro for
some special use and therefore unavailable as a variable name in a pro-
gram.

return address — The point in a program to which control returns on
completion of a subroutine or function.

return values — The value returned by a function to the calling program.
A function returns a value. The DATE() function returns the system
date from your computer. Functions contain a pair of parentheses that
distinguish them from commands.

routine — A part of a program that accomplishes some task subordinate
to the overall task of the program. See also: procedure.

row — A horizontal arrangement of character cells on the screen or
printer. See also: column.

RQBE — An acronym for Relational Query By Example. See also: query.
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run — (1) To execute a program. When a program runs, the computer
performs the instructions. (2) To load a program into main memory from
a peripheral storage medium, such as a disk, and execute it.

RUN — A FoxPro command that brings an external program into memory
and runs it.

save — To store information by transferring the information from main
memory to a disk. Work that is not saved disappears when you turn off
the computer or when the power is interrupted.

scientific notation — A method of expressing numbers in terms of powers
of ten, useful for expressing very small or very large numbers. For ex-
ample, 6.02E23 means 6.02 times ten to the 23rd power. (The letter E
stands for exponent.) The number is easier to understand in this form.

screen set — Two or more screens in a file.

scroll — To move through the contents of a window or scrollable list (in a
dialog) so that a different part becomes visible.

scroll bars — The controls that are used to view text that extends beyond
the edge of a window. A window may have a vertical and/or horizontal
scroll bar.

scrollable list — A list of the subdirectories and files under a common
parent directory. The parent directory always appears at the top of the
list.

select — (1) To designate where the next action will take place. To select
using a mouse, you click on or drag across information. You can also
select menu items by typing a letter or number at a prompt, by using a
combination key press, or by using arrow keys. (2) To highlight. Select-
ing prepares something to be chosen.

selection — The information or items that will be affected by the next
command. A selection usually appears highlighted.

selection marquee — Multiple objects can also be selected with the selec-
tion marquee. The selection marquee appears as a dotted line in the
Screen Design window. All objects enclosed in the marquee are selected.
Objects that are partially contained in the marquee are selected as well.

serial printer — A printer that accepts information from the computer by
way of a serial interface.
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setup code — Setup code is executed before the menu system is defined
and may include code to open files, declare memory variables, or place
the previous menu system on a stack so it can be retrieved later without
redefining it.

Shift-click — A technique that allows you to extend or shorten a selection.
Position the pointer at the end of what you want to select and hold down
the Shift key while clicking the mouse button.

Shift key — A key that, when pressed, causes the subsequent letter you
type to appear in upper-case, or the top symbol on a two-character key to
appear.

shortcut — You can use a Control key combination as a shortcut to choose
a menu option without displaying the menu popup.

size control — Control found on windows that allows you to change the
window size a little at a time.

software — A collective term for programs, the instructions that tell the
computer what to do. Software is usually stored on disks.

source — The original, as opposed to the duplicate (see also: destination).
When you are making a copy of a file, the source is the location you are
copying from.

source program — The form of a program given to a language translator,
such as a compiler or an assembler, for conversion into another form. It
is sometimes called source code. See also: object program.

Spacebar — The long, unlabeled bar along the bottom of the keyboard
that you press to generate a space character.

space character — A text character whose printed representation is a
blank space. You generate this character when you press the Spacebar.

starting value — The value assigned to the index variable on the first
pass through a loop.

start up — To get the system running. Starting up is the process of first
reading an operating system program from the disk and then running an
application program.

string — An item of information consisting of a sequence of text charac-
ters.
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string literals — A string literal is a character string surrounded by single
or double quotation mark. For example, "Ohio" or ‘Ohio’.

structural compound index — A structural compound index file, is
created when you include TAG <tag name> without including the optional
OF <.cdx file> clause. Structural CDX files always have the same base
name as the database. A structural compound index file is automatically
opened every time the database is opened.

style — A variation of a font, such as italic, underline, shadow or outline.

subdirectory — A directory within a directory; a file containing the names
and locations of other files.

subroutine — A part of a program that can be executed on request from
another point in the program and that returns control, on completion, to
the point of the request.

subscript — An index number used to identify a particular element of an
array.

substring — A string that is part of another string.

sum — An internal computation that returns the additive sum of the
values for the named field or expression.

summary band — An area of the report that appears once, at the end of a
report.

syntax — (1) The rules governing the structure of statements or instruc-
tions in a programming language. (2) A representation of a command
that specifies all the possible forms the command can take.

system — A coordinated collection of interrelated and interacting parts
organized to perform some function or achieve some purpose. A com-
puter system might consist of a processor, keyboard, monitor and disk
drive.

system messages — The boxes that appear in upper right corner of the
screen to present information.

system program — A program that makes the resources and capabilities
of the computer available for general purposes, such as an operating sys-
tem or a language translator. See also: application program.
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system software — The component of a computer system that supports
application programs by managing system resources such as memory and
/0 devices.

tab — (1) Stands for tabulator on typewriter keyboards. The Tab key al-
lows you to set automatic stops (tab stops) or margins for columns, useful
in tables. (2) An ASCII character that commands a device such as a
printer to start printing at a preset location (called a tab stop). There
are two such characters: horizontal tab (hex 09) and vertical tab (hex
0B). The horizontal tab character performs the same action as pressing
the Tab key on a typewriter.

Tab key — A key that, when pressed, generates the tab character. The
key’s function is to move the insertion point or cursor to the next tab
marker or to move the cursor to the next position in a dialog. The Tab
key works essentially like a typewriter Tab key.

tags — Any of the separate index entries contained in a compound index
file.

tagging — When you select the file(s) that an operation will affect, it is
called tagging. A tagged file appears in the list with a triangle to the left
of its name. You can tag files individually or in groups.

template — A predefined set of instructions designed to create a FoxPro
program to perform a specific task.

text — (1) Information presented in the form of readable characters. (2)
The display of characters on a display screen.

text editor — The part of FoxPro that allows you to create and modify text
and program files.

text file — A file which contains information expressed in text form and
whose contents are interpreted as characters encoded using the ASCII for-
mat. See also: binary file.

text object — Text in screens and reports. Text is usually used to convey
information making the screen or report easier to use.

text window — A window in which text is displayed and scrolled.

thumb — A diamond shaped object in the scroll bar that indicates the
relative position in the text. If you want to move through the text rapid-
ly you can drag the thumb up and down.
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title — The name that appears in the top portion of a window
title band — A report band that prints once at the beginning of the report.

title bar — A horizontal bar across the top of windows that displays the
window title.

Top-of-form command — A command causing a printer to feed paper
until the paper reaches a preset position relative to the top of a single
sheet.

trace — Watch your code as it executes

triple-click — Press and release the mouse button three times in quick
succession.

triple-click drag — To triple-click without releasing the mouse button on
the third click, and continue to hold the button down while you drag.

truncate — (1) To shorten by discarding a part. (2) To convert a real
number to the next lower integer.

type-ahead buffer — A buffer that accepts and holds characters that are
typed faster than the computer can process them.

unary operator — An operator that applies to a single operand. For ex-
ample, the minus sign (-) in a negative number such as -6 is a unary
arithmetic operator.

unconditional branch — A branch whose execution does not depend on
the truth of any condition. See also: conditional branch.

unindexed database — A database that does not have an index associated
with it.

unlock — To remove the restriction on the use of a disk or a file so that it
can once again be changed, deleted or renamed. See also: lock.

user — A person operating or controlling a computer system.

user interface — The rules and conventions by which a computer system
communicates with the person operating it.
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utilities - write

B-36

utilities — Programs which allow you to rename, copy, format, delete and
otherwise manipulate files and volumes.

utility screen — Screens designed to be used multiple times throughout
an application or in different applications. Utility screens are usually
designed to be independent of the structure and context of a particular
database.

value — An item of information, such as a number or a string, that can be
stored in a variable.

variable — (1) A location in the computer’s memory where a value can be
stored. (2) The symbol used in a program to represent such a location.
See also: constant.

wildcard character — A character that may be used to represent a se-
quence of characters in a pathname. A common wildcard character is the
asterisk (*). As an example, if you request a listing of *TXT files in a
particular appication, you would see a list of all files ending with the
extension TXT.

window — (1) The area that displays information on the screen. You can
open or close a window, move it around on the desktop, and sometimes
change its size, scroll through it, and edit its contents. (2) The portion of
a collection of information (such as a document, picture or worksheet)
that is visible in a viewing area on the display screen.

word wrap — The automatic continuation of text from the end of one line
to the beginning of the next, so that you don’t have to press the Enter
key at the end of each line as you type. If word wrap is set off, the text
you type may extend beyond the edge of the window.

work station — An individual work area that includes one or more devices
on a network.

wrap around — An option in the Find/Replace dialog that tells FoxPro to
search for a specified string from your present cursor postion to your
current postion, rather than stopping at the end of the file.

write — To transfer information from the computer to an external destina-
tion (such as a disk drive, printer or modem) or from the computer’s
processor to an external destination (such as main memory).
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zoom - zoom control

zoom — To enlarge a window until it fills the screen. When you zoom a

window that already fills the screen, FoxPro shrinks it to its original
size.

zoom control — A window control that you can use to make the window
as big as the screen and to change it back again.
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